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취급 및 사용에 관한 중요 참고 사항

• 이 기기는 정밀 기기입니다.
• 지정된 온도와 상대 습도가 있는 장소에 기기를 설치하십시오. 자세한 내용은 사양(P. 342).을 참조

하십시오.
• AC 어댑터, USB 및 이더넷 케이블을 단단히 연결하십시오.
• 기기를 이동할 때는 항상 손으로 바닥을 지지하십시오. 기기를 다른 곳에 보관하면 이동 시 파손될

수 있습니다.

사용 위치/사용 공간
기기를 평평하고 안정된 위치에 설치하십시오.

다음 위치에는 절대로 기기를 설치하지 마십시오. 품질이 저하되거나 오작동이 발생할 수 있습니다.

• 온도나 습도의 변동이 큰 장소
• 흔들림이나 진동이 있는 장소
• 바닥이 기울어져 있거나 평평하지 않거나 불안정한 위치
• 먼지가 많은 장소
• 직사광선에 노출되는 장소
• 강한 실내 조명에서 1m 이내의 위치
• 에어컨 또는 난방기구 근처
• 물이나 움직이는 공기에 노출된 장소
• 상당한 전기 또는 자기 노이즈 또는 기타 형태의 전자기 에너지에 노출된 위치

Important
Roland DG Corporation은 컴퓨터 오작동 또는 손상으로 인한 데이터 손실 또는 손상에 대해 책임을 지지 
않습니다. (중요한 데이터는 항상 백업해 두세요.)

Support
Roland DG Corporation 웹사이트를 통해 제공되는 지원 정보는 문제가 발생할 경우 유용한 참조를 제공하
기 위해 정기적으로 업데이트됩니다. 문의하시기 전에 "문제 해결 방법" 과 함께 웹 사이트의 정보를 참조하
십시오.

이 설명서에 포함된 URL은 예고 없이 변경될 수 있습니다.

IMPORTANT

관련된 링크

• https://www.rolanddg.kr/

시작하기

8 기본 정보
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커터 본체

전면

No. 이름 기능 개요

로딩 레버 소재를 장착할 때 사용합니다.

좌측 핀치 롤러 로딩 레버를 올린 다음 핀치 롤러로 소재를 고정합니다. 소재의 왼쪽 
가장자리에 배치 합니다.

커팅 케리지 블레이드 홀더를 설치합니다. 이 부분이 좌우로 이동하여 소재를 커팅
합니다.

우측 핀치 롤러 로딩 레버를 올린 다음 핀치 롤러로 소재를 고정합니다. 소재의 오른쪽 
가장자리에 배치 합니다.

그리트 롤러 이 롤러는 소재를 전면 또는 후면으로 공급합니다.

그리트 패턴 이것은 그리트 롤러의 위치를 나타냅니다. 소재를 공급할 때 핀치 롤러를 
이 패턴으로 표시된 영역 내에 배치해야 합니다.

블레이드 프로텍터 이것은 커팅 중에 블레이드의 팁을 보호합니다.

가이드 라인 소재를 장착 시 수직으로 정렬하기 위한 가이드입니다.

나이프 가이드 시판 칼 등을 삽입하여 가이드를 따라 움직이면 소재를 빼지 않고 절단
할 수 있습니다.

각 부의 명칭과 기능

기본 정보 9
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No. 이름 기능 개요

제어 패널 이를 사용하여 다양한 작업을 수행합니다.

각 부의 명칭과 기능
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후면

No. 이름 기능 개요

USB 연결부 USB 케이블 연결부입니다.

전원 코드 연결부 전원 코드 연결부입니다.

이더넷 연결부 이더넷 케이블 연결부입니다.

가이드 라인 소재를 장착 시 수직으로 정렬하기 위한 가이드입니다.

각 부의 명칭과 기능

기본 정보 11
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제어 패널

▲
▲ ▲▲

부품 이름 상세 이 문서에 사용된
표기법

W:261mm
L:----  [0mm]  

디스플레이 다양한 설정 메뉴 및 기타 정보를 표시합니다. —

TEST TEST 키 1초 이상 누르고 있으면 미리 저장된 테스트 
패턴을 커팅 할 수 있습니다.

[TEST]

ORIGIN ORIGIN 키 1초 이상 누르고 있으면 현재 블레이드 위치를 
원점으로 설정합니다.

[ORIGIN]

PAUSE PAUSE 키 이것은 작업을 중단합니다. 다시 누르면 작업이 
다시 시작됩니다.

[PAUSE]

▲
▲ ▲▲

방향 키 이 키를 사용하여 커팅 캐리지 또는 소재를 이동
하거나 메뉴 항목을 선택 또는 설정합니다.

[▲] [▼] [◀] [▶]

MENU
MENU 키 이 키를 누를 때마다 디스플레이의 메시지가

변경됩니다.
• 현재 설정된 커팅 조건
• 메뉴 모드
• 너비 표시 또는 소재 유형 표시

[MENU]

각 부의 명칭과 기능

12 기본 정보



부품 이름 상세 이 문서에 사용된
표기법

FORCE FORCE 키 블레이드 압력에 대한 조정 메뉴가 표시됩니다. [FORCE]

ENTER ENTER 키 메뉴 항목을 선택하고 설정을 완료하는 데 사용
됩니다.

[ENTER]

PEN FORCE

PEN FORCE 슬라이더 블레이드의 압력을 미세 조정할 수 있습니다. 
커팅이 진행되는 동안에도 이 조정을 수행할 수 
있습니다.

[PEN FORCE]

전원버튼 이것을 누르면 전원이 켜지고 파란색으로 켜집
니다. 1초 이상 누르면 전원이 꺼집니다.

—

 관련된 링크 
・ P. 22 "CONDITION"

각 부의 명칭과 기능
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캐리지 LED 램프

기기 상태가 LED 램프의 색상과 조명 패턴으로 표시됩니다.

기기 상태 LED 상태

전원 끄기

꺼짐

전원 켜기

파란색으로 점등

Set-up 해제 중
(로딩 레버를 내린 경우)

밝은 파란색으로 점멸한 다음 희미한 파란색으로 점등

Set-up 중
(로딩 레버를 올렸을 때)

희미한 파란색으로 점등

커팅 중 

파란색으로 점등

일시중지된 중 

파란색으로 점멸

기기에 이상이 생긴 경우

빨간색으로 점멸

 관련된 링크 
・ P. 330 오류 메시지

각 부의 명칭과 기능
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소재의 종류

이 기기에 사용되는 두 가지 주요 유형의 소재는 다음과 같습니다.

• 롤 소재
지관에 감긴 미디어

• 낱장 소재
표준 크기 소재와 같은 지관에 감겨 있지 않은 미디어

용도에 따라 다양한 소재를 선택하실 수 있습니다. 각 소재에 대한 자세한 내용은 소재 공급업체에 문의하
십시오.

이 설명서에서는 롤 소재와 낱장 소재를 통칭하여 "미디어" 또는 "소재"라고 합니다.

MEMO

사용 가능한 소재의 조건

기기에 장착할 수 있는 소재의 조건은 아래와 같습니다.

크기

너비 50 ~ 700mm(1.97 ~ 27.55in.)

길이 *1 100mm(3.94in.) 이상(낱장 소재)

커팅 가능 소재 두께 *2
0.3mm(0.01in.) 이하(장착 시 최대 1.0mm(0.03in.)

중량 최대 롤 소재의 무게 5kg(11.02lb.)

*1 롤 소재 제한 없음
*2 이형지(후지)의 두께를 포함합니다.

사용할 수 없는 소재
이 기기에서는 다음과 같은 특성을 가진 소재를 사용할 수 없습니다. 장착하기 전에 소재를 곧게 펴십시오.

• 심하게 휘어진 경우
• 모서리가 평행하지 않는 경우

인쇄와 커팅의 경우 위에 언급된 소재 외에 다음 소재는 사용할 수 없습니다.

• 투명한 소재
• 색상이 있는 소재

인쇄와 커팅 시 레이저 또는 잉크젯 프린터를 사용하여 인쇄할 수 있는 이형지가 있는 흰색 소재를 사용하십시오. 라미네
이트 또는 광택 소재와 같은 일부 소재의 경우 Crop Mark 자동 감지가 불가능할 수 있습니다.

• 레이저 프린터로 인쇄할 수 있는 소재의 종류
고급 종이
코팅된 종이
아트지
PET

MEMO

사용 소재

기본 정보 15



• 잉크젯 프린터로 인쇄할 수 있는 소재의 종류
고급 종이
코팅된 종이

사용 소재
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Crop Mark

Crop mark는 프린터에서 인쇄된 인쇄물을 이 기기에서 커팅할 때 정렬에 사용됩니다. 이미지와 함께 인쇄
되는 Crop Mark의 위치를 기기가 기억하도록 함으로써 커팅 위치를 수정할 수 있습니다.

읽을 수 있는 Crop Mark
기기의 센서는 아래에 표시된 원과 같은 Crop Mark만 읽을 수 있습니다.

• 직경 : 10mm
• 색상 : 검정

사용된 프린터 잉크에 따라 기기가 인쇄된 Crop Mark를 올바르게 읽지 못할 수 있습니다.

MEMO

Crop Mark를 사용해야 하는 경우 [3] vs[4]

일반적으로 [4]를 사용합니다. [3]은 [4]보다 읽어야 하는 Crop Mark 수가 적기 때문에 커팅에 필요한 
시간이 줄어듭니다. 그러나 [3]에서는 Tool Mode를 사용할 수 없습니다.

관련된 링크
・ P. 338 여백과 Crop Mark 사이의 거리

Crop Marks/Tool Marks
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Tool Mark

Crop Mark를 사용하여 자동 정렬을 수행할 수 없는 경우 Tool Mark는 수동 정렬에 사용됩니다.

CutStudio 또는 플러그인을 사용하여 Crop Mark 주위에 인쇄할 수 있습니다.

관련된 링크
・ P. 177 Tool Maode에서 인쇄와 커팅

Crop Marks/Tool Marks
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전원 켜기

절차

1. 전원 버튼을 누릅니다.

기기 전원이 켜지고 전원 램프가 켜집니다.

전원 끄기

절차

1. 전원 버튼을 1초 이상 길게 누릅니다.

전원이 꺼집니다.

2. 로딩 레버를 내리고 소재를 제거하십시오.

기기를 사용하지 않을 때는 전원이 켜져 있어도 로딩 레버를 내린 상태로 유지하십시오.

관련된 링크
• P. 298 전원을 끌 수 없는 경우

전원 공급
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절차

1. [MENU]를 여러 번 눌러 다음 화면을 표시하십시오.

CONDITION

소재가 장착되면 다음 순서에 따라 화면을 표시합니다.
1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

2. [▼]를 누릅니다.

MEMO

2. [▲][▼]를 여러 번 눌러 확인하려는 메뉴를 표시합니다.

표시할 수 있는 메뉴는 아래와 같습니다.
각 메뉴에서 [▶] 버튼을 클릭하면 상세 정보를 확인하거나 설정을 변경할 수 있습니다.

UNSETUP
"UNSETUP"
소재가 장착될 때 나타납니다. [ENTER]를 누르면 미디어 Set-up이 해제됩니
다.

CONDITION
"CONDITION"
블레이드의 압력과 커팅 속도를 포함한 커팅 조건을 설정합니다. 설정은 커팅 
품질에 영향을 미칩니다. 사용 중인 소재에 따라 커팅 조건을 변경하십시오.

P. 22"CONDITION"

SYSTEM INFO.
"SYSTEM INFO."
펌웨어 버전, IP 주소 및 서브넷 마스크를 포함한 시스템 정보를 확인하십시오.

P. 24"SYSTEM INFO."

CROPMARK
<SENSOR MODE>

"CROPMARK"
Crop Mark 또는 Tool Mark가 인쇄된 인쇄물을 커팅할 때 정렬 방법을 설정합니
다. 일반적으로 "SENSOR MODE"를 사용합니다.

OTHERS
"OTHERS"
디스플레이를 설정하거나 다른 설정을 켜거나 끌 수 있습니다.

P. 25"OTHERS"

REPLOT
<DATA EXISTS>

"REPLOT"
컴퓨터에서 수신한 데이터를 기기의 메모리에 저장한 다음 해당 데이터를 반복
적으로 사용하여 커팅(재커팅)할 수 있습니다.

P. 227 동일한 데이터를 반복적으로 커팅하기

MEMORY
<USER1>

"MEMORY"
소재 변경마다 커팅 조건을 설정하는 데 소요되는 시간을 절약하기 위해 자주 
사용하는 소재의 커팅 조건을 기기의 메모리에 저장할 수 있습니다.

 P. 230 자주 사용하는 커팅 조건 저장

관련된 링크
• P. 177 Tool Mode에서 인쇄와 커팅

디스플레이 메뉴 확인하기
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• P. 181 Manual Mode에서 인쇄와 커팅
• P. 197 품질 및 효율성 최적화

"CONDITION"

여기에서 블레이드 압력과 커팅 속도를 포함한 커팅 조건을 설정하고 확인합니다. 설정은 커팅 품질에 
영향을 미칩니다. 사용하는 소재에 따라 커팅 조건을 변경하십시오.

• "FORCE"

FORCE 50gf

블레이드의 압력을 설정할 수 있습니다. 디자인이 벗겨지거나 이형지도 소재와 함께 커팅되면  
"FORCE" 설정을 변경하십시오.

P. 202 블레이드 압력 설정
• "SPEED"

SPEED 40cm/s

커팅 속도를 설정할 수 있습니다. 커팅 라인이 왜곡되거나 일부 커팅되지 않은 영역이 남아 있는 
경우 "SPEED" 설정을 변경하십시오.

P. 204 커팅 속도 설정
• "OFFSET"

OFFSET 0.250mm

블레이드 팁 오프셋을 설정할 수 있습니다. 커팅 시작 부분이 의도한 위치에서 벗어나거나 모양의 
모서리가 깨끗하지 않은 경우 "OFFSET" 설정을 변경하십시오.

P. 205 블레이드 팁 오프셋 값 설정
• "UPSPEED"

UPSPEED 40cm/

커팅 작업 중에 블레이드를 소재에서 들어 올리고 다음 커팅 위치로 이동시키는 속도를 설정할 수 
있습니다. 일반적인 소재보다 얇거나 두꺼운 소재를 커팅할 때 소재가 들리는 등의 문제를 방지하기 
위해 "UPSPEED" 설정을 변경하십시오.

P. 210 커팅 중 블레이드 속도 설정
• "ROTATE"

ROTATE 0deg A

커팅 좌표를 회전할 수 있으며 소재의 커팅 방향을 설정할 수 있습니다.

P. 206 커팅 좌표의 방향 설정
• "QUALITY"

QUALITY NORMAL

커팅 품질을 설정할 수 있습니다. 두꺼운 소재를 사용하는 경우와 같이 "QUALITY" 설정을 변경
하십시오.

• "EXTEND"

디스플레이 메뉴 확인하기

22 기본 작동



EXTEND 0.0mm

일반적인 설정에 비해 커팅 영역을 확장할지 여부를 설정할 수 있습니다. 소재의 활용도를 극대
화하기 위해 "EXTEND" 설정을 변경합니다.

P. 208 커팅 영역 확장
• "AREA"

AREA 1.0m

롤 미디어를 사용할 때 필요한 소재의 길이를 설정할 수 있습니다. 롤 미디어를 설정할 때 "AREA" 
설정을 변경하십시오.

P. 40 3. 소재 장착 확인

디스플레이 메뉴 확인하기
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"SYSTEM INFO."

펌웨어 버전, IP 주소 및 서브넷 마스크를 포함한 시스템 정보를 확인할 수 있습니다.

• "MODEL"

SYSTEM INFO.
MODEL

모델명을 확인할 수 있습니다.
• "SERIAL NO."

SYSTEM INFO.
SERIAL No.

일련번호를 확인할 수 있습니다.
• "FIRMWARE"

SYSTEM INFO.
FIRMWARE

일련번호를 확인할 수 있습니다.
• "INTERFACE"

SYSTEM INFO.
INTERFACE

컴퓨터와의 연결 설정을 확인할 수 있습니다.
IP 주소 등 네트워크 설정을 확인하려면 [▶] 버튼을 두 번 누른 후 [▼] 버튼으로 표시할 정보를 
선택한 후 [▶] 버튼을 누릅니다.

디스플레이 메뉴 확인하기
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"OTHERS"

디스플레이를 설정하거나 다른 설정을 켜거나 끌 수 있습니다.

• "SMOOTHING"

SMOOTHING ON

이 기기로 전송되는 커팅 데이터의 곡선을 매끄럽게 설정할 수 있습니다.

 P. 211 호 및 기타 곡선을 부드럽게 자르기(Smoothing)
• "UNIT"

UNIT mm

표시 단위를 설정할 수 있습니다.

P. 272 표시할 길이 단위 변경
• "FACTORYDEFAULT"

FACTORYDEFAULT

이 절차는 모든 설정을 공장 기본값으로 되돌립니다. 이 지점에 대한 모든 설정이 삭제됩니다. 커
팅 조건과 같은 필요한 정보를 기록해 두십시오.

P. 275 표시할 길이 단위 변경
• "CONTRAST"

CONTRAST 5

디스플레이의 밝기를 조정할 수 있습니다. 사용자의 환경에 따라 디스플레이를 보기 편하게 설정
을 변경하십시오.

P. 274 디스플레이 밝기 조정
• "VACUUMFAN"

VACUUMFAN AUTO

흡입 팬을 켜서 커팅하는 동안 소재를 제자리에 고정하여 소재가 들리거나 제자리에서 이동하는 
것을 방지합니다. 얇거나 단단하지 않은 소재를 사용하는 경우 흡입 팬의 풍량을 낮추는 것이 좋습
니다.

P. 216 일반 소재보다 얇거나 단단한 소재 사용
• "PRE-FEED"

PRE-FEED OFF

커팅 위치의 오정렬을 방지하기 위해 커팅 전과 커팅 중에 소재가 자동으로 공급됩니다. 이 설정
은 특히 1m(3.28ft.) 이상의 데이터를 커팅할 때 유용합니다.

P. 218 오정렬 방지
• "OVER CUT"

OVER CUT OFF

디스플레이 메뉴 확인하기
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이 기능은 커팅 라인의 시작과 끝에서 더 길게 커팅합니다. 예를 들어 두꺼운 소재를 커팅할 때와
같이 특히 날카로운 모서리를 커팅하려는 경우에 효과적입니다.

P. 214 모서리를 깔끔하게 자르기(Over Cut)
• "OVERLAP"

OVERLAP OFF

동일한 커팅 데이터로 동일한 위치에서 여러 번 커팅을 반복합니다. 두꺼운 소재와 같이 단일 패스로 
커팅할 수 없는 소재에 이 설정을 사용합니다.

P. 212 동일한 위치에서 반복 커팅(Overlap)
• "PERFORATE"

PERFORATE OFF

천공 커팅은 이형지 없이 소재를 커팅하거나 커팅 데이터에 주름을 만드는 데 사용할 수 있습니다. 
소재가 끼는 것을 방지하기 위해 커팅 후 커팅 영역이 분리됩니다.

P. 232 딱지처럼 커팅 하기
• "CROP ADJ."

CROP ADJ.

인쇄 위치와 커팅 위치가 일치하지 않는 경우 인쇄 위치 또는 커팅 위치를 조정하여 문제를 해결할 
수 있습니다.

P. 220 커팅 위치 조정

P. 222 인쇄 위치 조정

디스플레이 메뉴 확인하기
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소재 장착 위치

소재의 가장자리에서 핀치 롤러까지의 좌우 여백이 균일하도록 소재를 장착합니다. 핀치 롤러(W)가 그리트 
패턴(X)의 범위(Y) 내에 있도록 소재를 장착합니다.

장착할 소재의 폭에 따라 좌우 여백이 일정하지 않을 수 있으며, 소재의 오른쪽 가장자리 여백이 왼쪽 가장자리 여백보다 
클 수 있습니다.

MEMO

Z 왼쪽 핀치 롤러의 사용 위치

왼쪽 핀치 롤러의 사용 범위
너비가 A~D 이외 크기의 소재를 장착할 때 왼쪽 핀치 롤러를 이동합니다.

A 크기의 소재가 장착된 오른쪽 핀치 롤러 사용 범위

B 크기의 소재가 장착된 오른쪽 핀치 롤러 사용 범위

B 크기의 소재가 장착된 오른쪽 핀치 롤러 사용 범위

D 크기의 소재가 장착된 오른쪽 핀치 롤러 사용 범위

A 너비가 약 150mm(5.91in.)인 소재

B 너비가 약 306mm(12.05in.)인 소재

C 너비가 약 457mm(17.99in.)인 소재 

D 너비가 약 610mm(24.02in.)인 소재

위에서 설명한 것 이외의 소재를 장착할 때는 소재의 너비에 맞게 왼쪽 핀치 롤러의 위치를 변경하십시오.

소재 장착
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관련된 링크
・ P. 9 전면

소재 장착
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낱장 소재 장착

낱장 미디어를 사용하는 경우 커팅 데이터의 세로 크기보다 최소 70mm(2.76in.) 길어야 합니다. 이것은 
그리트 롤러가 소재를 전면 또는 후면으로 공급하는 데 필요한 길이입니다.
아래 그림을 참고하여 소재의 앞뒤, 좌우 여백이 충분한지 확인합니다.

50mm(1.97in.) 이상

15mm(0.60in.) 이상

25mm(0.99in.) 이상

다음과 같은 특성을 가진 소재는 사용할 수 없습니다. 소재를 장착하기 전에 컬을 풀고 모양을 곧게 펴십시오.

• 소재가 위쪽으로 컬이 발생하는 경우
• 소재의 앞쪽 가장자리가 구부러지거나 구겨진 경우

IMPORTANT

1. 낱장 미디어 장착

이 지침은 A4 소재를 장착하는 방법을 설명합니다.

절차

1. 로딩 레버를 내립니다.

로딩 레버를 움직일 때 과도한 힘을 가하지 마십시오. 
손상될 수 있습니다.

IMPORTANT

소재 장착
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2. 기기 전면에서 소재를 삽입합니다.

3. 아래 그림에 표시된 위치에 소재를 장착합니다.

장착할 소재의 크기에 따라 장착할 수 있는 위치가 다릅니다.

4. 각 롤러가 그리트 패턴 내에 있도록 핀치 롤러를 소재의 가장자리로 이동합니다.

소재 가장자리에서 핀치 롤러까지의 좌우 여백(①)이 균일하도록 소재를 설정합니다.

이송량이 많은 소재(긴 소재)를 사용하는 경우 좌우 여백을 약 25mm(0.98in.)로 설정합니다.

MEMO

소재 장착
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스프로킷 공급 천공 미디어에는 소재 공급을 위해 각 가장자리를 따라 천공이 있습니다. 핀치 롤러가 천공 위에 
위치하면 소재를 올바르게 공급할 수 없습니다. 기기와 함께 이 소재를 사용할 때 핀치 롤러를 구멍에서 멀리  
놓으십시오.

MEMO

5. 가이드 라인(①)과 평행이 되도록 소재의 왼쪽 가장자리를 정렬합니다.

기기 위에서 보기

6. 로딩 레버를 올립니다.

소재가 제자리에 고정됩니다.

소재 장착
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이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오.
낱장 미디어 공급

MEMO

관련된 링크

• P. 15 사용 가능한 소재의 조건
• P. 27 소재 장착 위치
• P. 337 커팅 영역

소재 장착
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2. 장착된 소재 확인

절차

1. 기기의 전원을 켭니다.

2. [▼]를 여러 번 눌러 "PIECE"를 선택합니다.

SELECT SHEET
*PIECE

3. [ENTER]를 누릅니다.

커팅 캐리지가 왼쪽 핀치 롤러 위치로 이동하고 소재가 앞뒤로 이동합니다.

초기동작이 끝나면 커팅 가능한 너비와 길이가 디스플레이에 표시됩니다.

W:***mm
L:***mm

4. 작동이 중지된 후 다음 항목을 확인하십시오.

• 소재의 왼쪽 가장자리가 가이드 라인을 향해 기울어지지 않습니다.
• 핀치 롤러가 소재에서 떨어져 있지 않습니다.

기기 위에서 보기

소재 장착
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MEMO
소재가 기울어지거나 핀치 롤러가 소재에서 떨어져 있으면 소재를 올바르게 장착할 수 없습니다. 
다음 절차를 수행하고 소재 장착을 처음부터 다시 시작하십시오.
a. Media Set-up을 해제하고 커팅 캐리지를 대기 위치로 되돌립니다.

P. 172 소재 제거
b. 전원 버튼을 1초 이상 누르면 전원이 꺼집니다.

5. [MENU]를 누릅니다.

항목의 값이 표시되는지 확인하십시오.
다음 그림의 값은 참고 예입니다.

20cm/s
250gf 0.250mm ∠A
20cm/s
250gf 0.250mm ∠A

커팅 속도 

커팅 압력

블레이드 팁 오프셋

커팅 좌표의 방향

1.6m(5.25ft.)보다 긴 낱장 소재를 장착하면 기기가 이를 롤로 인식합니다.
이 경우 소재를 앞으로 투입하여 소재가 정상적으로 공급될 수 있는지 확인하십시오.
소재 공급을 확인하지 않고 커팅을 시작하면 커팅 중에 소재가 미끄러지거나 잘못된 공급으로 인해 커팅 품질이
저하될 수 있습니다.

P. 40 3. 소재 공급 확인

IMPORTANT

관련된 링크

• P. 202 블레이드 압력 설정하기
• P. 205 블레이드 팁 오프셋 값 설정하기
• P. 206 커팅 좌표의 방향 설정
• P. 204 커팅 속도 설정

소재 장착
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롤 소재 장착

롤러 베이스를 사용하지 않을 때는 커팅에 필요한 양을 미리 롤에서 잘라내어 낱장으로 장착하십시오.

P. 29 낱장 소재 장착

MEMO

1. 롤 소재 장착

롤러 베이스를 사용하여 롤 소재를 기기에 장착하십시오.

필요 항목

롤러 베이스

롤 미디어를 올바르게 장착하십시오.
그렇지 않으면 소재가 떨어져 부상을 입을 수 있습니다.

주의

롤 미디어는 약 5kg(11.02lb.)입니다.
부상을 방지하려면 롤 소재를 주의해서 다루십시오.

주의

5kg(11.02lb.)이 넘는 소재는 장착하지 마십시오.
기기가 무게를 견디지 못하고 전복되거나 소재가 떨어질 수 있습니다.

주의

절차

1. 로딩 레버가 내려갔는지 확인하십시오.

소재 장착
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2. 기기에 롤러 베이스를 부착합니다.

들어 올릴 때 기기의 끝을 잡으십시오.

3. 롤러 베이스에 롤 미디어를 놓습니다.

소재가 롤러 베이스(②)의 좌우 가장자리를 넘어가는 부분(A)의 양쪽 길이가  동일하도록 롤 미디어
(①)를 장착합니다.

롤 미디어를 올바르게 장착하십시오.
그렇지 않으면 용지가 떨어져 부상을 입을 수 있습니다.

절차

4. 롤에서 소재를 사용량보다 조금 더 길게 빼낸 후 기기 뒤쪽에서 앞쪽으로 삽입합니다.

소재 장착
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빼낸 소재에 약간의 여유를 둡니다. 약간의 여유를 만들지 않고 소재를 장착하면 소재가 올바르게 공급되지 
않습니다.

IMPORTANT

5. 핀치 롤러를 소재의 가장자리와 그리트 패턴 내로 이동합니다.

각각 소재의 왼쪽 또는 오른쪽 가장자리에서 안쪽으로 25mm(0.99in.) 이상(①)이 되도록 핀치 롤러를
배치합니다.

스프로킷 공급 천공 소재에는 소재 공급을 위해 각 가장자리를 따라 천공이 있습니다. 핀치 롤러가 천공 위에 
위치하면 소재를 올바르게 공급할 수 없습니다. 기기와 함께 이 소재를 사용할 때 핀치 롤러를 구멍에서 멀리 
놓으십시오.

MEMO

소재 장착
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6. 가이드 라인(①)과 평행이 되도록 소재의 왼쪽 가장자리를 정렬합니다.

기기 위에서 보기

7. 로딩 레버를 올립니다.

소재가 제자리에 고정됩니다.

이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오.

롤 소재 장착

MEMO

관련된 링크

・ P. 15 사용 가능한 소재의 조건
・ P. 27 소재 장착 위치

소재 장착
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2. 미디어 유형 선택

기기에 장착할 소재의 유형을 선택하십시오. 

절차

1. 기기를 켜십시오.

다음 그림과 같은 화면이 표시됩니다.

SELECT SHEET
ROLL

2. [▲] 또는 [▼]를 눌러 "ROLL" 또는 "EDGE"를 선택합니다.

"EDGE"를 선택하고 설정하면 소재의 상단 가장자리에서 약 15mm(0.59in.)(①)가 여백으로 설정
됩니다. 만약에
"ROLL"이 선택되고 설정되면 여백이 설정되지 않습니다.

3. [ENTER]를 누릅니다.

커팅 캐리지가 왼쪽 가장자리로 이동합니다. 그러면 커팅 가능한 너비가 디스플레이에 나타납니다.

W:261mm
L:----  [0mm]

관련된 링크

・ P. 35 롤 소재 장착

소재 장착
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3. 소재 공급 확인

커팅하기 전에 소재를 앞으로 공급하고 소재가 정상적으로 공급될 수 있는지 확인하십시오.
소재 공급을 확인하지 않고 커팅을 시작하면 커팅 중에 소재가 미끄러지거나 잘못된 공급으로 인해 커팅 
품질이 저하될 수 있습니다.

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

2. [▼]를 누르면 다음 화면이 나타납니다.

CONDITION

3. [▶]를 누른 후 [▲]를 누르면 아래와 같은 화면이 나타납니다.

아래 그림과 같은 화면이 표시됩니다.

AREA 1.0m

4. [▶]를 누릅니다.

5. [▲][▼]를 눌러 커팅 데이터에 필요한 소재 길이를 설정합니다.
그리트 롤러가 소재를 앞으로 공급하려면 커팅 영역의 시작과 끝에 마진이 남아 있어야 합니다.
필요한 소재 길이보다 약 0.2m(7.87in.) 더 긴 값을 설정하는 것이 좋습니다.

AREA 1.0m
*-24.9m

6. [ENTER]를 누릅니다.
설정된 길이의 소재가 앞쪽으로 이동한 다음 즉시 뒤로 당겨져 다시 감겨집니다.  소재가 핀치 롤러
에서 미끄러지면 [PAUSE]를 눌러 작업을 중지합니다. 로딩 레버를 내리고 소재를 꺼낸 후 처음부
터 다시 설정하십시오.

7. [MENU]를 누르면 원래 화면으로 돌아갑니다.

관련된 링크

・ P. 15 사용 소재

・ P. 29 낱장 소재 장착

・ P. 35 롤 소재 장착

소재 장착
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Step 1 : 블레이드 준비

블레이드의 팁은 절대 만지지 마세요.
부상을 입을 수 있습니다. 블레이드의 커팅 성능도 저하됩니다.

주의

필요 품목(제공된 품목)

블레이드 홀더 블레이드 핀 *1

*1 핀이 홀더에 삽입됩니다.

절차

1. 블레이드 홀더에서 핀이 제거된 경우 블레이드 홀더에 핀을 삽입합니다.

2. 블레이드 홀더 캡을 시계 방향으로 돌리고 회전이 멈출 때까지 조입니다.

3. 블레이드를 삽입합니다.

커팅 출력을 위한 준비
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컷인 양, 커팅 속도, 블레이드 압력 등과 같은 커팅 조건은 소재의 유형에 맞게 조정되어야 합니다.
반드시 사용하려는 소재로 커팅 시험을 실시하고 커팅 조건을 조정하십시오.

IMPORTANT

관련된 링크

・ P. 199 커팅 조건에 관한 일반 가이드
・ P. 200 커팅 조건 조정

커팅 출력을 위한 준비
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Step 2 : 블레이드 홀더 설치

블레이드의 팁은 절대 만지지 않습니다.
부상을 입을 수 있습니다. 블레이드의 커팅 성능도 저하됩니다.

주의

절차

1. 커팅 캐리지 나사를 풉니다.

2. 블레이드 홀더를 삽입합니다.

블레이드 홀더와 커팅 캐리지가 결합되었는지 확인합니다.

3. 커팅 캐리지 나사를 완전히 조입니다.

커팅 출력을 위한 준비
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이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오.

블레이드 준비

MEMO

커팅 출력을 위한 준비

44 기본 작동

https://youtu.be/gYVafOw2tms


Step 3 : 테스트 커팅 수행

소재의 종류와 커팅면의 청결도에 따라 커팅 조건을 조정하십시오. 고품질 커팅 결과를 얻으려면 실제 커
팅을 수행하기 전에 소재에 대한 커팅 품질을 확인하기 위해 커팅 테스트를 수행하십시오.

절차

1. PEN FORCE 슬라이더가 중앙 위치(스케일의 "0")에 있는지 확인하십시오.

▲
▲ ▲▲

-2 -1 0 +1 +2

2. [▲][▼][◀][▶]를 눌러 커팅 캐리지를 이동합니다.

블레이드의 끝이 커팅 시작 위치를 가리키도록 커팅 캐리지를 이동합니다.

소재나 커팅 캐리지를 빠르게 이동시키려면 다음 화면 중 하나가 표시된 상태에서 [▲][▼][◀][▶] 중 하나와 
함께 [ENTER] 키를 누르십시오.

20cm/s
250gf 0.250mm ∠A

W:***mm
L:***mm

MEMO

3. [TEST]를 1초 이상 누르십시오.

테스트 패턴의 자르기는 [TEST]를 누른 블레이드 위치에서 시작됩니다.

4. 커팅이 완료되면 [▼]를 눌러 소재를 앞으로 피드합니다.

커팅 출력을 위한 준비
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▲
▲ ▲▲

5. 커팅 상태를 확인하기 위해 핀셋 등을 사용하여 커팅된 모양을 벗겨냅니다.

다음 조건은 품질이 양호하다는 표시입니다.

• 원형 부분을 벗겨내면 원형 부분만 벗겨짐
• 네모난 부분을 벗겨내면 캐리어 페이퍼에 희미한 칼날 자국이 남음

다음 조건 중 하나라도 해당되면 블레이드 압력 또는 커팅 속도를 설정하십시오. 설정 후 커팅 
테스트를 다시 수행하십시오. 좋은 품질을 얻을 때까지 이 과정을 반복합니다.

체크 항목 결과 설정 항목 조정

모양을 확인합니다. 커팅된 모양이 왜곡된 경우 커팅 속도 줄임

원형 부분을 벗겨냅니다. 다른 모양이 함께 떨어져 나오는 경우 커팅 압력 높임

이형지도 함께 커팅되는 경우 줄임

커팅되지 않은 일부 영역이 남아 있는 경우 커팅 속도 줄임

네모 부분을 벗겨냅니다. 블레이드 흔적이 보이지 않는 경우 커팅 압력 높임

블레이드의 흔적이 너무 깊은 경우 줄임

단단한 소재나 얇은 이형지를 사용하는 경우 블레이드의 압력을 변경하면 품질이 좋지 않을 수 있습니다. 블레이드 
팁의 길이를 조절하고 컷인 양을 정확하게 조절합니다.

IMPORTANT

이 절차에 대한 참조 비디오를 보려면 다음 링크를 사용하십시오.

커팅 테스트

MEMO

관련된 링크

• P.199 커팅 조건에 관한 일반 가이드
• P. 202 블레이드 압력 설정하기
• P.204 커팅 속도 설정

커팅 출력을 위한 준비
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• P. 200 컷인 양(블레이드 길이) 조정하기

커팅 출력을 위한 준비
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Step 4 : 출력 시작 위치 설정

커팅 전에 출력 시작 위치를 충분한 커팅 영역을 확보할 수 있는 위치로 설정하십시오. 커팅 테스트에 
사용된 영역과 겹치지 않는 영역에 실제 커팅을 출력합니다.

절차

1. [◀][▲] 키를 눌러 커팅 캐리지를 원점으로 설정하려는 위치로 이동합니다.

블레이드 끝이 원점으로 설정하려는 위치를 가리킬 때까지 커팅 캐리지를 이동합니다.

2. [▲]를 눌러 소재를 뒤로 이동하고 커팅 테스트 흔적이 블레이드 프로텍터 앞에 있는지 확인합니다.

블레이드가 블레이드 프로텍터 위로 이동합니다. 원점이 설정되면 블레이드 프로텍터 뒤의 영역이
커팅 영역으로 설정됩니다.

3. [ORIGIN]을 1초 이상 길게 누릅니다.

디스플레이가 깜박이고 블레이드 팁의 위치가 원점으로 설정됩니다.

커팅 출력을 위한 준비
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출력 방법
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Step 1 : 커팅 데이터 생성

텍스트와 도형을 입력하고 컷 데이터를 생성합니다. 이 섹션에서는 "SALE"을 포함하는 커팅 데이터를 만드는 
방법과 나중에 불필요한 부분을 제거하기 쉽게 하는 "weed line,"을 추가하는 방법을 설명합니다.

절차

1. CutStudio를 시작합니다.

• Windows 11
a. [Start]를 클릭합니다.
b. [All apps]>[Roland CutStudio]>[CutStudio]를 클릭 합니다.

• Windows 10
a. [Start]를 클릭합니다.
b. [Roland CutStudio]>[CutStudio]를 클릭합니다.

• Windows 8.1

a. [시작] 창 왼쪽 하단의       을 클릭하여 [앱] 창을 표시합니다.

b. 를 클릭합니다.

CutStudio가 시작됩니다.

2. 를 클릭합니다.

3. 아무 곳이나 클릭하고 "SALE"을 입력합니다.

커팅 방법
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4. 을 클릭하고 문자 크기를 변경합니다.

■ 및 ◀가 텍스트 주위에 나타납니다. ■ 또는 ◀를 드래그하여 텍스트 크기를 변경합니다.

값에서 텍스트 크기를 지정하려면 대상 개체를 선택하고       을 클릭합니다.

MEMO

5. [Object]>[Weed]를 클릭합니다.

[Weed] 창이 표시됩니다.

커팅 방법
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6. [Weed Border] 확인란을 선택한 후 [OK]을 클릭합니다.

디자인 주위에 위드 라인이 추가됩니다.

커팅 방법
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입력된 개체는 위드 라인으로 그룹화됩니다. 위드 라인에 대한 자세한 내용은 CutStudio 도움말을 
참조하십시오.

커팅 방법
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7. 개체를 클릭하고        을 클릭합니다.

개체가 원점으로 이동합니다.

CutStudio에 표시되는 원점은 장착된 소재의 출력 시작 위치를 나타냅니다.
디자인을 원점에 위치시키면 소재의 과도한 공급을 방지할 수 있습니다.

MEMO

8. 를 클릭합니다.

9. 데이터를 저장할 폴더를 선택하고 파일 이름을 입력한 후 [Save]를 클릭합니다.

커팅 방법
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생성한 데이터가 저장됩니다.

커팅 방법
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Step 2 : 커팅 조건 설정

절차

1. 소재가 제대로 장착되고 설정되었는지 확인하십시오.

P. 27 소재 장착

2. [File]>[Cutting Setup]을 클릭합니다.

[Cutting Setup] 창이 표시됩니다.

3. [Name]의 [Printer]에서 [Roland DG GS2-24]를 선택합니다.

모델명이 설정됩니다.

4. [Media Size]에서 [Change]를 클릭합니다.

커팅 방법
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5. [Get from Machine]를 클릭합니다.

연결된 기기에서 커팅 가능 범위를 획득하면 [Cutting Area]의 [Width]와 [Length]가 업데이트
됩니다.

[The machine is not responding.]가 표시되면 기기와 컴퓨터의 설정을 확인하십시오.

P. 297 기기가 작동하지 않는 경우

MEMO

6. [OK]를 클릭합니다.

커팅 방법
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설정이 저장되고 [Cutting Setup] 창이 나타납니다.

7. 커팅 조건을 설정합니다.

일반적으로 [Use cutting conditions of machine] 확인란이 선택됩니다.

커팅 조건을 변경하려면 [Use cutting conditions of machine] 확인란의 선택을 취소하고 값을
입력합니다.

8. [OK]를 클릭합니다.

커팅 범위와 조건이 저장됩니다.

CutStudio에서 흰색으로 표시된 영역이 커팅 범위입니다. 이 영역 밖의 문자 및 도형은 커팅되지 않습니다.

MEMO

커팅 방법
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Step 3 : 커팅

커팅 데이터를 기기로 전송하고 커팅합니다.

소재가 떨어지거나 기기가 비정상적으로 작동하면 [PAUSE]를 눌러 출력을 취소하십시오. 로딩 레버를 내리고 소재를 
꺼낸 후 처음부터 다시 설정하십시오.

IMPORTANT

출력이 진행되는 동안 커팅 캐리지를 만지지 마십시오.
커팅 캐리지가 고속으로 이동합니다. 움직이는 캐리지에 닿으면 부상을 입을 수 있습니다.

경고

절차

1. 를 클릭합니다.

[Cut] 창이 표시됩니다.

2. [OK]를 클릭합니다.

커팅이 시작됩니다.

관련된 링크

・ P. 175 출력 일시 중지 및 취소

・ P. 27 소재 장착

커팅 방법
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Step 1 : 인쇄와 커팅 데이터 생성

1. 인쇄 데이터 배치

CutStudio는 다음 파일 유형만 읽을 수 있습니다.

• JPEG 형식(CMYK 형식으로 저장된 JPEG 파일은 읽을 수 없습니다.)
• PNG 형식
• BMP 형식
• AI 및 EPS 형식(Illustrator 8.0 버전만 해당. 상위 버전을 사용하는 경우 버전을 낮춰 저장하세요.)

MEMO

절차

1. CutStudio를 시작합니다.

• Windows 11
a. [Start]를 클릭합니다.

b. [All apps]>[Roland CutStudio]>[CutStudio]를 클릭합니다.

• Windows 10
a. [Start]를 클릭합니다.

b. [Roland CutStudio]>[CutStudio]를 클릭합니다.

• Windows 8.1

a. [시작] 창 왼쪽 하단의       를 클릭하여 [앱] 창을 표시합니다.

b. 를 클릭합니다.
CutStudio가 시작 됩니다.

2. CutStudio에서 [File]>[Print&Cut]을 선택합니다.

인쇄 영역과 Crop Mark가 화면에 표시됩니다. 인쇄 영역은 점선으로 표시됩니다. [Set up the
printer]에서 지정한 미디어 크기에서 [Printing Setup]에서 지정한 여백을 제외한 영역에 Crop
Mark가 표시됩니다.

인쇄와 커팅 방법
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3. 인쇄 데이터를 가져오려면       를 클릭하십시오.

여기서는 CutStudio가 설치된 폴더(일반적으로 C 드라이브의 [Program Files(x86)] > 
[CutStudio] 폴더에 있음)에 있는 Sample.bmp가 인쇄 데이터로 열립니다.

4. 인쇄 데이터를 선택하고 [Open]를 클릭합니다.

5. Crop Mark 내의 영역에 인쇄 데이터를 배치합니다.

가져온 이미지의 명암의 농도를 변경할 수 있습니다.

인쇄와 커팅 방법
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관련된 링크

• P.83 배치한 이미지의 명암의 농도 변경
• P.327 Illustrator 데이터를 가져올 수 없는 경우
• P.328 샘플 데이터를 찾을 수 없는 경우

인쇄와 커팅 방법
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2. 인쇄 데이터에 커팅 라인 추가

CutStudio에서 읽은 인쇄 데이터에 커팅 라인을 추가하고 인쇄와 커팅 데이터를 생성합니다. 

절차

1. 을 선택하고 커팅라인을 그립니다.

여기에서 아래와 같이 인쇄 데이터 주위에 커팅라인(①)이 그려집니다.

2. 를 클릭합니다.

3. 데이터를 저장할 폴더를 선택하고 파일 이름을 입력한 후 [Save]를 클릭합니다.

생성한 인쇄와 커팅 데이터가 저장됩니다.

인쇄와 커팅 방법
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Step 2 : 인쇄 조건 설정

인쇄와 커팅의 인쇄 범위와 Crop Mark를 설정합니다. 

절차

1. [File]>[Printing Setup]을 클릭합니다.

2. [Set up the printer]를 클릭합니다.

인쇄와 커팅 방법
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3. 문서 크기를 설정하고 [OK]를 클릭합니다.

4. Crop Mark의 수를 선택합니다.

[Layout Points]에서 [4] 또는 [3]을 선택합니다.

인쇄와 커팅 방법
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[4] Crop mark : 4 points

[3] Crop mark : 3 points

일반적으로 [4]를 사용합니다.
[3]은 [4]보다 감지할 Crop Mark가 적기 때문에 커팅에 필요한 시간이 절약되지만 Tool Mode에서는 사용할 수
없습니다.

MEMO

5. [Fit into shared area for cutting and printing]을 클릭합니다.

Crop Mark의 위치는 자동으로 설정됩니다.

인쇄와 커팅 방법
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Crop Mark 위치를 수동으로 설정할 때 아래 표를 참조하여 여백과 Crop Mark 사이의 거리를 지정하십시오. 이
송량이 많은 소재(긴 소재)를 사용하는 경우 좌우 여백을 약 25mm(0.98in.)로 설정하는 것이 좋습니다.

4개의 Crop Mark가 있는 다른 소재 크기의 Crop Mark 사이의 여백 및 거리(단위 : mm(in.))

설정 항목 A4 A3 B4

Y X Y X Y X

[Margins] [Top] 56 59 59 61 58(2.28in.) 56

[Bottom] 20 20 20 20 20 20

[Left] 10 30 30 15 15 14

[Right] 10 16 16 14 16 14

[Crop
marks]

[W] 170 230 230 370 205 315

[L] 200 110(4.33in.) 320 195 265 160

3개의 Crop Mark가 있는 다른 소재 크기의 Crop Mark 사이의 여백 및 거리(단위 : mm(in.))

설정 항목 A4 A3 B4

Y X Y X Y X

[Margins] [Top] 56 60 60 62 59 57

[Bottom] 20 20 20 20 20 20

[Left] 15 30 30 15 15 15

[Right] 15 17 17 15 17 14

[Crop
marks]

[W] 170 240 240 380
(14.96in.)

215 325

[L] 210 120 330 205 275 170

MEMO

6. [OK]를 클릭합니다.

값을 설정한 후 Crop Mark가 인쇄 영역 내에 있는지 확인하십시오.

표에 나열된 크기보다 큰 소재를 사용하는 경우 여백과 Crop Mark 사이의 거리(P. 338)를 참조하여 
값을 설정합니다.

MEMO

인쇄와 커팅 방법
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Step 3 : 인쇄와 커팅 데이터 출력

1. 인쇄와 커팅 데이터 인쇄

CutStudio에서 프린터로 인쇄 데이터를 전송하고 인쇄와 커팅 데이터를 인쇄합니다. 

절차

1. 프린터에 소재를 장착합니다.

프린터에 소재를 장착하는 방법은 프린터 설명서를 참조하십시오.

확대/축소 인쇄가 활성화되면 비활성화하십시오. 100% 배율로 인쇄하십시오.

IMPORTANT

2. 를 클릭합니다.

[Print] 창이 표시됩니다.

3. 사용하려는 프린터를 선택한 후 [OK]를 클릭합니다.

인쇄 데이터만 인쇄됩니다.

인쇄와 커팅 방법
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2. 인쇄물 장착

프린터에서 인쇄된 인쇄물을 기기에 장착합니다.

소재에 컬이 있는 경우 Crop Mark를 감지하지 못할 수 있습니다. 인쇄 시 소재에 컬이 발생하면  기기에 장착하기 전에 
곧게 펴십시오.

IMPORTANT

절차

1. 소재의 커팅 원점(①)을 확인합니다.

2. 기기의 왼쪽 하단에 커팅을 위한 원점을 배치하여 소재를 장착합니다.

소재를 잘못된 방향으로 장착하면 기기가 Crop Mark를 감지하지 못할 수있습니다.

IMPORTANT

3. 핀치 롤러를 배치합니다.

핀치 롤러를 배치할 때 다음 사항에 유의하십시오.

• 핀치롤러(②)를 Tool Mark(①) 바깥쪽에 위치시킵니다.
• 핀치 롤러(②)가 그리트 패턴(③)의 범위 내에 있는지 확인하십시오.

인쇄와 커팅 방법
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Crop Mark 위치를 수동으로 설정합니다. A3, A4, B4 이외의 크기의 소재를 사용하는 경우 다음 사항에 유의   
하십시오.
• 가장 왼쪽의 그리트 패턴 내에서 핀치 롤러를 사용하는 경우 그리트 패턴의 왼쪽 끝에서 Crop Mark까지 최소

30mm(1.19in.)(W)를 남겨 두어야 합니다. 간격이 30mm(1.19in.) 미만이면 Crop Mark를 읽을 수 없습니
다.

MEMO

4. 가이드 라인(①)과 거의 평행이 되도록 소재의 왼쪽 가장자리를 정렬합니다.

기기 위에서 보기

5. 로딩 레버를 올립니다.

소재가 고정됩니다.

인쇄와 커팅 방법
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6. 기기를 켭니다.

7. 소재 유형으로 [PIECE]를 선택합니다.

8. [ENTER]를 누릅니다.

커팅 가능한 너비와 길이가 표시됩니다.

W:***mm
L:***mm

9. [▲][▼]를 눌러 소재를 이동하고 Crop Mark(②)를 블레이드 프로텍터(①) 위에 배치합니다.

아래 표시된 상황에서는 Crop Mark를 읽을 수 없습니다. 소재를 한 번 제거한 다음 다시 장착하십시오.

• Crop Mark가 블레이드 프로텍터(①)에서 15mm(0.60in.) 이상(②) 떨어져 있는 경우
• 커팅 캐리지의 이동 방향의 좌/우측 Crop Mark가 5˚이상(③) 기울어져 있는 경우
• 좌/우측 Crop Mark가 소재 공급 방향으로 20mm(0.79in.) 이상(④) 벗어난 경우

IMPORTANT

인쇄와 커팅 방법
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10. [◀][▶]를 눌러 블레이드의 팁이 왼쪽 하단 Crop Mark의 중앙에 오도록 커팅 캐리지를 이동합니다.

인쇄와 커팅 방법
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Step 4 : 자동 정렬을 수행하도록 설정 구성

기기에 장착된 센서를 사용하여 Crop Mark를 자동으로 감지합니다. 

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

2. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

CROPMARK
<TOOL MODE>

3. [▶]를 누릅니다.

4. [▲] 또는 [▼]를 눌러 "SENSOR MODE"를 선택합니다.

CROPMARK
 SENSOR MODE

5. [ENTER]를 눌러 설정을 선택합니다.

6. [MENU]를 누르면 원래 화면으로 돌아갑니다.

인쇄와 커팅 방법
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Step 5 : 커팅 조건 설정

절차

1. 소재가 제대로 장착되었는지 확인하십시오.

P. 27 소재 장착

2. [File]>[Cutting Setup]을 클릭합니다.

[Cutting Setup] 창이 표시됩니다.

3. [Name]의 [Printer]에서 [Roland DG GS2-24]를 선택합니다.

모델명이 설정됩니다.

4. [Media Size]에서 [Change]를 클릭합니다.

인쇄와 커팅 방법
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5. [Get from Machine]을 클릭합니다.

연결된 기기에서 인식된 소재의 폭을 불러오면 [Cutting Area]의 [Width]와 [Length]가 업데이트됩
니다.

[The machine is not responding.]가 표시되면 이 기기와 컴퓨터의 설정을 확인하십시오.

P. 297 기기가 작동하지 않는 경우

MEMO

6. [OK]를 클릭합니다.

인쇄와 커팅 방법
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설정이 저장되고 [Cutting Setup] 창이 나타납니다.

7. 커팅 조건을 설정합니다.

일반적으로 [Use cutting conditions of machine] 확인란이 선택됩니다.
커팅 조건을 변경하려면 [Use cutting conditions of machine] 확인란의 선택을 취소하고 값을
입력합니다.

8. [OK]를 클릭합니다.

커팅 범위와 조건이 저장됩니다.

CutStudio에서 흰색으로 표시된 영역이 커팅 범위입니다. 이 영역 밖의 문자 및 도형은 커팅되지 않습니다.

MEMO

인쇄와 커팅 방법
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Step 6 : 커팅

인쇄와 커팅 데이터를 기기로 전송하고 커팅을 시작합니다.

출력이 진행되는 동안 커팅 캐리지를 만지지 마십시오.
커팅 캐리지가 고속으로 이동합니다. 움직이는 캐리지에 닿으면 부상을 입을 수 있습니다.

경고

절차

1. 을 클릭합니다.

[Cut] 창이 표시됩니다.

2. [OK]를 클릭합니다.

인쇄와 커팅 데이터가 기기로 전송됩니다. 기기가인쇄와 커팅 데이터를 수신하면 센서를 사용하여
Crop Mark를 자동으로 감지하여 다음 커팅을 시작합니다.

센서가 Crop Mark를 읽지 못하면 아래와 같은 화면이 나타납니다.
다음 화면이 나타나면 Crop Mark가 감지되지 않는 경우(P.292)를 참조하여 오류를 해결하십시오.

SET TO
<TOOL MODE>

그래도 문제가 해결되지 않으면 Tool Made로 전환한 다음 정렬을 수행하십시오.

MEMO
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P. 177 Tool Mode에서 인쇄와 커팅

3. 커팅 소재를 제거하십시오.

관련된 링크

・ P. 172 소재 제거

인쇄와 커팅 방법

82 CutStudio를 사용하여 커팅 데이터 만들기



이 섹션에서는 CutStudio를 사용하여 데이터를 만드는 데 유용한 사용 방법을 제공합니다.

배치된 이미지의 명암의 농도 변경

CutStudio로 가져온 이미지의 명도를 변경할 수 있습니다. 

절차

1. [File]>[Preference]를 클릭합니다.

2. [General]>[Image Darkness]를 설정합니다.

• 설정 범위 : 1~100%

고급 데이터 생성 방법
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3. [OK]를 클릭합니다.

고급 데이터 생성 방법
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세로 글꼴로 전환

이 절차는 알파벳 글꼴을 지원하지 않습니다.

IMPORTANT

절차

1. 세로 텍스트로 전환할 문자를 선택하려면       을 사용하십시오.

2. 를 클릭합니다.

도킹 패널이 열립니다.

3. [Format] 패널을 선택한 후 [Vertical writing font] 체크 박스를 선택합니다.

텍스트가 가로 쓰기에서 세로 쓰기로 전환됩니다.

고급 데이터 생성 방법
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문자의 방향을 변경하려면 [Size and shape] 패널의 [Angle of Rotation]를 사용합니다.

MEMO

4. 폰트 선택

세로쓰기를 지원하는 폰트가 나타납니다.

고급 데이터 생성 방법
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저장된 기호를 새 컴퓨터로 이동

기호를 저장하는 방법은 CutStudio 도움말을 확인하십시오.

MEMO

절차

폴더가 표시되지 않으면 숨김 파일 표시 설정을 확인합니다.
P. 328 샘플 데이터를 찾을 수 없는 경우

1. 아래 경로에서 [Symbol] 폴더를 복사합니다.

• C:\ProgramData\Roland DG Corporation\CutStudio\Symbol

MEMO

2. [Symbol] 폴더를 새 컴퓨터에 복사합니다.

새 컴퓨터의 동일한 위치에 폴더를 복사합니다.

고급 데이터 생성 방법
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이 섹션에서는 Adobe Illustrator로 커팅 데이터를 만드는 방법과 커팅을 수행하는 방법에 대해 설명합니다.
Adobe Illustrator를 사용하여 만든 커팅 데이터를 CutStudio로 출력하려면 Adobe Illustrator용 
CutStudio 플러그인을 설치해야 합니다.
지원되는 최신 버전에 대한 정보는 Roald DG Corporation 웹사이트(https://www.rolanddg.kr)를 방문하
십시오.

 RELATED LINKS 

・ GS2-24 설치 및 초기 설정 Windows 버전

Step 1 : 커팅 데이터 생성

텍스트와 도형을 입력하고 커팅 데이터를 생성합니다. 이 섹션에서는 Adobe Illustrator 2020을 사용하여 
커팅 데이터를 만드는 방법에 대해 설명합니다. 작업 절차는 다른 버전과 동일합니다.

절차

1. Adobe Illustrator를 시작합니다.

2. [Window]>[Extensions]>[Roland CutStudio]를 클릭합니다.

[Roland CutStudio] 팔레트가 나타납니다.

커팅 방법
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3. 새 문서를 만듭니다.
소재 장착 후 기기 화면에 표시되는 커팅 가능 크기 중 하나로 문서 크기를 설정합니다.

4. 텍스트와 도형을 입력합니다.

이 예에서는 "SALE"을 입력하고 단어를 둘러싸는 선을 그립니다. 이 라인을 "위드 라인"이라고 하며

커팅 데이터를 쉽게 제거하는 데 사용됩니다.

텍스트의 윤곽을 잡습니다. 텍스트를 선택하고 [Roland CutStudio] 팔레트에서       을 클릭하면 텍스트에 아웃
라인이 적용됩니다.

MEMO

커팅 방법
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커팅 방법
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Step 2 : 커팅 데이터를 CutStudio로 출력

Adobe Illustrator로 만든 커팅라인 데이터를 CutStudio로 출력할 수 있습니다. 

절차

1. [Roland CutStudio] 팔레트에서 [Output All Lines]을 선택합니다.

2. 팔레트에서 [Auto Update] 확인란을 선택합니다.

출력할 개체의 미리보기가 표시됩니다.

3. 를 클릭합니다.

CutStudio가 시작되고 커팅라인 데이터가 CutStudio로 전송됩니다.

출력 데이터는 Adobe Illustrator에서의 위치에 관계없이 항상 CutStudio의 원점에 정렬됩니다.
(Crop Mark가 있는 데이터에는 적용되지 않습니다.)

MEMO

커팅 방법
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Step 3 : 커팅 조건 설정

절차

1. 소재가 제대로 장착되고 설정되었는지 확인하십시오.

P. 27 소재 장착

2. [File]>[Cutting Setup]을 클릭합니다.

[Cutting Setup] 창이 표시됩니다.

3. [Name]의 [Printer]에서 [Roland DG GS2-24]를 선택합니다.

모델명이 설정됩니다.

4. [Media Size]에서 [Change]를 클릭합니다.

커팅 방법
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5. [Get from Machine]을 클릭합니다.

연결된 기기에서 커팅 가능 범위를 불러오면 [Cutting Area]의 [Width]와 [Length]가 업데이트
됩니다.

[The machine is not responding.]가 표시되면 이 기기와 컴퓨터의 설정을 확인하십시오.

P. 297 기기가 작동하지 않는 경우

MEMO

6. [OK]를 클릭합니다.

커팅 방법
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설정이 저장되고 [Cutting Setup] 창이 나타납니다.

7. 커팅 조건을 설정합니다.

일반적으로 [Use cutting conditions of machine] 확인란이 선택됩니다.

커팅 조건을 변경하려면 [Use cutting conditions of machine] 확인란의 선택을 취소하고 값을
입력합니다.

8. [OK]를 클릭합니다.

커팅 범위와 조건이 저장됩니다.

CutStudio에서 흰색으로 표시된 영역이 커팅 범위입니다. 이 영역 밖의 문자 및 도형은 잘리지 않습니다.

MEMO

커팅 방법
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Step 4 : 커팅

커팅 데이터를 기기로 전송하고 소재를 커팅합니다.

소재가 떨어지거나 기기가 비정상적으로 작동하면 [PAUSE]를 눌러 출력을 취소하십시오. 로딩 레버를 내리고 소재를 
꺼낸 후 처음부터 다시 설정하십시오.

IMPORTANT

출력이 진행되는 동안 커팅 캐리지를 만지지 마십시오.
커팅 캐리지가 고속으로 이동합니다. 움직이는 캐리지에 닿으면 부상을 입을 수 있습니다.

경고

절차

1. 를 클릭합니다.

[Cut] 창이 표시됩니다.

2. [OK]를 클릭합니다.

커팅이 시작됩니다.

 RELATED LINKS 

・ P. 27 소재 장착

커팅 방법
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Adobe Illustrator 도움말 확인

절차

1. [Window]>[Extensions]>[Roland CutStudio]를 클릭합니다.

[Roland CutStudio] 팔레트가 나타납니다.

2. 팔레트에서      을 클릭합니다.

3. [Help]를 클릭합니다.

커팅 방법
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Step 1 : 인쇄 조건 설정

인쇄와 커팅의 인쇄 범위와 커팅라인을 설정합니다. 

절차

1. Adobe Illustrator를 시작한 다음 새 문서를 엽니다.

아트보드를 설정합니다.

2. [Window]>[Extensions]>[Roland CutStudio]를 클릭합니다.

[Roland CutStudio] 팔레트가 나타납니다.

인쇄와 커팅 방법
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3. 팔레트에서       을 클릭합니다.

Crop Mark가 아트보드에 삽입됩니다.

4. 팔레트에서      를 클릭하고 [Crop-marks]를 클릭합니다.

5. [Type], [Point]를 설정합니다.

[Type]에서 "GS2-24"를 선택합니다.
[Point]는 Crop Mark의 수를 나타냅니다.

When [Point] is "4" Crop marks: 4 points

When [Point] is "3" Crop marks: 3 points

일반적으로 [Point]에서 "4"를 선택합니다. [Point]가 "3"인 경우 Tool Mode를 사용할 수 없습니다.

6. Crop Mark 사이의 여백과 거리를 설정한 후 [OK]을 클릭합니다.

Crop Mark 사이의 여백 및 거리에 대한 자세한 내용은 아래 표를 참조하십시오. 이송량이 많은
소재(긴 소재)를 사용하는 경우 좌우 여백을 약 25mm(0.98in.)로 설정하는 것이 좋습니다.

4개의 Crop Mark가 있는 다른 소재 크기의 Crop Mark 사이의 여백 및 거리(단위: mm(in.))

A4 A3 B4

Y X Y X Y X

[W] 170 230 230 370 205 315

인쇄와 커팅 방법
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A4 A3 B4

Y X Y X Y X

[L] 200 110(4.33in.) 320 195 265 160

[X] 10 30 30 15 15 15

[Y] 20 20 20 20 20 20

3개의 Crop Mark가 있는 다른 소재 크기의 Crop Mark 사이의 여백 및 거리(단위: mm(in.))

A4 A3 B4

Y X Y X Y X

[W] 170 240 240 380(14.96in.) 215 325

[L] 210 120 330 205 275 170

[X] 15 30 30 15 15 15

[Y] 20 20 20 20 20 20

위에 나열된 크기보다 큰 소재를 사용하는 경우 여백과 Crop Mark 사이의 거리(P.338)를 참조하여 값을 
설정합니다.

MEMO

Crop Mark가 아트보드에 표시됩니다.

인쇄와 커팅 방법
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Step 2 : 인쇄와 커팅 데이터 만들기

1. 인쇄 데이터 배치

절차

1. 인쇄 데이터를 가져오려면 [File]>[Placement]를 클릭합니다.

여기서는 CutStudio가 설치된 폴더(일반적으로 C 드라이브의 [Program Files (x86)]>[CutStudio]
폴더에 있음)에 있는 Sample.bmp가 인쇄 데이터로 열립니다.

2. 인쇄 데이터를 선택하고 [Layout Points]를 클릭합니다.

3. Crop Mark 내의 영역에 인쇄 데이터를 배치합니다.

인쇄와 커팅 방법
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2. 인쇄 데이터에 커팅라인 추가

배치된 인쇄 데이터에 커팅 라인을 추가하고 인쇄와 커팅 데이터를 생성합니다. 

절차

1. 커팅 라인용 새 레이어를 만들고 거기에 커팅 라인을 그립니다.

여기에서 아래와 같이 인쇄 데이터 주위에 커팅 라인(①)이 그려집니다.

2. [File]>[Save]를 클릭합니다.

3. 데이터를 저장할 폴더를 선택하고 파일 이름을 입력한 후 [Save]을 클릭합니다.

생성한 인쇄와 커팅 데이터가 저장됩니다.

인쇄와 커팅 방법
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Step 3 : 인쇄와 커팅 데이터 출력

1. 인쇄와 커팅 데이터 인쇄

인쇄 데이터를 프린터로 전송하고 인쇄와 커팅 데이터를 인쇄합니다. 

절차

1. 프린터에 소재를 장착합니다.

프린터에 소재를 장착하는 방법은 프린터 설명서를 참조하십시오.

확대/축소 인쇄가 활성화되면 비활성화하십시오. 100% 배율로 인쇄하십시오.

IMPORTANT

2. 커팅 라인이 포함된 레이어를 숨깁니다.

3. [File]>[Print]를 클릭합니다.

4. 인쇄 설정을 확인하고 [Print]를 클릭합니다.

인쇄 데이터만 인쇄됩니다.

인쇄와 커팅 방법
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2. 인쇄물 장착

프린터에서 인쇄된 인쇄물을 기기에 장착합니다.

IMPORTANT

절차

1. 인쇄물의 커팅 원점(①)을 확인합니다.

2. 기기의 왼쪽 하단에 커팅을 위한 원점을 배치하여 인쇄물을 설정합니다.

인쇄물을 잘못된 방향으로 장착하면 기기가 Crop Mark를 읽을 수 없습니다.

IMPORTANT

3. 핀치 롤러를 배치합니다.

핀치 롤러를 배치할 때 다음 사항에 유의하십시오.

• 핀치롤러(②)를 Tool Mark(①) 바깥쪽에 위치시킨다.
• 핀치 롤러(②)가 그리트 패턴(③)의 범위 내에 있는지 확인하십시오.

인쇄와 커팅 방법
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소재에 컬이 있는 경우 Crop Mark를 감지하지 못할 수 있습니다. 인쇄 시 소재에 컬이 발생하면  기기에 장착하기 전에 
곧게 펴십시오.



Crop Mark 위치를 수동으로 설정합니다. A3, A4, B4 이외의 크기의 소재를 사용하는 경우 다음 사항에 유의하
십시오.

• 가장 왼쪽의 그리트 패턴 내에서 핀치 롤러를 사용하는 경우 그리트 패턴의 왼쪽 끝에서 Crop Mark까지 최소
30mm(1.19in.)(W)를 남겨 두어야 합니다. 간격이 30mm(1.19in.) 미만이면 Crop Mark를 읽을 수 없습니
다.

MEMO

4. 가이드 라인(①)과 거의 평행이 되도록 인쇄물의 왼쪽 가장자리를 정렬합니다.

5. 로딩 레버를 올립니다.

인쇄물이 고정됩니다.

인쇄와 커팅 방법
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기기 위에서 보기



6. 기기를 켭니다.

7. 소재 유형으로 [PIECE]를 선택합니다.

8. [ENTER]를 누릅니다.

커팅 가능한 너비와 길이가 표시됩니다.

W:***mm
L:***mm

9. [▲][▼]를 눌러 인쇄물을 이동하고 Crop Mark(②)를 블레이드 프로텍터(①) 위에 배치합니다.

아래 표시된 상황에서는 Crop MArk를 읽을 수 없습니다. 인쇄물을 한 번 제거한 다음 다시 장착하십시오.

• Crop Mark가 블레이드 프로텍터(①)에서 15mm(0.60in.) 이상(②) 떨어져 있는 경우
• 커팅 캐리지의 이동 방향에서 좌/우측 Crop Mark가 5˚ 이상(③) 기울어져 있는 경우
• 좌/우측 Crop Mark가 소재 공급 방향으로 20mm(0.79in.) 이상(④) 벗어난 경우

IMPORTANT

인쇄와 커팅 방법
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10.     [◀][▶]를 눌러 블레이드의 팁이 왼쪽 하단 Crop Mark의 중앙에 오도록 커팅 캐리지를 이동합니다.

인쇄와 커팅 방법
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Step 4 : 자동 정렬을 수행하도록 설정 구성

기기의 센서를 사용하여 Crop Mark를 자동으로 배치합니다. 

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

2. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

CROPMARK
<TOOL MODE>

3. [▶]를 누릅니다.

4. [▲] 또는 [▼]를 눌러 "SENSOR MODE"를 선택합니다.

CROPMARK
 SENSOR MODE

5. [ENTER]를 눌러 설정을 선택합니다.

6. [MENU]를 누르면 원래 화면으로 돌아갑니다.

인쇄와 커팅 방법
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Step 5 : 인쇄와 커팅 데이터를 CutStudio로 보내기

절차

1. Adobe Illustrator로 그린 커팅 라인이 포함된 레이어를 표시하고 선택합니다.

2. [Roland CutStudio] 팔레트에서 [Output Current Layer]을 선택한 후 [Update]를 클릭합니다.

출력할 커팅 라인이 미리 보기 화면에 표시되는지 확인합니다.

3. 를 클릭합니다.

CutStudio가 시작되고 커팅 라인 데이터가 CutStudio로 전송됩니다.

인쇄와 커팅 방법
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Step 6 : 커팅 조건 설정

절차

1. [File]>[Cutting Setup].를 클릭합니다.

[Cutting Setup] 창이 표시됩니다.

2. [Name]의 [Printer]에서 [Roland DG GS2-24]를 선택합니다.

모델명이 설정됩니다.

3. [Media Size]에서 [Change]를 클릭합니다.

인쇄와 커팅 방법
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4. [Get from Machine]을 클릭합니다.

연결된 기기에서 커팅 가능 범위를 불러오면 [Cutting Area]의 [Width]와 [Length]가 업데이트
됩니다.

[The machine is not responding.]가 표시되면 이 기기와 컴퓨터의 설정을 확인하십시오.

P. 297 기기가 작동하지 않는 경우

MEMO

5. [OK]를 클릭합니다.

인쇄와 커팅 방법
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설정이 저장되고 [Cutting Setup] 창이 나타납니다.

6. 커팅 조건을 설정합니다.

일반적으로 [Use cutting conditions of machine] 확인란이 선택됩니다.

커팅 조건을 변경하려면 [Use cutting conditions of machine] 확인란의 선택을 취소하고 값을
입력합니다.

7. [OK]를 클릭합니다.

커팅 범위와 조건이 저장됩니다.

CutStudio에서 흰색으로 표시된 영역이 커팅 범위입니다. 이 영역 밖의 문자 및 도형은 커팅되지 않습니다.

MEMO
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Step 7 : 커팅

인쇄와 커팅 데이터를 기기로 전송하고 커팅을 시작합니다.

출력이 진행되는 동안 커팅 캐리지를 만지지 마십시오.
커팅 캐리지가 고속으로 이동합니다. 움직이는 캐리지에 닿으면 부상을 입을 수 있습니다.

경고

절차

1. 를 클릭합니다.

[Cut] 창이 표시됩니다.

2. [OK]를 클릭합니다.

인쇄와 커팅 데이터가 기기로 전송됩니다. 기기가 인쇄와 커팅 데이터를 수신하면 센서를 사용하여
Crop Mark를 자동으로 감지 후 커팅을 시작합니다.

센서가 Crop Mark를 감지하지 못하면 아래와 같은 화면이 나타납니다.
다음 화면이 나타나면 Crop Mark가 감지되지 않는 경우(P. 292)를 참조하여 오류를 해결하십시오. 
그래도 문제가 해결되지 않으면 Tool Mode로 전환한 다음 정렬을 수행하십시오.

P. 177 Tool Mode에서 인쇄와 커팅

SET TO
<TOOL MODE>

MEMO
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3. 커팅된 소재를 제거하십시오.

 RELATED LINKS 

・ P. 172 소재 제거

인쇄와 커팅 방법
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이 섹션에서는 Adobe Illustrator로 커팅 데이터를 만드는 방법과 커팅을 수행하는 방법에 대해 설명합니다.
Adobe Illustrator를 사용하여 만든 컷 데이터를 출력하려면 Adobe Illustrator용 CutStudio Plug-in을 설치
해야 합니다.
지원되는 최신 버전에 대한 정보는 Roland DG Corporation 웹사이트 (https://www.rolanddg.kr/)를 방문
하십시오.

 RELATED LINKS 
・ GS2-24 Macintosh 컴퓨터의 설치 및 초기 설정

Step 1 : 커팅 데이터 생성

텍스트와 도형을 입력하고 커팅 데이터를 생성합니다. 이 섹션에서는 Adobe Illustrator 2020을 사용하여 
커팅 데이터를 만드는 방법에 대해 설명합니다. 작업 절차는 다른 버전과 동일합니다.

절차

1. Adobe Illustrator를 시작합니다.

2. [Window]>[Extensions]>[Roland CutStudio]를 클릭합니다.

[Roland CutStudio] 팔레트가 나타납니다.

커팅 방법
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3. 새 문서를 만듭니다.
소재 설정 후 기기 화면에 표시되는 커팅 가능 크기 중 하나로 문서 크기를 설정합니다.

4. 텍스트와 도형을 입력합니다.

이 예에서는 "SALE"을 입력하고 단어를 둘러싸는 라인을 그립니다. 이 라인을 "위드 라인"이라고 하

며 커팅 데이터를 쉽게 제거하는 데 사용됩니다.

텍스트의 윤곽을 잡습니다. 텍스트를 선택하고 [Roland CutStudio] 팔레트에서        를 클릭하면 텍스트에 
아웃라인이 적용됩니다.

MEMO
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Step 2 : 커팅 조건 설정

절차

1. 소재가 제대로 장착되고 설정되었는지 확인하십시오.

P. 27 소재 장착

2. [Roland CutStudio] 패널에서 [MODEL] 아래의 [GS2-24]를 선택합니다.

3. 패널에서 [Update Information]을 클릭합니다.

커팅 가능한 범위는 연결된 기기에서 가져오고 [Media]의 디스플레이가 업데이트됩니다.

[The machine is not responding.]가 표시되면 이 기기와 컴퓨터의 설정을 확인하십시오.

P. 297 기기가 작동하지 않는 경우

MEMO

4. 팔레트에서      을 클릭하고 [Preferences]를 클릭합니다.

5. [Use Cut Setting] 확인란을 선택합니다.
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6. [OK]를 클릭합니다.

7. 팔레트에서      를 클릭하고 [Cut Setting]을 클릭합니다.

[Cut Setting]을 선택하면 [Cut Setting]이 나타납니다.

8. 커팅 조건을 설정합니다.

일반적으로 [Use Machine Setting] 확인란이 선택되어 있습니다.
커팅 조건을 변경하려면 [Use Machine Setting] 확인란의 선택을 취소하고 값을 입력합니다.

9. [OK]를 클릭합니다.

커팅 범위와 조건이 저장됩니다.

커팅 방법
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Step 3 : 커팅

커팅 데이터를 기기로 전송하고 소재를 커팅합니다.

소재가 떨어지거나 기기가 비정상적으로 작동하면 [PAUSE]를 눌러 출력을 취소하십시오.
로딩 레버를 내리고 소재를 꺼낸 후 처음부터 다시 설정하십시오.

IMPORTANT

출력이 진행되는 동안 커팅 캐리지를 만지지 마십시오.
커팅 캐리지가 고속으로 이동합니다. 움직이는 캐리지에 닿으면 부상을 입을 수 있습니다.

경고

절차

1. [Roland CutStudio] 팔레트에서 [Output All Lines]을 선택한 후 [Update]를 클릭합니다.

출력할 커팅 라인이 미리 보기 화면에 표시되는지 확인합니다.

2. 팔레트에서 를 클릭합니다.

3. [Roland GS2-24]를 선택하고 [Cut]을 클릭합니다.

커팅이 시작됩니다.

모델명이 나타나지 않으면 기기가 작동하지 않는 경우를 참조합니다.

4. 커팅이 끝나면 [Exit]를 클릭하여 창을 닫습니다.
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Step 1 : 인쇄 조건 설정

인쇄와 커팅의 인쇄 범위와 커팅 라인을 설정합니다. 

절차

1. Adobe Illustrator를 시작하고 새 문서를 엽니다.

아트보드를 설정합니다.

2. [Window]>[Extensions]>[Roland CutStudio]를 클릭합니다.

[Roland CutStudio] 팔레트가 나타납니다.

3. 팔레트에서       을 클릭합니다.

Crop Mark가 아트보드에 삽입됩니다.

4. 팔레트에서      를 클릭하고 [Crop-marks]를 클릭합니다.

인쇄와 커팅 방법
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5. [Type], [Point]를 설정합니다.

[Type]에서 "GS2-24"를 선택합니다.

[Point]은 Crop Mark의 수를 나타냅니다.

When [Point] is "4" Crop marks: 4 points

When [Point] is "3" Crop marks: 3 points

일반적으로 [Point]에서 "4"를 선택합니다. [Point]가 "3"인 경우 Tool Mode를 사용할 수 없습니다.

6. Crop Mark 사이의 여백과 거리를 설정한 후 [OK]를 클릭합니다.

Crop Mark 사이의 여백 및 거리에 대한 자세한 내용은 아래 표를 참조하십시오. 이송량이 많은 소
재(긴 소재)를 사용하는 경우 좌우 여백을 약 25mm(0.98in.)로 설정하는 것이 좋습니다.

4개의 Crop Mark가 있는 다른 소재 크기의 Crop Mark 사이의 여백 및 거리(단위: mm(in.))

A4 A3 B4

Y X Y X Y X

[W] 170 230 230 370 205 315

[L] 200 110(4.33in.) 320 195 265 160

[X] 10 30 30 15 15 15

[Y] 20 20 20 20 20 20

3개의 Crop Mark가 있는 다른 소재 크기의 Crop Mark 사이의 여백 및 거리(단위: mm(in.))

A4 A3 B4

Y X Y X Y X

[W] 170 240 240 380(14.96in.) 215 325

인쇄와 커팅 방법
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A4 A3 B4

Y X Y X Y X

[L] 210 120 330 205 275 170

[X] 15 30 30 15 15 15

[Y] 20 20 20 20 20 20

위에 나열된 크기보다 큰 소재를 사용하는 경우 여백과 Crop Mark 사이의 거리(P.338)를 참조하여 값을 
설정합니다.

MEMO

Crop Mark가 아트보드에 표시됩니다.

인쇄와 커팅 방법
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Step 2 : 인쇄와 커팅 데이터 생성

1. 인쇄 데이터 배치

절차

1. 인쇄 데이터를 가져오려면 [File]>[Placement]를 클릭합니다.

2. Crop Mark 내의 영역에 인쇄 데이터를 배치합니다.

인쇄와 커팅 방법
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2. 인쇄 데이터에 커팅 라인 추가

배치된 인쇄 데이터에 커팅 라인을 추가하고 인쇄와 커팅 데이터를 생성합니다.

절차

1. 커팅 라인용 새 레이어를 만들고 거기에 커팅 라인을 그립니다.

여기에서 아래와 같이 인쇄 데이터 주위에 커팅 라인(①)이 그려집니다.

2. [File]>[Save]를 클릭합니다.

3. 데이터를 저장할 폴더를 선택하고 파일 이름을 입력한 후 [Save]를 클릭합니다.

생성한 인쇄와 커팅 데이터가 저장됩니다.

인쇄와 커팅 방법
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Step 3 : 인쇄와 커팅 데이터 출력

1. 인쇄와 커팅 데이터 인쇄

인쇄 데이터를 프린터로 전송하고 인쇄와 커팅 데이터를 인쇄합니다. 

절차

1. 프린터에 소재를 장착합니다.

프린터에 소재를 장착하는 방법은 프린터 설명서를 참조하십시오.

확대/축소 인쇄가 활성화되면 비활성화하십시오. 100% 배율로 인쇄하십시오.

IMPORTANT

2. 커팅 라인이 포함된 레이어를 숨깁니다.

3. [File]>[Print]를 클릭합니다.

4. 인쇄 설정을 확인하고 [Print]를 클릭합니다.

인쇄 데이터만 인쇄됩니다.

인쇄와 커팅 방법
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2. 인쇄물 장착

프린터에서 인쇄된 인쇄물을 기기에 장착합니다.

IMPORTANT

절차

IMPORTANT

인쇄와 커팅 방법
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소재에 컬이 있는 경우 Crop Mark를 감지하지 못할 수 있습니다. 인쇄 시 소재에 컬이 발생하면  기기에 장착하기 전에 
곧게 펴십시오.

1. 인쇄물의 커팅 원점(①)을 확인합니다.

2. 기기의 왼쪽 하단에 커팅을 위한 원점을 배치하여 인쇄물을 설정합니다.

인쇄물을 잘못된 방향으로 장착하면 기기가 Crop Mark를 읽을 수 없습니다.

3. 핀치 롤러를 배치합니다.

핀치 롤러를 배치할 때 다음 사항에 유의하십시오.

• 핀치롤러(②)를 Tool Mark(①) 바깥쪽에 위치시킨다.
• 핀치 롤러(②)가 그리트 패턴(③)의 범위 내에 있는지 확인하십시오.



MEMO

인쇄와 커팅 방법
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Crop Mark 위치를 수동으로 설정합니다. A3, A4, B4 이외의 크기의 소재를 사용하는 경우 다음 사항에 유의하
십시오.

• 가장 왼쪽의 그리트 패턴 내에서 핀치 롤러를 사용하는 경우 그리트 패턴의 왼쪽 끝에서 Crop Mark까지 최소
30mm(1.19in.)(W)를 남겨 두어야 합니다. 간격이 30mm(1.19in.) 미만이면 Crop Mark를 읽을 수 없습니
다.

4. 가이드 라인(①)과 거의 평행이 되도록 인쇄물의 왼쪽 가장자리를 정렬합니다.

5. 로딩 레버를 올립니다.

인쇄물이 고정됩니다.

기기 위에서 보기



W:***mm
L:***mm

IMPORTANT

인쇄와 커팅 방법
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6. 기기를 켭니다.

7. 소재 유형으로 [PIECE]를 선택합니다.

8. [ENTER]를 누릅니다.

커팅 가능한 너비와 길이가 표시됩니다.

9. [▲][▼]를 눌러 인쇄물을 이동하고 Crop Mark(②)를 블레이드 프로텍터(①) 위에 배치합니다.

아래 표시된 상황에서는 Crop MArk를 읽을 수 없습니다. 인쇄물을 한 번 제거한 다음 다시 장착하십시오.

• Crop Mark가 블레이드 프로텍터(①)에서 15mm(0.60in.) 이상(②) 떨어져 있는 경우
• 커팅 캐리지의 이동 방향에서 좌/우측 Crop Mark가 5˚ 이상(③) 기울어져 있는 경우
• 좌/우측 Crop Mark가 소재 공급 방향으로 20mm(0.79in.) 이상(④) 벗어난 경우
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10. [◀][▶]를 눌러 블레이드의 팁이 왼쪽 하단 Crop Mark의 중앙에 오도록 커팅 캐리지를 이동합니다.



Step 4 : 자동 정렬을 수행하도록 설정 구성

UNSETUP

CROPMARK
<TOOL MODE>

CROPMARK
 SENSOR MODE

인쇄와 커팅 방법
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기기의 센서를 사용하여 Crop Mark를 자동으로 배치합니다. 

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

2. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

3. [▶]를 누릅니다.

4. [▲] 또는 [▼]를 눌러 "SENSOR MODE"를 선택합니다.

5. [ENTER]를 눌러 설정을 선택합니다.

6. [MENU]를 누르면 원래 화면으로 돌아갑니다.



Step 5 : 커팅 조건 설정

절차

1. 소재가 올바르게 장착되고 설정되었는지 확인하십시오.

P. 27 소재 장착

2. [Roland CutStudio] 패널에서 [MODEL] 아래의 [GS2-24]를 선택합니다.

3. 패널에서 [Update Information]을 클릭합니다.

커팅 가능한 범위는 연결된 기기에서 가져오고 [Media]의 디스플레이가 업데이트됩니다.

[The machine is not responding.]가 표시되면 이 기기와 컴퓨터의 설정을 확인하십시오.
P. 297 기기가 작동하지 않는 경우

MEMO

4. 팔레트에서      을 클릭하고 [Preferences]을 클릭합니다.

5. [Use Cut Setting] 확인란을 선택합니다.

인쇄와 커팅 방법

Adobe Illustrator를 사용하여 커팅 데이터 만들기(Mac) 137



6. [OK]를 클릭합니다.

7. 팔레트에서      를 클릭하고 [Cut Setting]을 클릭합니다.

[Cut Setting]을 선택하면 [Cut Setting]이 나타납니다.

8. 커팅 조건을 설정합니다.

일반적으로 [Use Machine Setting] 확인란이 선택되어 있습니다.
커팅 조건을 변경하려면 [Use Machine Setting] 확인란의 선택을 취소하고 값을 입력합니다.

9. [OK]를 클릭합니다.

커팅 범위와 조건이 저장됩니다.

인쇄와 커팅 방법

138 Adobe Illustrator를 사용하여 커팅 데이터 만들기(Mac)



Step 6 : 커팅

데이터를 기기로 보내고 인쇄물 커팅을 시작하십시오.

출력이 진행되는 동안 커팅 캐리지를 만지지 마십시오.
커팅 캐리지가 고속으로 이동합니다. 움직이는 캐리지에 닿으면 부상을 입을 수 있습니다.

경고

절차

1. 커팅 라인이 포함된 레이어를 표시하고 선택합니다.

출력할 커팅 라인이 미리 보기 화면에 표시되는지 확인합니다.

2. [Output Current Layer]를 선택합니다.

출력할 커팅 라인이 미리 보기 화면에 표시되는지 확인합니다.

커팅 설정을 변경하거나 확인하려면 Step 2 : 커팅 조건 설정을 참조하십시오.

3. 팔레트에서            를 클릭합니다.

4. [Roland GS2-24]를 선택하고 [Cut]를 클릭합니다.

커팅 데이터가 기기로 전송됩니다. 기기가 데이터를 수신하면 센서를 사용하여 Crop Mark를 자동
으로 감지 후 커팅을 시작합니다.

인쇄와 커팅 방법
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모델명이 나타나지 않으면 기기가 작동하지 않는 경우를 참조하십시오.

MEMO

센서가 Crop Mark를 감지하지 못하면 아래와 같은 화면이 나타납니다.
아래와 같은 화면이 나타나면 Crop Mark가 감지되지 않는 경우를 참조하여 오류를 해결합니다.

SET TO
<TOOL MODE>

그래도 문제가 해결되지 않으면 Tool Mode로 전환한 다음 정렬을 수행하십시오.
P. 177 Tool Mode에서 인쇄와 커팅

MEMO

5. 커팅이 끝나면 [Exit]를 클릭하여 창을 닫습니다.

6. 커팅된 인쇄물을 제거하십시오.

 RELATED LINKS 

・ P. 172 소재 제거

인쇄와 커팅 방법
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 RELATED LINKS 

・ GS2-24 설치 및 초기 설정 Windows 버전

Step 1 : 커팅 데이터 생성

텍스트와 도형을 입력하고 커팅 데이터를 생성합니다. 이 섹션에서는 CorelDRAW 2020을 사용하여 커팅 
데이터를 만드는 방법을 설명합니다. 작업 절차는 다른 버전과 동일합니다.

절차

1. CorelDRAW를 시작합니다.

2. 도구 모음에서      를 클릭합니다.

[Roland CutStudio] 팔레트가 나타납니다.

3. 새 문서를 만듭니다.
소재 장착 후 기기 화면에 표시되는 커팅 가능 크기 중 하나로 문서 크기를 설정합니다.

4. 텍스트와 도형을 입력합니다.

이 예에서는 "SALE"을 입력하고 단어를 둘러싸는 라인을 그립니다. 이 라인을 "위드 라인"이라고

하며 커팅 데이터를 쉽게 제거하는 데 사용됩니다.

커팅 방법
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이 섹션에서는 CorelDRAW로 커팅 데이터를 만드는 방법과 커팅을 수행하는 방법에 대해 설명합니다.
CorelDRAW를 사용하여 만든 컷 데이터를 출력하려면 CorelDRAW용 CutStudio Plug-in을 설치해야 합니
다.
지원되는 최신 버전에 대한 정보는 Roland DG Corporation 웹사이트 (https://www.rolanddg.kr/)를 방문
하십시오.

https://downloadcenter.rolanddg.com/contents/manuals/GS2-24_INS2-H_WIN_JP/index.html


텍스트의 윤곽을 잡습니다. 텍스트를 선택하고 [Roland CutStudio] 팔레트에서         을 클릭하면 텍스트에 
아웃라인이 적용됩니다.

MEMO

커팅 방법
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Step 2 : 커팅 데이터를 CutStudio로 출력

CorelDRAW에서 만든 커팅 데이터를 CutStudio로 보냅니다.

절차

1. [Roland CutStudio] 팔레트에서 [Output All Lines]을 선택합니다.

2. [Auto Update] 확인란을 선택합니다.

출력할 커팅 라인이 미리 보기 화면에 표시되는지 확인합니다.

3. 를 클릭합니다.

CutStudio가 시작되고 커팅 라인 데이터가 CutStudio로 전송됩니다.

출력 데이터는 CorelDRAW의 위치에 관계없이 항상 CutStudio의 원점에 정렬됩니다.

MEMO

커팅 방법
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CorelDRAW에서 생성된 데이터는 다음 조건에서 CutStudio로 출력됩니다.

• 그려진 모든 그래픽은 CutStudio로 출력됩니다.
• 문자열은 CutStudio로 출력되지 않습니다. 출력하기 전에 개요를 작성하십시오.
• 라인 너비, 채우기 및 화살표는 무시됩니다.
• 너비가 없는 라인은 출력되지 않습니다.
• 이미지는 출력되지 않습니다.

MEMO

커팅 방법
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Step 3 : 커팅 조건 설정

절차

1. 소재가 올바르게 장착되고 설정되었는지 확인하십시오.

P. 27 소재 장착

2. [File]>[Cutting Setup]를 클립합니다.

[Cutting Setup] 창이 표시됩니다.

3. [Name]의 [Printer]에서 [Roland DG GS2-24]를 선택합니다.

모델명이 설정됩니다.

4. [Media Size]에서 [Change]을 클릭합니다.

커팅 방법
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5. [Get from Machine]를 클릭합니다.

연결된 기기에서 커팅 가능 범위를 불러오면 [Cutting Area]의 [Width]와 [Length]가 업데이트
됩니다.

[The machine is not responding.]가 표시되면 이 기기와 컴퓨터의 설정을 확인하십시오.

P. 297 기기가 작동하지 않는 경우

MEMO

6. [OK]를 클릭합니다.

커팅 방법
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설정이 저장되고 [Cutting Setup] 창이 나타납니다.

7. 커팅 조건을 설정합니다.

일반적으로 [Use cutting conditions of machine] 확인란이 선택됩니다.
커팅 조건을 변경하려면 [Use cutting conditions of machine] 확인란의 선택을 취소하고 값을
입력합니다.

8. [OK]를 클릭합니다.

커팅 범위와 조건이 저장됩니다.

CutStudio에서 흰색으로 표시된 영역이 커팅 범위입니다. 이 영역 밖의 문자 및 도형은 커팅되지 않습니다.

MEMO
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커팅 방법
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Step 4 : 커팅

커팅 데이터를 기기로 전송하고 소재를 커팅합니다.

소재가 떨어지거나 기기가 비정상적으로 작동하면 [PAUSE]를 눌러 출력을 취소하십시오. 로딩 레버를 내리고 소재를 
꺼낸 후 처음부터 다시 설정하십시오.

IMPORTANT

출력이 진행되는 동안 커팅 캐리지를 만지지 마십시오.
커팅 캐리지가 고속으로 이동합니다. 움직이는 캐리지에 닿으면 부상을 입을 수 있습니다.

경고

절차

1. 을 클릭합니다.

[Cut] 창이 표시됩니다.

2. [OK]를 클릭합니다.

커팅이 시작됩니다.

 RELATED LINKS 

・ P. 27 소재 장착

커팅 방법
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CorelDRAW 도움말 확인

절차

1. 도구 모음에서       를 클릭합니다.

[Roland CutStudio] 팔레트가 나타납니다.

2. 팔레트에서       를 클릭합니다.

3. [Help]를 클릭합니다.

커팅 방법
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Step 1 : 인쇄 조건 설정

인쇄와 커팅의 인쇄 범위와 Crop Mark를 설정합니다. 

절차

1. CorelDRAW를 시작한 다음 새 문서를 엽니다.

문서 크기를 설정합니다.

2. 도구 모음에서       를 클릭합니다.

[Roland CutStudio] 팔레트가 나타납니다.

3. 팔레트에서         을 클릭합니다.

Crop Mark가 문서에 삽입됩니다.
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4. 팔레트에서       을 클릭하고 [Crop-marks]를 클릭합니다.

5. [Type], [Point]를 설정합니다.

[Type]에서 "GS2-24"를 선택합니다.

[Point]는 Crop Mark의 수를 나타냅니다.

[Point]가 "4"인 경우 Crop Mark : 4개

[Point]가 "3"인 경우 Crop Mark : 3개

인쇄와 커팅 방법
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일반적으로 [Point]에서 "4"를 선택합니다. [Point]가 "3"인 경우 Tool Mode를 사용할 수 없습니다.

6. Crop Mark 사이의 여백과 거리를 설정한 후 [OK]를 클릭합니다.

Crop Mark 사이의 여백 및 거리에 대한 자세한 내용은 아래 표를 참조하십시오. 이송량이 많은 소재(긴
소재)를 사용하는 경우 좌우 여백을 약 25mm(0.98in.)로 설정하는 것이 좋습니다.

4개의 Crop Mark가 있는 다른 소재 크기의 Crop Mark 사이의 여백 및 거리(단위: mm(in.))

A4 A3 B4

Y X Y X Y X

[W] 170 230 230 370 205 315

[L] 200 110(4.33in.) 320 195 265 160

[X] 10 30 30 15 15 15

[Y] 20 20 20 20 20 20

3개의 Crop Mark가 있는 다른 소재 크기의 Crop Mark 사이의 여백 및 거리(단위: mm(in.))

A4 A3 B4

Y X Y X Y X

[W] 170 240 240 380(14.96in.) 215 325

[L] 210 120 330 205 275 170

[X] 15 30 30 15 15 15

[Y] 20 20 20 20 20 20

위에 나열된 크기보다 큰 소재를 사용하는 경우 여백과 Crop Mark 사이의 거리(P. 338)를 참조하여 값을 
설정합니다.

MEMO

Crop Mark가 아트보드에 표시됩니다.

인쇄와 커팅 방법
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Step 2 : 인쇄와 커팅 데이터 생성

1. 인쇄 데이터 배치

절차

1. [File]>[Import]를 클릭하여 인쇄 데이터를 가져옵니다.

여기서는 CutStudio가 설치된 폴더(일반적으로 C 드라이브의 [Program Files (x86)]>[CutStudio]
폴더에 있음)에 있는 Sample.bmp가 인쇄 데이터로 열립니다.

2. 인쇄 데이터를 선택하고 [Import]를 클릭합니다.

3. Crop Mark내의 영역에 인쇄 데이터를 배치합니다.

인쇄와 커팅 방법
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2. 인쇄 데이터에 커팅 라인 추가

배치된 인쇄 데이터에 커팅 라인을 추가하고 인쇄와 커팅 데이터를 생성합니다. 

절차

1. 커팅 라인용 새 레이어를 만들고 거기에 커팅 라인을 그립니다.

여기에서 아래와 같이 인쇄 데이터 테두리에 커팅라인(①)이 그려집니다.

2. [File]>[Save]를 클릭합니다.

3. 데이터를 저장할 폴더를 선택하고 파일 이름을 입력한 후 [Save]를 클릭합니다.

생성한 인쇄와 커팅 데이터가 저장됩니다.

인쇄와 커팅 방법
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Step 3 : 인쇄와 커팅 데이터 출력

1. 인쇄와 커팅 데이터 인쇄

인쇄 데이터를 프린터로 전송하고 인쇄와 커팅 데이터를 인쇄합니다.

절차

1. 프린터에 인쇄물을 장착합니다.

프린터에 인쇄물을 장착하는 방법은 프린터 설명서를 참조하십시오.

확대/축소 인쇄가 활성화되면 비활성화하십시오. 100% 배율로 인쇄하십시오.

IMPORTANT

2. 커팅 라인이 포함된 레이어를 숨깁니다.

3. [File]>[Print]를 클릭합니다.

4. 인쇄 설정을 확인하고 [Print]를 클릭합니다.

인쇄 데이터만 인쇄됩니다.

인쇄와 커팅 방법
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2. 인쇄물 장착

프린터에서 인쇄된 인쇄물을 기기에 장착합니다.

IMPORTANT

절차

IMPORTANT

인쇄와 커팅 방법
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소재에 컬이 있는 경우 Crop Mark를 감지하지 못할 수 있습니다. 인쇄 시 소재에 컬이 발생하면  기기에 장착하기 전에 
곧게 펴십시오.

1. 인쇄물의 커팅 원점(①)을 확인합니다.

2. 기기의 왼쪽 하단에 커팅을 위한 원점을 배치하여 인쇄물을 설정합니다.

인쇄물을 잘못된 방향으로 장착하면 기기가 Crop Mark를 읽을 수 없습니다.

3. 핀치 롤러를 배치합니다.

핀치 롤러를 배치할 때 다음 사항에 유의하십시오.

• 핀치롤러(②)를 Tool Mark(①) 바깥쪽에 위치시킨다.
• 핀치 롤러(②)가 그리트 패턴(③)의 범위 내에 있는지 확인하십시오.



MEMO
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Crop Mark 위치를 수동으로 설정합니다. A3, A4, B4 이외의 크기의 소재를 사용하는 경우 다음 사항에 유의하
십시오.

• 가장 왼쪽의 그리트 패턴 내에서 핀치 롤러를 사용하는 경우 그리트 패턴의 왼쪽 끝에서 Crop Mark까지 최소
30mm(1.19in.)(W)를 남겨 두어야 합니다. 간격이 30mm(1.19in.) 미만이면 Crop Mark를 읽을 수 없습니
다.

4. 가이드 라인(①)과 거의 평행이 되도록 인쇄물의 왼쪽 가장자리를 정렬합니다.

5. 로딩 레버를 올립니다.

인쇄물이 고정됩니다.

기기 위에서 보기



W:***mm
L:***mm

IMPORTANT

인쇄와 커팅 방법
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6. 기기를 켭니다.

7. 소재 유형으로 [PIECE]를 선택합니다.

8. [ENTER]를 누릅니다.

커팅 가능한 너비와 길이가 표시됩니다.

9. [▲][▼]를 눌러 인쇄물을 이동하고 Crop Mark(②)를 블레이드 프로텍터(①) 위에 배치합니다.

아래 표시된 상황에서는 Crop MArk를 읽을 수 없습니다. 인쇄물을 한 번 제거한 다음 다시 장착하십시오.

• Crop Mark가 블레이드 프로텍터(①)에서 15mm(0.60in.) 이상(②) 떨어져 있는 경
• 커팅 캐리지의 이동 방향에서 좌/우측 Crop Mark가 5˚ 이상(③) 기울어져 있는 경
• 좌/우측 Crop Mark가 소재 공급 방향으로 20mm(0.79in.) 이상(④) 벗어난 경
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10. [◀][▶]를 눌러 블레이드의 팁이 왼쪽 하단 Crop Mark의 중앙에 오도록 커팅 캐리지를 이동합니다.



Step 4 : 자동 정렬을 수행하도록 설정 구성

기기의 센서를 사용하여 Crop Mark를 자동으로 배치합니다.

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

2. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

CROPMARK
<TOOL MODE>

3. [▶]를 누릅니다.

4. [▲] 또는 [▼]를 눌러 "SENSOR MODE"를 선택합니다.

CROPMARK
 SENSOR MODE

인쇄와 커팅 방법
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5. [ENTER]를 눌러 설정을 선택합니다.

6. [MENU]를 누르면 원래 화면으로 돌아갑니다.



Step 5 : 인쇄와 커팅 데이터를 CutStudio로 보내기

절차

1. CorelDRAW에서 커팅라인이 포함된 레이어를 표시하고 선택합니다.

2. [Roland CutStudio] 팔레트에서 [Output Current Layer]를 선택한 후 [Update]를 클릭합니다.

출력할 커팅 라인이 미리 보기 화면에 표시되는지 확인합니다.

3. 를 클릭합니다.

CutStudio가 시작되고 커팅 라인 데이터가 CutStudio로 전송됩니다.

인쇄와 커팅 방법
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Step 6 : 커팅 조건 설정

절차

1. [File]>[Cutting Setup]를 클릭합니다.

[Cutting Setup] 창이 표시됩니다.

2. [Name]의 [Printer]에서 [Roland DG GS2-24]를 선택합니다.

모델명이 설정됩니다.

3. [Media Size]에서 [Change]를 클릭합니다.

인쇄와 커팅 방법
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4. [Get from Machine]를 클릭합니다.

연결된 기기에서 커팅 가능 범위를 불러오면 [Cutting Area]의 [Width]와 [Length]가 업데이트
됩니다.

[The machine is not responding.]가 표시되면 이 기기와 컴퓨터의 설정을 확인하십시오.

P. 297 기기가 작동하지 않는 경우

MEMO

5. [OK]를 클릭합니다.
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166 CorelDRAW를 사용하여 커팅 데이터 만들기



설정이 저장되고 [Cutting Setup] 창이 나타납니다.

6. 커팅 조건을 설정합니다.

일반적으로 [Use cutting conditions of machine] 확인란이 선택됩니다.

커팅 조건을 변경하려면 [Use cutting conditions of machine] 확인란의 선택을 취소하고 값을
입력합니다.

7. [OK]를 클릭합니다.

커팅 범위와 조건이 저장됩니다.

CutStudio에서 흰색으로 표시된 영역이 커팅 범위입니다. 이 영역 밖의 문자 및 도형은 커팅되지 않습니다.

MEMO

인쇄와 커팅 방법
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Step 7 : 커팅

인쇄와 커팅 데이터를 기기로 전송하고 커팅을 시작합니다.

출력이 진행되는 동안 커팅 캐리지를 만지지 마십시오.
커팅 캐리지가 고속으로 이동합니다. 움직이는 캐리지에 닿으면 부상을 입을 수 있습니다.

경고

절차

1. CutStudio에서        을 클릭합니다.

[Cut] 창이 표시됩니다.

2. [OK]를 클릭합니다.

인쇄와 커팅 데이터가 기기로 전송됩니다. 기기가 인쇄와 커팅 데이터를 수신하면 센서를 사용하여
Crop Mark를 자동으로 감지하고 커팅을 시작합니다.

센서가 Crop Mark를 읽지 못하면 아래와 같은 화면이 나타납니다.
다음 화면이 나타나면  Crop Mark가 감지되지 않는 경우(P. 292)를 참조하여 오류를 해결하십시
오. 그래도 문제가 해결되지 않으면 Tool Mode로 전환한 다음 정렬을 수행하십시오.

P. 177 Tool Mode에서 인쇄와 커팅
SET TO
<TOOL MODE>

MEMO
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3. 커팅된 인쇄물을 제거하십시오.

 RELATED LINKS 

・ P. 172 소재 제거

인쇄와 커팅 방법
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출력 후 절차
소재 제거/절단 ..................................................................................... 172

소재 제거 ..................................................................................... 172
소재 절단 ..................................................................................... 174

출력 일시 중지 및 취소 ........................................................................... 175
출력 일시 중지 ............................................................................... 175
출력 취소 ..................................................................................... 175
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출력 후 기기에서 소재를 제거하거나 잘라냅니다.

소재 제거

커팅이 완료되면 소재를 제거하십시오. 

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

2. [ENTER]를 누릅니다.

커팅 캐리지가 홈 위치로 돌아갑니다.

3. 로딩 레버를 내립니다.

로딩 레버를 움직일 때 과도한 힘을 가하지 마십시오. 
손상될 수 있습니다.

IMPORTANT

4. 소재를 제거하십시오.

소재 제거/절단
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소재 절단

출력 후 필요에 따라 소재를 잘라냅니다. 

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

W:***mm
L:***mm

2. [▲][▼]를 눌러 절단라인이 나이프 가이드(①) 위치를 덮을 때까지 소재를 피드합니다.

3. 기기 전면의 나이프 가이드를 따라 칼을 사용하여 소재를 자릅니다.

소재 제거/절단
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출력 일시 중지

진행 중인 커팅 프로세스를 일시 중지하고 일시 중지된 커팅 출력을 재개할 수 있습니다.

이 작업은 커팅 품질을 저하시킬 수 있습니다. 가능하면 일시 중지하지 마십시오.

MEMO

절차

1. 출력이 끝나기 전에 [PAUSE]를 누르십시오.

커팅 출력이 일시 중지됩니다.

2. [PAUSE]를 다시 누릅니다.

출력이 재개됩니다.

출력 취소

커팅 프로세스가 진행되는 동안 커팅 출력을 종료하려면 다음 작업을 수행하십시오.

이 작업은 출력 데이터를 취소하고 커팅 출력을 재개할 수 없게 합니다.

MEMO

절차

1. 출력이 끝나기 전에 [PAUSE]를 누르십시오.

커팅 출력이 일시 중지됩니다.

2. [ENTER]를 1초 이상 누르십시오.

출력 데이터가 취소됩니다. 커팅 출력을 다시 시작하십시오.

출력 일시 중지 및 취소
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Tool Mode는 다음과 같은 상황에서 사용할 수 있습니다.

Crop Mark를 3개만 사용하는 경우 Tool Mode를 사용할 수 없습니다.

• Sensor Mode에서 정렬이 불가능한 경우
• 소재의 종류를 선택하지 않고 인쇄와 커팅을 수행하는 경우

MEMO

필요 품목

얼라이먼트 툴 Tool Mark(①)가 인쇄된 인쇄물

Step 1 : 정렬 방법 설정(Tool Mode)

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

2. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

CROPMARK
<SENSOR MODE>

3. [▶]를 누릅니다.

CROPMARK
 SENSOR MODE

4. [▲] 또는 [▼]를 눌러 "TOOL MODE"를 선택합니다.

CROPMARK
 TOOL MODE

5. [ENTER]를 누릅니다.

CROPMARK
<TOOL MODE>

6. [MENU]를 누르면 원래 화면으로 돌아갑니다.
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Step 2 : 자동 정렬 후 커팅

출력이 진행되는 동안 커팅 캐리지를 만지지 마십시오.
커팅 캐리지가 고속으로 이동합니다. 움직이는 캐리지에 닿으면 부상을 입을 수 있습니다.

경고

절차

1. CutStudio의 [File]>[Print&Cut]가 선택되지 않은 경우 이를 선택합니다.

2. 커팅 데이터를 보냅니다.

아래와 같은 화면이 나타납니다.

REPLACE TO TOOL
(QUIT   MENU)

3. 블레이드 홀더를 제거하고 얼라이먼트 툴을 설치합니다.

얼라이먼트 툴은 블레이드 홀더와 동일한 방식으로 설치할 수 있습니다.

4. [ENTER]를 누릅니다.

아래와 같은 화면이 나타납니다.
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178 기타 커팅



MARK1 SET
(RETURN MENU)

5. [▲][▼][◀][▶]를 눌러 얼라이먼트 툴의 끝을 Tool Mark 1에 정렬합니다.

손가락으로 얼라이먼트 툴을 위에서 부드럽게 누르고 얼라이먼트 툴의 끝이 Tool Mark와 겹치는지
확인합니다.

6. [ENTER]를 누릅니다.

툴은 오른쪽 아래 Crop Mark 근처의 위치로 이동하고 아래와 같은 화면이 표시됩니다.

MARK2 SET
(RETURN MENU)

7. [▲][▼][◀][▶]를 눌러 얼라이먼트 툴의 끝을 Tool Mark 2에 정렬합니다.

얼라인먼트를 다시 수행하려면 설정 중 [MENU]를 눌러 이전 화면으로 돌아가서 절차를 다시 수행하십시오.

MEMO

8. [ENTER]를 누릅니다.

툴이 왼쪽 상단 Crop Mark 근처의 위치로 이동하고 아래와 같은 화면이 표시됩니다.

MARK3 SET
(RETURN MENU)

9. Tool Mark 3과 4를 같은 방식으로 정렬합니다.
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10. Tool Mark 4를 정렬한 후 [ENTER] 키를 누릅니다.

아래와 같은 화면이 나타납니다.
REPLACE TO BLADE
(RETURN MENU)

11. 얼라이먼트 툴을 제거하고 블레이드 홀더를 설치하십시오.

12. [ENTER]를 누릅니다.

13. 다음 화면이 나타나면 [ENTER]를 누릅니다.

커팅이 시작됩니다.
COMPLETE ENTER
QUIT    MENU

14. 커팅 소재를 제거하십시오.

 RELATED LINKS 

・ P. 43 블레이드 홀더 설치
・ P. 172 소재 제거
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수동 모드를 사용하면 CutStudio, Adobe Illustrator 또는 Corel-DRAW를 사용하지 않고 인쇄 및 자르
기를 수행할 수 있습니다.
사전에 호환되는 소재와 사용할 프린터를 확인하십시오.

사용할 프린터

해상도가 720dpi 이상인 레이저 또는 잉크젯 프린터

 RELATED LINKS 

・ P. 15 사용 소재

Step 1 : 수동으로 Tool Mark 데이터 만들기

CutStudio, Adobe Illustrator 또는 CorelDRAW 이외의 소프트웨어를 사용하여 Tool Mark 데이터를 생
성합니다. 응용 소프트웨어를 사용하여 그림에 Tool Mark를 추가하는 경우 커팅에 필요한 여백을 고려하
여 위치를 설정하십시오.
이 섹션에서는 샘플 데이터를 사용하여 Tool Mark 데이터를 수동으로 생성하는 방법에 대해 설명합니다.
샘플 데이터 :

CutStudio 설치 폴더에 있는 Sample.bmp(일반적으로 C 드라이브의 [Program Files (x86)]>[CutStudio] 
폴더에 있음)

절차

1. Tool Mark를 그립니다.

Tool Mark는 특별한 디자인은 없으나 아래 그림과 같이 모서리가 있는 형태를 사용하면 정렬이 용이
합니다.

커팅 원점은 왼쪽 하단에 있습니다. 원점의 Tool Mark는  다른 Tool Mark와 구분이 되어야 합니다.

2. 여백을 설정합니다.

많은 양의 피드가 있는 소재(긴 소재)를 사용할 때는 왼쪽과 오른쪽에 각각 약 25mm(0.98in.)
(①), 재료 피드 방향 상단에 약 20mm(0.79in.)(②), 피드 방향 후면에 약 50mm(1.97in.)(③)의
여백을 설정하는 것이 좋습니다.
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3. Tool Mark 사이의 거리를 기록해 둡니다(너비는 W, 길이는 L).

4. 오프셋 값을 기록해 둡니다.

소프트웨어의 원점(X와 Y가 모두 0인 경우)을 확인하고 이 원점(①)과 왼쪽 하단 Tool Mark(W, L)
사이의 거리를 기록합니다.

5. Tool Mark로 정의된 커팅 영역 내에 일러스트레이션(디자인)을 배치합니다.
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 RELATED LINKS 

・ P. 338 여백과 Crop Mark 사이의 거리
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Step 2 : 인쇄 및 커팅 데이터 출력

1. 인쇄와 커팅 데이터 인쇄

절차

1. 프린터에 낱장 용지를 장착합니다.

프린터에 소재를 장착하는 방법은 프린터 설명서를 참조하십시오.

확대/축소 인쇄가 활성화되면 비활성화하십시오. 100% 배율로 인쇄하십시오.

IMPORTANT

2. 인쇄와 커팅 데이터를 인쇄합니다.
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2. 인쇄물 장착

프린터에서 인쇄된 인쇄물을 기기에 장착합니다.

소재에 컬이 발생하는 경우가 있습니다. 소재에 컬이 발생하면  기기에 장착하기 전에 곧게 펴십시오.

IMPORTANT

절차

1. 커팅을 위한 원점(①)을 확인합니다.

2. 커팅 원점을 소재의 왼쪽 하단 모서리로 설정하여 기기에 인쇄물을 장착합니다.

인쇄물이 잘못된 방향으로 장착되면 1단계의 절차 3과 4에 기록된 값이 무효화되어 커팅이 올바르게 수행되지 
않습니다.

IMPORTANT

3. 핀치 롤러를 배치합니다.

핀치 롤러를 배치할 때 다음 사항에 유의하십시오.

• 핀치 롤러(②)를 Tool Mark(①) 바깥쪽에 위치시키십시오.
• 핀치 롤러(②)가 그리트 패턴(③)의 범위 내에 있는지 확인하십시오.

Manual Mode에서 인쇄와 커팅

기타 커팅 185



4. 가이드 라인(①)과 평행이 되도록 소재의 왼쪽 가장자리를 정렬합니다.

5. 로딩 레버를 올려 소재를 고정합니다.

6. 기기를 켭니다.

7. 소재 유형으로 [PIECE]를 선택합니다.

8. [ENTER]를 누릅니다.

커팅 가능한 너비와 길이가 표시됩니다.

W:***mm
L:***mm
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9. [▲][▼]를 눌러 소재를 이동하고 블레이드 프로텍터(①) 위에 Tool Mark(②)를 배치합니다.

다음과 같은 상황이 발생하면 소재를 한 번 제거한 다음 다시 장착하십시오.

• Tool Mark가 블레이드 프로텍터에서 15mm(0.60in.) 이상 떨어져 있는 경우
• 커팅 캐리지의 이동 방향에 대해 좌우 Tool Mark가 5˚ (③)이상 기울어져 있는 경우
• 소재 공급 방향으로 20mm(0.79in.)(④) 이상 벗어난 경우

IMPORTANT

10. [◀][▶]를 눌러 블레이드의 팁이 왼쪽 하단 Tool Mark 위로 오도록 커팅 캐리지를 이동합니다.
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Step 3 : 정렬 방법 설정(수동 모드)

1. 수동 모드 선택

Crop Mark 정렬 방법을 수동 모드로 설정합니다. 

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

2. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

CROPMARK
<SENSOR MODE>

3. [▶]를 누릅니다.

CROPMARK
 SENSOR MODE

4. [▲][▼]를 누르고 "MANUAL"을 선택합니다.

CROPMARK
 MANUAL

5. [ENTER]를 누릅니다.

CROPMARK
<MANUAL>

6. [▶]를 누릅니다.
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2. Tool Mark 사이의 거리를 입력

Tool Mark를 수동으로 생성할 때 기록된 거리, 너비(W) 및 길이(L)를 입력합니다.

절차

1. [▶]를 세 번 누르면 아래와 같은 화면이 나타납니다.

WIDTH 160
*160mm

2. [▲][▼]를 누르고 Tool Mark 사이의 수평 거리("WIDTH")를 입력합니다.

WIDTH 160
*180mm

3. [ENTER]를 눌러 설정을 선택합니다.

WIDTH 180

4. [▼] 버튼을 누른 후 [▶] 버튼을 누르면 아래와 같은 화면이 나타납니다.

LENGTH 210
*210mm

5. [▲][▼]를 누르고 Tool Mark 사이의 수직 거리("LENGTH")를 입력합니다.

LENGTH 210
*230mm

6. [ENTER]를 눌러 설정을 선택합니다.

LENGTH 230
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 RELATED LINKS 

・ P. 181 수동으로 Tool Mark 데이터 만들기
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3. 오프셋 값 입력

Tool Mark를 수동으로 생성할 때 기록된 오프셋 값 거리, 폭(W) 및 길이(L)를 입력합니다.

절차

1. [▼] 버튼을 누른 후 [▶] 버튼을 누르면 아래와 같은 화면이 나타납니다.

OFFSET W 0.5
*0.5mm

2. [▲][▼]을 눌러 폭 오프셋 값(W)을 입력합니다.

OFFSET W 0.5
*0.0mm

3. [ENTER]를 눌러 설정을 선택합니다.

OFFSET W 0.0

4. [▼] 버튼을 누른 후 [▶] 버튼을 누르면 아래와 같은 화면이 나타납니다.

OFFSET L 0.5
*0.5mm

5. [▲][▼]을 눌러 길이 오프셋 값(L)을 입력합니다.

OFFSET L 0.5
*0.0mm

6. [ENTER]를 눌러 설정을 선택합니다.

OFFSET L 0.0
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 RELATED LINKS 

・ P. 181 수동으로 Tool Mark 데이터 만들기
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Step 4 : 커팅(수동 모드)

출력이 진행되는 동안 커팅 캐리지를 만지지 마십시오.
커팅 캐리지가 고속으로 이동합니다. 움직이는 캐리지에 닿으면 부상을 입을 수 있습니다.

경고

절차

1. [◀]를 누른 후 [▼]를 누르면 아래와 같은 화면이 나타납니다.

3개의 Tool Marek에  "3-POINT START"를 선택합니다.
MANUAL
4-POINT START

2. [ENTER]를 누릅니다.

아래와 같은 화면이 나타납니다.

REPLACE TO TOOL
(QUIT   MENU)

3. 블레이드 홀더를 제거하고 얼라이먼트 툴을 설치합니다.

얼라이먼트 툴을 블레이드 홀더와 동일한 방식으로 설치할 수 있습니다.

4. [ENTER]를 누릅니다.

아래와 같은 화면이 나타납니다.

MARK1 SET
(RETURN MENU)

5. [▲][▼][◀][▶]를 눌러 얼라이먼트 툴의 끝을 Tool Mark 1에 정렬합니다.

손가락으로 얼라이먼트 툴을 위에서 부드럽게 누르고 얼라이먼트 툴의 끝이 Tool Mark와 겹치는지
확인합니다.
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6. [ENTER]를 누릅니다.

툴이 오른쪽 하단 Tool Mark 부근의 위치로 이동한 후 아래와 같은 화면이 나타납니다.

MARK2 SET
(RETURN MENU)

7. [▲][▼][◀][▶]를 눌러 얼라이먼트 툴의 끝을 Tool Mark 2에 정렬합니다.

얼라인먼트를 다시 수행하려면 설정 중 [MENU]를 눌러 이전 화면으로 돌아가서 절차를 다시 수행하십시오.

MEMO

8. [ENTER]를 누릅니다.

툴이 좌측 상단의 Tool Mark 부근으로 이동한 후 아래와 같은 화면이 나타납니다.

MARK3 SET
(RETURN MENU)

9. Tool Mark 3과 4를 같은 방식으로 정렬합니다.

Manual Mode에서 인쇄와 커팅
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10. Tool Mark 4를 정렬한 후 [ENTER] 키를 누릅니다.

아래와 같은 화면이 나타납니다.

REPLACE TO BLADE
(RETURN MENU)

11. 얼라이먼트 툴을 제거하고 블레이드 홀더를 설치하십시오.

12. [ENTER]를 누릅니다.

13. 다음 화면이 나타나면 [ENTER]를 누릅니다.

COMPLETE ENTER
QUIT    MENU

14. 아래와 같은 화면이 표시되면 컴퓨터에서 커팅 데이터를 전송합니다.

OUTPUT DATA

기기가 데이터를 수신하면 커팅을 시작합니다.

15. 커팅된 인쇄물을 제거합니다.

 RELATED LINKS 

・ P. 172 소재 제거
・ P. 43 블레이드 홀더 설치

Manual Mode에서 인쇄와 커팅
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커팅 조건에 관한 일반 가이드

세 가지 커팅 조건은 블레이드 압력, 커팅 속도 및 블레이드 팁 오프셋입니다.

소재와 블레이드의 다양한 조합에 대한 블레이드의 커팅 조건 및 수명에 대한 일반적인 지침은 아래에 나와 
있습니다.

아래 조건을 준수하는 것만으로는 최적의 커팅을 얻을 필요가 없습니다. 커팅하기 전에 시트 소재에 적합
한 블레이드로 커팅 테스트를 수행하십시오.

특정 블레이드는 특정 판재에 적합합니다. 적합하다고 지정되지 않은 커팅 소재는 블레이드가 파손될 수 있습니다.

IMPORTANT

블레이드 소재 커팅 압력(gf)
커팅 속도
(cm/sec) 

(in./sec)*1

블레이드 팁 
오프셋(mm) 

(in.)
수명(m)(ft.) *2

ZEC-U5032 General signage vinyl 30~100 20 혹은 이하 0.25 4.000

ZEC-U5025
General signage vinyl 40~100 20 혹은 이하

0.25
4.000

Fluorescent vinyl 120~200 10 혹은 이하 2.500

* 1 커팅 속도가 빠를 수록 이미지 품질이 떨어집니다. 필요한 이미지 품질에 맞게 속도를 조정합니다.
* 2 수명은 동일한 유형의 소재를 커팅한 경우의 일반적인 기준입니다.

블레이드 압력을 이 차트에 표시된 값보다 50~60gf 높은 값으로 증가시켜도 커팅되지 않은 영역이 남아 있으면 블레이드를 
교체하십시오.

MEMO

 RELATED LINKS 

・ P. 45 테스트 커팅 수행
・ P. 200 커팅 조건 조정
・ P. 282 블레이드 교체

커팅 조건

품질 및 효율성 최적화 199



커팅 설정을 조정하기 전에 커팅 테스트를 수행하십시오. 커팅 테스트 결과를 확인한 후 커팅 조건을 조정하
십시오. 프린터 드라이버의 [Print Setting] 창(또는 CutStudio/VersaWorks)에서 블레이드  압력, 커팅 속
도, 블레이드 팁 오프셋을 변경할 수 있습니다.

 RELATED LINKS 

・ P. 45 테스트 커팅 수행

컷인 양(블레이드 길이) 조정하기

얇은 이형지로 소재를 커팅하는 경우와 같이 커팅량을 정확하고 미세하게 조정하려는 경우 블레이드 길이를 
조정하면 좋은 결과를 얻을 수 있습니다. 블레이드 홀더의 캡 부분을 돌려 블레이드 길이를 조정합니다.
블레이드 길이(②)는 최소 0mm(①), 최대 2.5mm(98.42mil)(③)입니다. 캡을 완전히 한 바퀴 돌리면 
0.5mm(0.02in.)가 조정됩니다.

블레이드 길이(①)는 소재 부분(②)의 두께와 이형지(④) 두께의 반(③)을 합한 양으로 설정합니다.

이형지가 없는 소재에 절취선을 커팅하는 경우 커터가 소재를 뚫을 때(②) 날이 약간 더 길도록 블레이드 길이(①)를 
설정합니다. 블레이드를 너무 길게하면 블레이드와 블레이드 프로텍터가 손상되고 성능 저하가 빨라지므로 주의하십
시오.

MEMO

커팅 조건 조정
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커팅 조건 조정
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블레이드 압력 설정

디자인이 떼어지거나 이형지도 소재와 함께 커팅되면 블레이드 압력을 조정하십시오. 

절차

1. PEN FORCE 슬라이더 [PEN FORCE]가 중앙 위치(눈금 "0")에 있는지 확인합니다.

▲
▲ ▲▲

-2 -1 0 +1 +2

2. [FORCE]를 누릅니다.

현재의 블레이드 압력이 표시됩니다.
FORCE 50gf
* 50gf

3. [▲] 또는 [▼]를 눌러 값을 선택합니다.

4. [ENTER]를 눌러 설정을 선택합니다.

• 기본 설정 : 50gf
• 설정 범위 : 30~500gf(10gf 단위로 변경 가능)

MEMO

 RELATED LINKS 

・ P. 199 커팅 조건에 관한 일반 가이드

블레이드 압력 미세 조정

"FORCE" 메뉴를 사용하여 블레이드 압력을 설정한 후 PEN FORCE 슬라이더를 사용하여 블레이드 압력
을 더 미세 조정할 수 있습니다. "FORCE" 메뉴를 사용하여 설정한 것보다 블레이드 압력을 약간 더 크게 
또는 더 작게 만들고 싶을 때 이 작업을 사용합니다.

절차

1. PEN FORCE 슬라이더로 블레이드 압력을 조정하십시오.

커팅 조건 조정
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▲
▲ ▲▲

-2 -1 0 +1 +2

여기에서 조정한 값은 대략적인 가이드일 뿐입니다. 이 값의 정확성은 보장되지 않습니다.

• 조정 가능 범위 : ±약 30gf

MEMO

커팅 조건 조정
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커팅 속도 설정

커팅 속도를 설정합니다. 

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

CONDITION

소재가 장착되어 있는 경우 [MENU]를 여러 번 누르면 다음 화면이 표시됩니다. 
1. [MENU]를 여러 번 누르면 다음 화면이 나타납니다.

UNSETUP

2. [▼]를 누릅니다.

MEMO

2. [▶]를 누릅니다.

3. [▲][▼]를 누르면 다음 화면이 나타납니다.

SPEED 40cm/s

4. [▶]를 누릅니다.

5. [▲] 또는 [▼]를 눌러 값을 선택합니다.

SPEED 40cm/s
  10cm/s

6. [ENTER]를 눌러 설정을 선택합니다.

7. [MENU]를 누르면 원래 화면으로 돌아갑니다.

• 기본 설정 : 20cm/s
• 설정 범위 : 1 ~ 85cm/s(0.40 ~ 33.46in./s)(1cm/s(0.39in./s) 스텝)

MEMO

 RELATED LINKS 

・ P. 199 커팅 조건에 관한 일반 가이드

커팅 조건 조정
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블레이드 팁 오프셋 값 설정

이 설정을 사용하면 블레이드 팁의 오프셋을 설정할 수 있습니다. 블레이드에 표시된 오프셋 값을 입력
합니다. 제공된 블레이드를 사용하는 경우 기본 설정을 사용하여 커팅을 수행할 수 있습니다.

커팅의 시작 부분이 의도한 위치에서 벗어나거나 모양의 모서리가 깨끗하지 않은 경우 오프셋 값을 조정합니다.

MEMO

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

CONDITION

소재가 장착되어 있는 경우 [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.
1. [MENU]를 여러 번 누르면 다음 화면이 나타납니다.

UNSETUP

2. [▼]를 누릅니다.

MEMO

2. [▶]를 누릅니다.

3. [▲][▼]를 누르면 다음 화면이 나타납니다.

OFFSET 0.250mm

4. [▶]를 누릅니다.

5. [▲] 또는 [▼]를 눌러 값을 선택합니다.

OFFSET 0.250mm
  0.500mm

6. [ENTER]를 눌러 설정을 선택합니다.

7. [MENU]를 누르면 원래 화면으로 돌아갑니다.

• 기본 설정 : 0.250mm
• 설정 범위 : 0.000~1.000mm(0.000~0.039in.)(0.025mm(0.001in.) 스텝)

MEMO

 RELATED LINKS 

・ P. 199 커팅 조건에 관한 일반 가이드

커팅 조건 조정
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커팅 좌표의 방향 설정

커팅 좌표를 회전하고 소재를 커팅할 방향을 결정합니다. 

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

CONDITION

소재가 장착되어 있는 경우 [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.
1. [MENU]를 여러 번 누르면 다음 화면이 나타납니다.

UNSETUP

2. [▼]를 누릅니다.

MEMO

2. [▶]를 누릅니다.

3. [▲][▼]를 누르면 다음 화면이 나타납니다.

ROTATE 0deg A

4. [▶]를 누릅니다.

5. [▲] 또는 [▼]를 눌러 설정을 선택합니다.

ROTATE 0deg A
*0deg A

"0deg" 다음 그림의 화살표는 각각 X축과 Y축의 양의 방향을 나타
냅니다.

• 원점 : 왼쪽 하단
• 좌표축 :

세로 방향 : Y축
가로 방향 : X축

커팅 조건 조정
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"90deg" 다음 그림의 화살표는 각각 X축과 Y축의 양의 방향을 나타
냅니다.

6. [ENTER]를 눌러 설정을 선택합니다.

• 기본 설정: "0deg"

MEMO

MENU를 여러 번 눌러 다음 화면을 표시하여 설정 값을 확인할 수도 있습니다.

• "0deg"로 설정한 경우

20cm/s
250gf 0.250mm ∠A

• "90deg"로 설정한 경우

20cm/s
250gf 0.250mm ∠ A

7. [MENU]를 누르면 원래 화면으로 돌아갑니다.

 RELATED LINKS 

・ P. 199 커팅 조건에 관한 일반 가이드

커팅 조건 조정
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커팅 영역 확장

커팅 영역을 확장하면 소재를 최대로 사용 가능합니다.

커팅할 디자인에 따라 핀치 롤러가 커팅 라인 위를 지나갈 수 있습니다.

MEMO

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

CONDITION

UNSETUP

MEMO

2. [▶]를 누릅니다.

3. [▲][▼]를 누르면 다음 화면이 나타납니다.

EXTEND 0.0mm

4. [▶]를 누릅니다.

5. [▲] 또는 [▼]를 눌러 값을 선택합니다.

EXTEND 0.0mm
  10.0mm

• 설정된 값은 커팅 영역의 양쪽 끝에 적용됩니다.
• 소재를 장착한 후 "EXTEND"를 설정하면 제어 패널에 표시되는 "W" 값이 실제 커팅 폭과 달라집니다.

IMPORTANT

커팅 조건 조정
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2. [▼]를 누릅니다.



예: 0mm(0in.)에서 10.0mm(0.39in.)로 설정하는 경우

200mm

220mm(8.66in.)

10mm

6. [ENTER]를 눌러 설정을 선택합니다.

7. [MENU]를 누르면 원래 화면으로 돌아갑니다.

• 기본 설정 : 0.0mm
• 설정 범위 : 0.0~10.0mm(0.0~0.39in.)

MEMO

 RELATED LINKS 

・ P. 39 미디어 유형 선택

커팅 조건 조정
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커팅 중 블레이드 속도 설정

이 설정을 사용하면 커팅 작업 중에 소재에서 블레이드를 들어 올린 상태에서 블레이드를 다음 커팅 위치로
이동하는 속도를 설정할 수 있습니다. 일반적인 소재보다 얇거나 두꺼운 소재를 커팅할 때는 소재가 들뜨는
등의 문제를 방지하기 위해 속도를 줄이는 것이 좋을 수 있습니다.

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

CONDITION

UNSETUP

MEMO

2. [▶]를 누릅니다.

3. [▲][▼]를 누르면 다음 화면이 나타납니다.

UPSPEED 40cm/

4. [▶]를 누릅니다.

5. [▲] 또는 [▼]를 눌러 값을 선택합니다.

UPSPEED 40cm/
  AUTO

"AUTO"로 설정하면 "SPEED"에서 설정한 속도로 움직입니다. "UPSPEED"를 높이면 커팅 시간이 
단축됩니다.

6. [ENTER]를 눌러 설정을 선택합니다.

7. [MENU]를 누르면 원래 화면으로 돌아갑니다.

• 기본 설정 : "AUTO"
• 설정 범위 : 10 ~ 85cm/s(3.94 ~ 33.46in./s)(5cm/s(1.97in./s) 스텝), "AUTO"

MEMO

 RELATED LINKS 

・ P. 199 커팅 조건에 관한 일반 가이드

커팅 조건 조정
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소재가 장착되어 있는 경우 [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.
1. [MENU]를 여러 번 누르면 다음 화면이 나타납니다.

2. [▼]를 누릅니다.



호 및 기타 곡선을 부드럽게 자르기(Smoothing)

이 기기로 전송되는 커팅 데이터의 곡선을 매끄럽게 설정할 수 있습니다. 일반적으로 높이 조절 레버를
"ON"으로 설정합니다. 작은 텍스트나 복잡한 모양을 커팅할 때 모서리 커팅이 너무 둥글다면 이것을
"OFF"로 설정하십시오. 품질에 관계없이 생산성을 높여야 할 경우에도 "OFF"로 설정하는 것이 좋습니다.

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

CONDITION

소재가 장착되면 [MENU]를 여러 번 눌러 다음 화면을 표시합니다.

UNSETUP

MEMO

2. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

OTHERS

3. [▶]를 누릅니다.

4. [▲][▼]를 누르면 다음 화면이 나타납니다.

SMOOTHING ON

5. [▶]를 누릅니다.

6. [▲] 또는 [▼]를 눌러 "ON" 또는 "OFF"를 선택합니다.

SMOOTHING ON
*ON

7. [ENTER]를 눌러 설정을 선택합니다.

8. [MENU]를 누르면 원래 화면으로 돌아갑니다.

• 기본 설정 : "ON"

MEMO

커팅 조건 조정
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동일한 위치에서 반복 커팅(Overlap)

동일한 커팅 데이터로 동일한 위치에서 여러 번 커팅을 반복합니다. 두꺼운 소재와 같이 단일 패스로 커팅
할 수 없는 소재에 이 설정을 사용합니다.

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

CONDITION

소재가 장착되어 있는 경우 [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

MEMO

2. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

OTHERS

3. [▶]를 누릅니다.

4. [▲][▼]를 누르면 다음 화면이 나타납니다.

OVERLAP OFF

5. [▶]를 누릅니다.

6. [▲] 또는 [▼]를 눌러 값을 선택합니다.

OVERLAP OFF
*OFF

일반적인 커팅 외에도 설정한 횟수만큼 커팅을 합니다.

MEMO

7. [ENTER]를 눌러 설정을 선택합니다.

8. [MENU]를 누르면 원래 화면으로 돌아갑니다.

• 기본 설정 : "OFF"
• 설정 범위 : "OFF", 1~10

MEMO

커팅 조건 조정
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 RELATED LINKS 

・ P. 81 커팅

커팅 조건 조정
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모서리를 깔끔하게 자르기(Over Cut)

이 기능은 커팅 라인의 시작과 끝에서 더 길게 커팅합니다. 예를 들어 두꺼운 소재를 커팅할 때와 같이 특히
날카로운 모서리를 커팅 하려는 경우에 효과적입니다. 작은 글자나 복잡한 모양을 커팅할 때 소재의 필요한
부분을 커팅하지 않도록 이 기능은 일반적으로 "OFF"로 설정됩니다.

"ON" "OFF"

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

CONDITION

소재가 장착되어 있는 경우 [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

MEMO

2. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

OTHERS

3. [▶]를 누릅니다.

4. [▲][▼]를 누르면 다음 화면이 나타납니다.

OVER CUT OFF

5. [▶]를 누릅니다.

6. [▲] 또는 [▼]를 눌러 "ON" 또는 "OFF"를 선택합니다.

OVER CUT OFF
*OFF

커팅 조건 조정
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7. [ENTER]를 눌러 설정을 선택합니다.

8. [MENU]를 누르면 원래 화면으로 돌아갑니다.

• 기본 설정 : "OFF"

MEMO

커팅 조건 조정
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일반적인 소재보다 얇거나 단단한 소재 사용

흡입 팬을 켜서 커팅하는 동안 소재를 제자리에 고정하여 소재가 위로 들리거나 제자리에서 이동하는 것을 
방지합니다. 일반적으로 "AUTO"를 그대로 사용합니다. 단, 얇거나 단단하지 않은 소재를 사용할 때는 흡입
팬의 풍량을 낮추어야 합니다.

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

CONDITION

소재가 장착되어 있는 경우 [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

MEMO

2. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

OTHERS

3. [▶]를 누릅니다.

4. [▲][▼]를 누르면 다음 화면이 나타납니다.

VACUUMFAN AUTO

5. [▶]를 누릅니다.

6. [▲] 또는 [▼]를 눌러 값을 선택합니다.

얇은 소재를 사용할 때는 흡입을 더 약하게 사용하십시오.

VACUUMFAN AUTO
*AUTO

7. [ENTER]를 눌러 설정을 선택합니다.

8. [MENU]를 누르면 원래 화면으로 돌아갑니다.

• 기본 설정 : "AUTO"

MEMO

커팅 오정렬 방지 및 보정
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• 설정 범위 : 1~5, "AUTO"

커팅 오정렬 방지 및 보정
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오정렬 방지

커팅 위치의 오정렬을 방지하기 위해 커팅 전과 커팅 중에 소재가 자동으로 공급됩니다. "ON"으로 설정하면 
컴퓨터가 커팅 데이터를 보낼 때마다 소재가 자동으로 1m(3.28ft.) 공급되고(데이터에 따라 소재가 
1m(3.28ft.) 이상 공급될 수 있음), 커팅이 시작됩니다.

"AREA" 기능을 사용하여 소재가 이미 공급된 경우 "PRE-FEED"가 "ON"으로 설정되어 있어도 이미 공급된 양만큼 
소재가 자동으로 공급되지 않습니다.

MEMO

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

CONDITION

소재가 장착되어 있는 경우 [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

MEMO

2. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

OTHERS

3. [▶]를 누릅니다.

4. [▲][▼]를 누르면 다음 화면이 나타납니다.

PRE-FEED OFF

5. [▶]를 누릅니다.

6. [▲] 또는 [▼]를 눌러 "ON" 또는 "OFF"를 선택합니다.

PRE-FEED OFF
*OFF

7. [ENTER]를 눌러 설정을 선택합니다.

8. "ON"을 선택한 경우 소재 이송 속도를 설정합니다.

(1) [▶]를 두 번 누르면 아래와 같은 화면이 나타납니다.

커팅 오정렬 방지 및 보정
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SPEED 40cm/s

(2) [▶]를 누릅니다.

(3) [▲] 또는 [▼]를 눌러 값을 선택 합니다.

(4) [ENTER]를 눌러 설정을 선택합니다.

9. [MENU]를 누르면 원래 화면으로 돌아갑니다.

• 기본 설정 : "OFF"
• 설정 범위 : "ON"(1~10cm/s)(0.40~3.93in./s), "OFF"

MEMO

커팅 오정렬 방지 및 보정

품질 및 효율성 최적화 219



커팅 위치 조정

인쇄 위치와 커팅 위치가 다음 그림과 같이 오프셋된 경우 인쇄 위치 또는 커팅 위치를 조정하여 문제를 해결
할 수 있습니다. 이 예는 커팅 위치를 조정하는 절차를 보여줍니다.

① : 설정된 커팅 라인
② : 실제 커팅된 라인

절차

1. 소재가 장착되었는지 확인하십시오.

2. 커팅 상태에 따라 보정 값을 확인하십시오.
"CROP-L"은 소재의 공급 방향을 나타내고 "CROP-W"는 커팅 캐리지의 이동 방향을 나타냅니다.
예 : 커팅 라인을 오른쪽으로 0.5mm(0.02in.) 이동하고(①) 위로 0.7mm(0.03in.) 이동하려면(②)

+

+
-

-

• CROP-W： +0.500으로 설정
• CROP-L： +0.700으로 설정

3. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

4. [▼]를 누르면 다음 화면이 나타납니다.

커팅 오정렬 방지 및 보정
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OTHERS

5. [▶]를 누릅니다.

6. [▲][▼]를 누르면 다음 화면이 나타납니다.

CROP ADJ.

7. CROP-L 및 CROP-W에 대한 보정 값을 설정합니다.

(1) [▶]를 두 번 누르면 아래와 같은 화면이 나타납니다.

CROP-L 0.000
*0.000mm

(2) [▲][▼]를 눌러 CROP-L에 대한 보정 값을 설정합니다.

(3) [ENTER]를 눌러 설정을 선택합니다.

(4) "▼"를 누른 다음 "▶"를 누르면 아래와 같은 화면이 표시됩니다.

CROP-W 0.000
*0.000mm

(5) [▲][▼]를 눌러 CROP-W에 대한 보정 값을 설정합니다.

(6) [ENTER]를 눌러 설정을 선택합니다.

8. [MENU]를 누르면 원래 화면으로 돌아갑니다.

9. 커팅을 다시 수행하십시오.
커팅 라인의 오정렬이 수정되면 조정이 완료된 것입니다. 추가 조정이 필요한 경우 프로세스를
반복하십시오.

MEMO
• 기본 설정 :

"CROP-L"：(소재 공급 방향) 0.000
"CROP-W"： (커팅 캐리지 이동 방향) 0.000

• 설정 범위 : -25.000mm(-0.985in.) ~ +25.000mm(+0.984in.)

커팅 오정렬 방지 및 보정
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인쇄 위치 조정

인쇄 위치와 커팅 위치가 다음 그림과 같이 오프셋된 경우 인쇄 위치 또는 커팅 위치를 조정하여 문제를 해결
할 수 있습니다. 이 예는 인쇄 위치를 조정하는 절차를 보여줍니다.

절차

1. CutStudio에서 [File]>[Printing Setup]을 클릭합니다.

커팅 오정렬 방지 및 보정
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2. [Fine adjustment]을 선택하고 [Adjust]를 클릭합니다.

[Crop Mark Adjustment] 창이 표시됩니다.

3. 원점(①)에 가까운 선이나 점(②)을 기준으로 위치를 맞춥니다.

[BaseX] 및 [BaseY] 값을 조정하여 오정렬을 보정한 후 [OK]를 클릭합니다.

• 커팅 위치가 인쇄 위치의 왼쪽 또는 오른쪽으로 벗어난 경우
[BaseX] 값을 변경합니다. 커팅 위치가 인쇄 위치 오른쪽으로 오프셋된 경우 값을 늘리십시오.
인쇄 위치 왼쪽으로 오프셋된 경우 값을 줄입니다. 위 그림과 같은 경우 [BaseX]를 증가시킵니
다.

• 커팅 위치가 인쇄 위치 위 또는 아래로 벗어난 경우
[BaseY] 값을 변경합니다. 커팅 위치가 인쇄 위치 위로 오프셋된 경우 값을 늘리십시오. 인쇄 위
치 아래에서 오프셋된 경우 값을 줄입니다. 위 그림과 같은 경우 [BaseY]를 증가시킵니다.
[BaseX]와 [BaseY]로 위치를 조정한 후에도 다음 그림과 같이 원점(①)에서 떨어진 위치에서
인쇄와 커팅 위치가 어긋나면 팽창, 수축 또는 변경된 소재로 인해 설정([W], [L])에서 벗어나도
록 인쇄된 Crop Mark 사이의 거리. 4단계로 진행합니다.

4. [Crop Mark Adjustment] 창에서 [W]와 [L]을 설정하고 차이를 수정합니다.

그러나 값은 지침일 뿐입니다. 값을 변경하고 실제로 소재를 여러 번 커팅하여 최적의 값을 찾아야
합니다.

커팅 오정렬 방지 및 보정
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설정하기 전에 [BaseX]와 [BaseY]가 원점(①)에 가까운 선이나 점을 기준으로 조정되었는지 확인합니다. 멀리 
떨어진 지점을 기준으로 정렬한 경우 [W] 및 [L]을 설정하면 3단계의 조정 결과가 어긋납니다.

IMPORTANT

• 커팅 라인이 인쇄 위치에서 바깥쪽으로 벗어나는 경우
인쇄된 Crop Mark 사이의 거리가 설정보다 멀기 때문일 수 있습니다. 이 경우 [W], [L]을 설정값
보다 크게 설정하여 위치를 조정합니다.

• 커팅 라인이 인쇄 위치에서 안쪽으로 벗어나는 경우
인쇄된 Crop Mark 사이의 거리가 설정보다 짧기 때문일 수 있습니다. 이 경우 [W]와 [L]을 설
정값보다 작게 설정하여 위치를 조정합니다.

① : 원점

[Crop Mark Adjustment] 창에서 입력한 값은 [Printing Setup] 대화 상자에서 [Adjust]를 선택한 경우에
만 유효합니다. [Fine adjustment]를 선택하지 않거나 [CROPMARK]의 [W] 및 [L] 설정을 변경하면 입력
한 모든 값이 지워집니다.

IMPORTANT

센서가 Crop Mark를 읽지 못하면 아래와 같은 화면이 나타납니다.
다음 화면이 나타나면 Crop Mark가 감지되지 않는 경우(P. 292)를 참조하여 오류를 해결하십시오.

SET TO
<TOOL MODE>

MEMO

커팅 오정렬 방지 및 보정
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P. 177 Tool Mode에서 인쇄와 커팅

커팅 오정렬 방지 및 보정
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"REPLOT"

컴퓨터에서 수신한 데이터를 기기의 메모리에 저장할 수 있으며 해당 데이터를 반복해서 커팅하는 데 사용
할 수 있습니다. 다시 커팅하려면 디스플레이 메뉴에서 "REPLOT"을 사용하십시오.

• 기기가 Set-up 상태가 된 시점부터 Set-up 상태가 해제된 시점까지 수신된 모든 데이터가 저장
됩니다.

• Set-up 상태를 해제해도 데이터는 지워지지 않습니다.
• Set-up 상태를 취소한 후 기기를 다시 Set-up 상태로 되돌리면 저장된 모든 데이터를 컴퓨터에서

전송된 새 데이터로 덮어씁니다.
• 전원이 꺼지면 모든 데이터가 지워집니다.
• 기기 메모리에 저장된 데이터가 2MB를 초과하면 데이터가 삭제될 때까지 다시 커팅할 수 없습니다.

이 상태에서 "REPLOT"을 수행하면 "DATA OVERFLOW"가 나타납니다. 기기의 메모리에 데이터가
저장되어 있지 않으면 메뉴에서 "REPLOT"을 선택하면 "NO DATA"가 나타납니다.

Step 1 : 재커팅을 위한 데이터 준비

기기 메모리에 남아 있는 모든 데이터를 지운 다음 필요한 데이터만 기기 메모리에 저장되도록 새 데이터를 
전송하십시오.

절차

1. 소재가 장착되었는지 확인하십시오.

2. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

3. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

REPLOT
<DATA EXISTS>

"NO DATA"가 표시되면 6단계로 진행합니다.

4. [▶]를 누릅니다.

REPLOT
*START

5. [▼]를 눌러 "CLEAR"를 선택합니다.

REPLOT
*CLEAR

6. [ENTER]를 누릅니다.

데이터가 지워집니다.

동일한 데이터를 반복적으로 커팅하기
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REPLOT
<NO DATA>

7. 컴퓨터에서 데이터를 보냅니다.

동일한 데이터를 반복적으로 커팅하기

228 작업 효율성 최적화



Step 2 : 재커팅(Replot)

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

2. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

REPLOT
<DATA EXISTS>

3. [▶]를 누릅니다.

REPLOT
*START

4. [ENTER]를 누릅니다.

디스플레이는 아래와 같이 돌아가고 메모리에 저장된 커팅이 수행됩니다.

20cm/s
250gf 0.250mm ∠A

동일한 데이터를 반복적으로 커팅하기
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커팅 조건 저장하기

다른 소재로 바꿀때마다 커팅 조건을 설정하는 데 소요되는 시간을 절약하기 위해 자주 사용하는 소재의 커
팅 조건을 메모리에 저장할 수 있습니다. 다음에 같은 소재를 사용할 때는 저장한 메모리를 불러오기만 하면 
소재에 적합한 설정으로 변경할 수 있습니다.
8개의 설정 세트를 USER 1에서 USER 8 메모리에 저장할 수 있습니다. 메모리를 덮어쓰면 메모리에 포함
된 이전 커팅 조건이 삭제됩니다.

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

CONDITION

소재가 장착되면 [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

MEMO

2. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

MEMORY
<USER1>

3. [▶], [▼], [▶]를 차례로 누릅니다.

SAVE USER1
50-20-0.250

디스플레이는 왼쪽부터 "FORCE", "SPEED" 및 "OFFSET" 메뉴의 값을 보여줍니다.

4. [▲][▼]를 눌러 커팅 조건을 저장하려는 메모리 번호를 선택합니다.

5. [ENTER]를 누릅니다.

아래와 같은 화면이 나타납니다.

SAVE USER2

6. [MENU]를 누르면 원래 화면으로 돌아갑니다.

디스플레이에는 표시되지 않지만 UPSPEED(커팅하지 않을 때 블레이드가 움직이는 속도)와 커팅 품질도 저장
됩니다.

MEMO

자주 사용하는 커팅 조건 저장
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커팅 조건 불러오기

저장된 메모리를 선택하고 제어 패널에 적용합니다.
USER 1에서 USER 8까지 메모리를 선택할 수 있습니다. 메모리에서 커팅 조건을 로드하면 저장되지 않은 
모든 커팅 조건이 지워집니다.

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

CONDITION

소재가 장착되어 있는 경우 [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

MEMO

2. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

MEMORY
<USER1>

3. [▶]를 두 번 누릅니다.

LOAD *USER1
50-20-0.250

4. [▲][▼]를 눌러 로드하려는 메모리 번호를 선택합니다.

5. [ENTER]를 눌러 실행합니다.

6. [MENU]를 누르면 원래 화면으로 돌아갑니다.

자주 사용하는 커팅 조건 저장

작업 효율성 최적화 231



천공 커팅은 이형지 없이 소재를 커팅하거나 커팅 데이터에 주름을 만드는 데 사용할 수 있습니다.

소재가 끼는 것을 방지하기 위해 커팅 후 커팅된 영역이 분리됩니다.

 RELATED LINKS 

・ P. 27 소재 장착
・ P. 41 커팅 출력을 위한 준비
・ P. 57 커팅 조건 설정
・ P. 67 인쇄 조건 설정

CutStudio를 사용하여 천공 커팅 데이터 만들기

1. 천공 커팅 데이터 만들기

기기에 소재를 장착하고 커팅 출력 준비를 마칩니다.

P. 27 소재 장착
P. 41 커팅 출력을 위한 준비

절차

1. CutStudio를 시작합니다.

• Windows 11
a. [Start]를 클릭합니다.
b. [All apps]>[Roland CutStudio]>[CutStudio]를 클릭합니다.

• Windows 10
[시작] 메뉴에서 [ Roland CutStudio]>[CutStudio]를 클릭합니다.

• Windows 8.1

[시작] 화면 왼쪽 하단에서       를 클릭하면 [앱] 화면이 표시됩니다.      를 클릭합니다.

CutStudio가 시작됩니다.

2. 모양을 만듭니다.

이 예에서는 아래 그림에 표시된 디자인을 만듭니다.

딱지처럼 커팅 하기
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3. 을 클릭합니다.

천공 커팅이 설정되고 개체가 빨간색으로 표시됩니다.

[File]>[Preference]를 클릭하면 [Preference] 창이 나타납니다. 이를 통해 천공 커팅 라인의 색상과 표시를 
설정할 수 있습니다.

MEMO

천공 커팅 라인 설정을 취소하려면       를 사용하여 천공 커팅을 취소할 모양을 선택하고        를 클릭합니다. 

천공 커팅 설정을 해제하면 커팅 라인 색상이 검은색으로 돌아갑니다.

MEMO

딱지처럼 커팅 하기
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2. 천공 커팅 조건 설정

절차

1. [File]>[Cutting Setup]를 클릭합니다.

[Cutting Setup] 창이 표시됩니다.

2. [Name]의 [Printer]에서 [Roland DG GS2-24]를 선택합니다.

모델명이 설정됩니다.

3. [Media Size]에서 [Change]를 클릭합니다.

딱지처럼 커팅 하기
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4. [Get from Machine]을 클릭합니다.

연결된 기기에서 커팅 가능 영역을 불러오고 [Cutting Area]에서 [Width] 및 [Length]를 업데이트
합니다.

[The machine is not responding.]가 표시되면 이 기기와 컴퓨터의 설정을 확인하십시오.

P. 297 기기가 작동하지 않는 경우

MEMO

5. [OK]를 클릭합니다.

딱지처럼 커팅 하기
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설정이 저장되고 [Cutting Setup] 창이 나타납니다.

6. 커팅 조건을 설정합니다.

일반적으로 [Use cutting conditions of machine] 확인란이 선택됩니다.
커팅 조건을 변경하려면 [Use cutting conditions of machine] 확인란의 선택을 취소하고 값을
입력합니다.

7. [Use perforated cutting conditions of machine] 확인란의 선택을 취소합니다.

이를 통해 [Perforated Cutting]에 값을 입력할 수 있습니다.

딱지처럼 커팅 하기

236 작업 효율성 최적화



8. [Perforated Cutting]에서 [Perforation length], [Perforation Force], [Half-cut length], [Half-cut
Force]를 설정합니다.

• ① : 천공길이
소재에서 커팅된 부분의 길이
• ② : 하프 컷 길이
블레이드 압력이 억제된 상태에서 소재에서 커팅되지 않은 부분의 길이

소재의 종류에 따라 천공 압력 또는 하프 컷 압력을 조정하십시오.

[Perforation length]
＞ [Half-cut length]

[Perforation length]
＝ [Half-cut length]

[Perforation length]
＜ [Half-cut length]

Perforation length : 20mm(0.8in.) Perforation length : 20mm(0.8in.) Perforation length : 1mm(0.04in.)

Half-cut Length : 1mm(0.04in.) Half-cut Length : 20mm(0.8in.) Half-cut Length : 20mm(0.8in.)

9. [OK]를 클릭합니다.

커팅 범위와 조건이 저장됩니다.

CutStudio에서 흰색으로 표시된 영역이 커팅 범위입니다. 이 영역 밖의 문자 및 도형은 잘리지 않습니다.

MEMO

 RELATED LINKS 

・ P. 199 커팅 조건에 관한 일반 가이드
・ P. 202 블레이드 압력 설정

딱지처럼 커팅 하기
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・ P. 257 기기에서 천공 커팅 조건 설정

딱지처럼 커팅 하기
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3. 천공 라인 커팅

절차

1. 소재가 장착되었는지 확인하십시오.

2. 를 클릭합니다.

[Cut] 창이 표시됩니다.

3. 출력할 커팅 라인의 종류를 선택합니다.

[All] 커팅 라인 및 천공 커팅 라인 출력

[Cutlines only] 커팅 라인만 출력

[Perforated Cut Lines only] 천공 커팅 라인만 출력

4. [OK]를 클릭합니다.

커팅이 시작됩니다.

5. 커팅 결과를 확인하십시오.

필요에 따라 커팅 조건을 조정하십시오.

 RELATED LINKS 

・ P. 234 천공 커팅 조건 설정
・ P. 200 커팅 조건 조정

딱지처럼 커팅 하기
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Adobe Illustrator를 사용하여 천공 커팅 데이터 만들기

1. 천공 커팅 데이터 만들기

기기에 소재를 장착하고 커팅 출력 준비를 마칩니다.

P. 27 소재 장착
P. 41 커팅 출력을 위한 준비

이 섹션에서는 Adobe Illustrator 2020을 사용하여 천공 커팅 데이터를 만드는 예를 보여줍니다. 작업 절차
는 다른 버전과 동일합니다.

절차

1. 새 문서를 만들고 새 도형을 그리거나 기존 파일을 엽니다.

이 예에서는 아래 그림에 표시된 디자인을 만듭니다.

2. [Window]>[Extensions]>[Roland CutStudio]를 클릭합니다.

[Roland CutStudio] 팔레트가 나타납니다.

딱지처럼 커팅 하기
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3. 천공 커팅을 적용하려는 개체를 선택합니다.

4. 를 클릭합니다.

딱지처럼 커팅 하기

작업 효율성 최적화 241



5. [Output Perforated Cut Lines Only]를 선택합니다.

6. 팔레트에서 [Update]를 클릭합니다.

미리보기 화면에서 출력하고자 하는 커팅 라인이 보이는지 확인하세요.

7. 를 클릭합니다.
CutStudio가 시작되고 커팅 데이터가 CutStudio로 전송됩니다. 출력하는 커팅 데이터는 Adobe
Illustrator에서의 위치에 관계없이 항상 CutStudio의 원점에 정렬됩니다(Crop Mark 데이터 제외).

딱지처럼 커팅 하기
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2. 천공 커팅 조건 설정

절차

1. [File]>[Cutting Setup]를 클릭합니다.

[Cutting Setup] 창이 표시됩니다.

2. [Name]의 [Printer]에서 [Roland DG GS2-24]를 선택합니다.

모델명이 설정됩니다.

3. [Media Size]에서 [Change]를 클릭합니다.

딱지처럼 커팅 하기
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4. [Get from Machine]을 클릭합니다.

연결된 기기에서 커팅 가능 영역을 불러오고 [Cutting Area]에서 [Width] 및 [Length]를 업데이트
합니다.

[The machine is not responding.]가 표시되면 이 기기와 컴퓨터의 설정을 확인하십시오.

P. 297 기기가 작동하지 않는 경우

MEMO

5. [OK]를 클릭합니다.

딱지처럼 커팅 하기
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설정이 저장되고 [Cutting Setup] 창이 나타납니다.

6. 커팅 조건을 설정합니다.

일반적으로 [Use cutting conditions of machine] 확인란이 선택됩니다.
커팅 조건을 변경하려면 [Use cutting conditions of machine] 확인란의 선택을 취소하고 값을
입력합니다.

7. [Use perforated cutting conditions of machine] 확인란의 선택을 취소합니다.

이를 통해 [Perforated Cutting]에 값을 입력할 수 있습니다.

딱지처럼 커팅 하기
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8. [Perforated Cutting]에서 [Perforation length], [Perforation Force], [Half-cut length], [Half-cut
Force]를 설정합니다.

MEMO

 RELATED LINKS 

딱지처럼 커팅 하기
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• ① : 천공 길이

소재에서 커팅된 부분의 길이
• ② : 하프 컷 길이

블레이드 압력이 억제된 상태에서 소재에서 커팅되지 않은 부분의 길이
소재의 종류에 따라 천공 압력 또는 하프 컷 압력을 조정하십시오.

[Perforation length]
＞ [Half-cut length]

[Perforation length]
＝ [Half-cut length]

[Perforation length]
＜ [Half-cut length]

Perforation length : 20mm(0.8in.)

Half-cut Length : 1mm(0.04in.)

Perforation length : 20mm(0.8in.) Perforation length : 1mm(0.04in.)

Half-cut Length : 20mm(0.8in.) Half-cut Length : 20mm(0.8in.)

9. [OK]를 클릭합니다.

커팅 범위와 조건이 저장됩니다.

CutStudio에서 흰색으로 표시된 영역이 커팅 범위입니다. 이 영역 밖의 문자 및 도형은 잘리지 않습니다.

・ P. 199 커팅 조건에 관한 일반 가이드
・ P. 202 블레이드 압력 설정



・ P. 257 기기에서 천공 커팅 조건 설정

딱지처럼 커팅 하기
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3. 천공 라인 커팅

절차

1. 소재가 장착되었는지 확인하십시오.

2. 를 클릭합니다.

[Cut] 창이 표시됩니다.

3. 출력할 커팅 라인의 종류를 선택합니다.

[All]

[Cutlines only]

[Perforated Cut Lines only]

4. [OK]를 클릭합니다.

커팅이 시작됩니다.

5. 커팅 결과를 확인하십시오.

필요에 따라 커팅 조건을 조정하십시오.

 RELATED LINKS 

딱지처럼 커팅 하기
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커팅 라인 및 천공 커팅 라인 출력

커팅 라인만 출력

천공 커팅 라인만 출력

・ P. 234 천공 커팅 조건 설정
・ P. 200 커팅 조건 조정



CorelDRAW를 사용하여 천공 커팅 데이터 만들기 

1. 천공 커팅 데이터 만들기

기기에 소재를 장착하고 커팅 출력 준비를 마칩니다.

P. 27 소재 장착
P. 41 커팅 출력을 위한 준비

이 섹션에서는 CorelDRAW 2020을 사용하여 천공 커팅을 위한 커팅 데이터를 만드는 방법을 설명합니다.
작업 절차는 다른 버전과 동일합니다.

절차

1. 새 문서를 만들고 새 도형을 그리거나 기존 파일을 엽니다.

이 예에서는 아래 그림에 표시된 디자인을 만듭니다.

2. 도구 모음에서       를 클릭합니다.

[Roland CutStudio] 팔레트가 나타납니다.

딱지처럼 커팅 하기
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3. 천공 커팅을 적용하려는 개체를 선택합니다.

4.       를 클릭합니다.

5. [Output Perforated Cut Lines Only]를 선택합니다.

6. [Update]를 클릭합니다.

미리보기 화면에서 출력하고자 하는 커팅 라인이 보이는지 확인합니다.

7.     를 클릭합니다.

CutStudio가 시작되고 커팅 데이터가 CutStudio로 전송됩니다. 출력 커팅 데이터는 
CorelDRAW의 위치에 관계없이 항상 CutStudio의 원점에 정렬됩니다(Crop Mark 데이터 제외).

딱지처럼 커팅 하기
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2. 천공 커팅 조건 설정

절차

1. [File]>[Cutting Setup]를 클릭합니다.

[Cutting Setup] 창이 표시됩니다.

2. [Name]의 [Printer]에서 [Roland DG GS2-24]를 선택합니다.

모델명이 설정됩니다.

3. [Media Size]에서 [Change]을 클릭합니다.

딱지처럼 커팅 하기
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4. [Get from Machine].을 클릭합니다.

연결된 기기에서 커팅 가능 영역을 획득하고 [Cutting Area]에서 [Width] 및 [Length]를 업데이
트합니다.

[The machine is not responding.]가 표시되면 이 기기와 컴퓨터의 설정을 확인하십시오.

P. 297 기기가 작동하지 않는 경우

MEMO

5. [OK]를 클릭합니다.

딱지처럼 커팅 하기
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설정이 저장되고 [Cutting Setup] 창이 나타납니다.

6. 커팅 조건을 설정합니다.

일반적으로 [Use cutting conditions of machine] 확인란이 선택됩니다.

커팅 조건을 변경하려면 [Use cutting conditions of machine] 확인란의 선택을 취소하고 값을 입
력합니다.

7. [Use perforated cutting conditions of machine] 확인란의 선택을 취소합니다.

이를 통해 [Perforated Cutting]에 값을 입력할 수 있습니다.

딱지처럼 커팅 하기
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8. [Perforated Cutting]에서 [Perforation length], [Perforation Force], [Half-cut length], [Half-cut 
Force]를 설정합니다.

MEMO

 RELATED LINKS 

딱지처럼 커팅 하기

254 작업 효율성 최적화

• ① : 천공 길이

소재에서 커팅된 부분의 길이
• ② : 하프 컷 길이

블레이드 압력이 억제된 상태에서 소재에서 커팅되지 않은 부분의 길이
소재의 종류에 따라 천공 압력 또는 하프 컷 압력을 조정하십시오.

[Perforation length]
＞ [Half-cut length]

[Perforation length]
＝ [Half-cut length]

[Perforation length]
＜ [Half-cut length]

Perforation length : 20mm(0.8in.)

Half-cut Length : 1mm(0.04in.)

Perforation length : 20mm(0.8in.) Perforation length : 1mm(0.04in.)

Half-cut Length : 20mm(0.8in.) Half-cut Length : 20mm(0.8in.)

9. [OK]를 클릭합니다.

커팅 범위와 조건이 저장됩니다.

CutStudio에서 흰색으로 표시된 영역이 커팅 범위입니다. 이 영역 밖의 문자 및 도형은 잘리지 않습니다.

・ P. 199 커팅 조건에 관한 일반 가이드
・ P. 202 블레이드 압력 설정



・ P. 257 기기에서 천공 커팅 조건 설정

딱지처럼 커팅 하기
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3. 천공 라인 커팅

절차

1. 소재가 장착되었는지 확인하십시오.

2.       를 클릭합니다.

[Cut] 창이 표시됩니다.

3. 출력할 커팅 라인의 종류를 선택합니다.

[All]

[Cutlines only]

[Perforated Cut Lines only]

4. [OK]를 클릭합니다.

커팅이 시작됩니다.

5. 커팅 결과를 확인하십시오.

필요에 따라 커팅 조건을 조정하십시오.

 RELATED LINKS 

딱지처럼 커팅 하기
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커팅 라인 및 천공 커팅 라인 출력

커팅 라인만 출력

천공 커팅 라인만 출력

・ P. 234 천공 커팅 조건 설정
・ P. 200 커팅 조건 조정



기기에서 천공 커팅 조건 설정

기기의 제어 패널에서 천공 커팅 조건을 설정합니다. 이 예에서는 "HALF LEN.", "HALF FORCE" 및 "CUT 
LEN." 설정됩니다.

• ① : "CUT LEN."
소재에서 커팅된 부분의 길이
• ② : "HALF LEN."
블레이드 압력이 억제된 상태에서 소재에서 커팅되지 않은 부분의 길이

소재의 종류에 따라 "HALF FORCE"를 조정하십시오.

"CUT LEN."＞"HALF LEN." "CUT LEN."＝"HALF LEN." "CUT LEN."＜"HALF LEN."

Cut Length : 20mm(0.8in.) Cut Length : 20mm(0.8in.) Cut Length : 1mm(0.04in.)

Half-cut Length : 1mm(0.04in.) Half-cut Length : 20mm(0.8in.) Half-cut Length : 20mm(0.8in.)

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

CONDITION

소재가 장착되어 있는 경우 [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

MEMO

2. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

OTHERS

3. [▶]를 누릅니다.

딱지처럼 커팅 하기
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4.    [▲][▼]를 누르면 다음 화면이 나타납니다.

PERFORATE OFF

5. [▶]를 누릅니다.

6. [▲] 또는 [▼]를 눌러 "ON"을 선택합니다.

7. [ENTER]를 눌러 설정을 선택합니다.

8. [▶]를 두 번 누르면 아래와 같은 화면이 나타납니다.

하프 컷 길이를 설정합니다.

HALF LEN.  0.5

(1) [▶]를 누릅니다.
(2) [▲] 또는 [▼]를 눌러 값을 선택합니다.

HALF LEN.  0.5
* 0.5mm

(3) [ENTER]를 눌러 설정을 선택합니다.

9.    [▼]를 누르면 다음 화면이 나타납니다.

하프 컷 압력을 설정합니다.

HALF FORCE  5

HALF FORCE  5
* 5gf

10.    [▼]를 누르면 다음 화면이 나타납니다.

커팅 길이를 설정합니다.

CUT LEN. 15.5

CUT LEN. 15.5
  15.5mm

11. [MENU]를 누르면 원래 화면으로 돌아갑니다.

 RELATED LINKS 

・ P. 199 커팅 조건에 관한 일반 가이드

딱지처럼 커팅 하기
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(1) [▶]를 누릅니다.
(2) [▲] 또는 [▼]를 눌러 값을 선택합니다.

(3) [ENTER]를 눌러 설정을 선택합니다.

(1) [▶]를 누릅니다.
(2) [▲] 또는 [▼]를 눌러 값을 선택합니다.

(3) [ENTER]를 눌러 설정을 선택합니다.



타일 출력 개요

데이터가 커팅 가능 범위보다 크면 데이터를 여러 조각으로 나누어 출력합니다.

인쇄와 커팅 데이터는 타일 출력을 사용할 수 없습니다.

IMPORTANT

내부 여백 기능

서로 다른 커팅 조각을 연결할 때 자연스럽게 이어지도록 하기 위해 각 타일 출력 조각의 테두리에 추가 커팅 
영역이 있을 수 있습니다. 잘라낸 여분의 부분을 내부 여백(①)이라고 합니다. 필요에 따라 내부 여백을 설정
할 수 있습니다.

• 내부 여백 없음 : 조각을 연결할 때 테두리 사이의 간격 발생 할 수 있음

• 내부 여백 있음 : 조각을 연결할 때 테두리 사이에 간격이 없도록 사용 가능

커팅 데이터를 분할하여 여러 조각으로 커팅
(타일링)
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Step 1 : (타일)을 몇 조각으로 나눌지 결정

분할(타일) 컷 데이터를 출력할 때 미리 완성된 크기를 상상해 두면 도움이 됩니다. 이 섹션에서는 
아래와 같이 큰 데이터를 커팅하는 경우에 대해 설명합니다.

550mm(21.65in.)

1,000mm(39.4in.)

1,000mm(39.4in.)

절차

1. 데이터의 출력 크기를 결정합니다.

1,000mm(39.4in.)

1,000mm(39.4in.)

2. 소재 크기를 확인하고 사용할 조각 수를 결정하십시오.

이 예에서는 데이터를 2(세로) x 2(가로) 조각으로 나누어 출력합니다. 결합된 소재의 크기가 출력 
데이터 크기보다 큰지 확인합니다.

550mm(21.65in.)

550mm(21.65in.)

커팅 데이터를 분할하여 여러 조각으로 커팅(타일링)
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①

②
③

①
②

①
②



Step 2 : 타일 출력 조건 설정

타일 출력 및 내부 여백 활성화 또는 비활성화를 설정합니다.
기기에 소재를 미리 장착하고 커팅 출력 준비를 마칩니다.

P. 27 소재 장착
P. 41 커팅 출력을 위한 준비

절차

1. CutStudio를 시작합니다.

2. [File]>[Tiling]를 클릭합니다.

[Tiling] 창이 표시됩니다.

3. [Change Size]를 클릭합니다.

커팅 데이터를 분할하여 여러 조각으로 커팅(타일링)
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4. [Get from Machine]을 클릭합니다.

연결된 기기에서 커팅 가능 범위를 볼러오면 값이 자동으로 입력됩니다.

5. 값이 자동으로 입력되면 [OK] 를 클릭합니다.

세그먼트 크기가 업데이트됩니다.

커팅 데이터를 분할하여 여러 조각으로 커팅(타일링)
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6. [Tiled Output] 확인란을 선택하고 타일 수를 입력합니다.

7. 내부 여백을 설정합니다.

[Inner Margin]을 입력하면 [Overall Size]가 자동으로 업데이트됩니다. [Overall Size]가 출력 크기
보다 큰지 확인하십시오.

8. [OK]를 클릭합니다.

커팅 데이터를 분할하여 여러 조각으로 커팅(타일링)
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문서가 표시됩니다. 내부 여백이 설정되지 않은 경우에도 세그먼트의 가장자리가 표시됩니다.

 RELATED LINKS 

· P.259 타일 출력 개요
· P.260 타일을 몇 조각으로 나눌지 결정

커팅 데이터를 분할하여 여러 조각으로 커팅(타일링)

264 작업 효율성 최적화



Step 3 : 커팅 데이터 생성

커팅 데이터를 생성하고 미리보기에서 출력 순서와 커팅 조건을 확인하십시오. 

절차

1. 원하는 대로 텍스트 및/또는 도형을 입력합니다.

이 예에서는 아래 그림에 표시된 데이터를 입력합니다.

2. [File]>[Cutting Preview]를 클릭합니다.

커팅 데이터를 분할하여 여러 조각으로 커팅(타일링)
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[Next Page]를 클릭하면 커팅되는 순서대로 미리보기가 표시됩니다.

커팅 데이터를 분할하여 여러 조각으로 커팅(타일링)
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커팅 순서

3. 커팅 데이터를 확인하고 미리 보기를 닫습니다.

커팅 데이터를 분할하여 여러 조각으로 커팅(타일링)
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Step 4 : 커팅

타일 커팅을 시작합니다.

절차

1. 소재가 장착되었는지 확인하십시오.

2.        을 클릭합니다.

[DivCut Page] 창이 표시됩니다.

3. [OK]를 클릭합니다.

[Cut] 창이 표시됩니다.

4. [OK]를 클릭합니다.

커팅 데이터를 분할하여 여러 조각으로 커팅(타일링)
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커팅이 시작됩니다.

커팅이 완료되면 메시지 화면이 표시됩니다.

판재를 사용하는 경우 새 판재를 장착하십시오.

MEMO

5. [OK]를 클릭합니다.

커팅 데이터를 분할하여 여러 조각으로 커팅(타일링)
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6. 4단계와 5단계를 반복합니다.

설정된 타일 수를 출력합니다.

7. 출력된 커팅물을 결합합니다.

절차를 완료하려면 여백을 맞춥니다.

커팅 데이터를 분할하여 여러 조각으로 커팅(타일링)
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표시 언어 변경

절차

1. 기기 전원이 켜져 있을 때 전원 버튼을 1초 이상 누르면 전원이 꺼집니다.

2. [MENU]를 누른 상태에서 전원 버튼을 누릅니다.

아래와 같은 화면이 나타납니다.

LANG. ENGLISH
*ENGLISH

3.    [▼] 버튼을 눌러 화면에 표시할 언어를 선택합니다.(한국어 지원 불가)

LANG  ENGLISH
にほんこﾞ

4. [ENTER]를 눌러 설정을 선택합니다.

표시할 길이 단위 변경

표시에 사용되는 단위를 변경합니다. 

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

CONDITION

소재가 장착되어 있는 경우 [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

MEMO

2.    [▼]를 여러 번 누르면 다음 화면이 나타납니다.

OTHERS

3.    [▶], [▼], [▶]를 차례로 누릅니다.

기기의 기본 설정 관리
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UNIT mm
*mm

4. [▲][▼]로 단위를 선택합니다.

밀리미터 또는 인치를 선택할 수 있습니다.

5. [ENTER]를 눌러 설정을 선택합니다.

6. [MENU]를 누르면 원래 화면으로 돌아갑니다.

기기의 기본 설정 관리
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디스플레이 밝기 조정

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

CONDITION

소재가 장착되어 있는 경우 [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

MEMO

2.    [▼]를 여러 번 누르면 다음 화면이 나타납니다.

OTHERS

3. [▶]를 누릅니다.

4. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

CONTRAST 5

5. [▶]를 누릅니다.

6. [▲][▼]를 눌러 화면 밝기를 선택합니다.

CONTRAST 5
*5

• 설정 범위 : 1 ~ 5

7. [ENTER]를 눌러 설정을 선택합니다.

8. [MENU]를 누르면 원래 화면으로 돌아갑니다.

기기의 기본 설정 관리
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기본 설정 복원

이 절차는 모든 설정을 공장 기본값으로 되돌립니다.

이 작업은 모든 설정을 기본 설정으로 복원하고 해당 지점에 대한 모든 변경 사항을 삭제합니다. 커팅 조건과 같은 필요
한 정보를 기록해 두십시오.
그러나 언어 설정은 변경되지 않습니다.

MEMO

절차

1. [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

CONDITION

소재가 장착되어 있는 경우 [MENU]를 여러 번 누르면 다음 화면이 표시됩니다.

UNSETUP

MEMO

2.    [▼]를 여러 번 누르면 다음 화면이 나타납니다.

OTHERS

3. [▶]를 누릅니다.

4. [▼]를 여러 번 누르면 다음 화면이 나타납니다.

FACTORYDEFAULT
*PRESET

5.    [▶]를 누르면 다음 화면이 나타납니다.

FACTORYDEFAULT
*PRESET

6. [ENTER]를 눌러 실행합니다.

아래와 같은 화면이 다시 나타납니다.

SELECT SHEET
ROLL

기기의 기본 설정 관리
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깨끗한 커팅을 위해서는 청소가 중요합니다. 기기를 주기적으로 청소하십시오.

지침에 명시된 대로 작업을 수행하고 지침에 지정되지 않은 영역을 절대 만지지 마십시오.
기기가 갑자기 움직이면 부상이나 화상을 입을 수 있습니다.

경고

휘발유, 알코올 또는 시너와 같은 용제를 사용하여 청소하지 마십시오.
그렇게 하면 화재가 발생할 수 있습니다.

경고

기기 청소

물에 적신 천을 꼭 짜서 먼지와 때를 닦아내십시오.

청소하기 전에 전원을 끄십시오.

IMPORTANT

청소하기 전에 로딩 레버를 내리십시오.

IMPORTANT

청소
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핀치 롤러 롤러가 돌아가지 않도록 손으로 잡고 핀치 롤러의 고무 부분에서 이물질과 소재 찌
꺼기를 닦아냅니다. 그런 다음 마른 천으로 깨끗이 닦으십시오.

디스플레이 마른 천으로 닦으십시오.

그리트 롤러 핀치 롤러를 모두 올린 후 브러시를 사용하여 그릿 롤러를 돌립니다. 브러시*1 는 
표면의 먼지를 제거할 때 사용합니다.

*1 금속 브러시를 사용하지 마십시오.

청소
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블레이드 홀더 캡 청소

블레이드 홀더를 오랫동안 사용하면 블레이드를 지지하는 베어링이 열화되어 블레이드가 회전하기가 더 어
려워집니다. 블레이드 홀더를 이렇게 계속 사용하면 블레이드의 팁이 부드럽게 돌아가지 않아 기기가 깨끗
하게 커팅되지 않습니다.

다음과 같은 상황이 나타나면 블레이드 홀더 캡을 청소하십시오.

• 모서리와 곡선이 깨끗하지 않은 경우
• 커팅 라인이 천공 커팅처럼 커팅되는 경우

블레이드의 팁은 절대 만지지 않습니다.
부상을 입을 수 있습니다. 블레이드의 커팅 성능도 저하됩니다.

주의

캡을 풀어 제거하고 캡 내부에 쌓인 이물질이나 소재 찌꺼기를 제거하십시오.

청소해도 상태가 개선되지 않으면 블레이드 홀더를 새것으로 교체하십시오.

MEMO

 RELATED LINKS 

청소
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・ P. 282 블레이드 홀더 교체

청소
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소모품을 구매하려면 RolandDG Corporation 웹사이트를 방문하거나 공인 RolandDG  Corporation 
대리점에 문의하십시오.

 RELATED LINKS 

・ https://www.rolanddg.kr

블레이드

블레이드

아래의 경우 블레이드의 수명이 다한 것입니다. 새 블레이드로 교체하십시오.

• 블레이드의 팁이 부러진 경우.
• 블레이드 압력을 50~60gf 이상 올려도 커팅되지  않은 영역이 남는 경우.
• 커팅물이 예전만큼 깨끗하지 않는 경우.
• 세부적인 영역이나 모서리를 커팅할 때 소재가 이형지에서 말리기 시작하는 경우

오랫동안 사용했거나 단단한 소재를 커팅하는 데 사용된 블레이드의 팁이 마모될 수 있습니다. 이렇게 
마모된 블레이드는 더 이상 깨끗하게 커팅되지 않으므로 새 것으로 교체하십시오.

 RELATED LINKS 

・ P. 282 블레이드 교체

블레이드 교체

날이 무뎌지면 함께 제공된 교체용 블레이드로 교체하십시오.

지침에 명시된 대로 작업을 수행하고 지침에 지정되지 않은 영역을 절대 만지지 마십시오.
기기가 갑자기 움직이면 부상이나 화상을 입을 수 있습니다.

경고

블레이드의 팁은 절대 만지지 않습니다.
부상을 입을 수 있습니다. 블레이드의 커팅 성능도 저하됩니다.

주의

절차

1. 기기에 장착된 모든 소재를 제거하십시오.

소모품
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2. 블레이드 홀더를 분리합니다.

3. 블레이드를 교체합니다.

(1) 핀을 눌러 기존 블레이드를 밀어냅니다.
(2) 새 블레이드를 삽입합니다.

4. 커팅 캐리지에 블레이드 홀더를 설치합니다.

5. 나사가 조여졌는지 확인하십시오.

 RELATED LINKS 

・ P. 172 소재 제거/절단

・ P. 200 컷인 양(블레이드 길이) 조정하기

소모품
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블레이드 홀더

블레이드 홀더

블레이드 팁을 조정한 상태에서 커팅을 수행하면 블레이드 홀더의 캡과 소재가 서로 마찰하면서 캡의 팁이 
점차 마모됩니다. 심한 마모는 블레이드 팁의 올바른 조정을 방해하여 깨끗한 커팅을 방해합니다. 이런 경
우 블레이드 홀더를 새 것으로 교체하십시오.

 RELATED LINKS 

・ P. 280 블레이드 홀더 캡 청소

블레이드 프로텍터

블레이드 프로텍터

블레이드의 길이나 블레이드의 압력이 적절하게 조정되지 않은 상태에서 커팅을 수행하면 블레이드의 팁이 
소재의 이형지를 뚫고 블레이드 프로텍터가 손상될 수 있습니다. 블레이드 프로텍터가 손상된 상태에서 커팅
을 수행하면 커팅된 부분이 깨끗하지 않을 수 있습니다.
아래의 경우 블레이드 프로텍터를 교체하십시오.

• 블레이드 프로텍터의 표면이 긁힘 또는 이와 유사한 손상으로 인해 변형된 경우

• 손상이 심하여 뭉게지는 경우

 RELATED LINKS 

・ https://www.rolanddg.kr

소모품
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문제 해결 방법

285
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 Crop Mark가 감지되지 않는 경우 .............................................................. 292
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 RELATED LINKS 

・ P. 220 커팅 위치 조정

・ P. 222 인쇄 위치 조정

두꺼운 소재를 사용하고 있습니까?

두꺼운 소재를 사용하는 경우 "QUALITY"를 "HEAVY"로 설정하십시오.

 RELATED LINKS 

・ P. 204 커팅 속도 설정

커팅 전에 일정량의 소재를 피드 후 커팅되도록 설정되어 있습니까?

1.6m(63.00in.)보다 긴 롤 소재 또는 판지 소재를 사용할 때 커팅 데이터에 필요한 소재 길이를 피드 포워
드하지 않고 커팅을 하면 소재가 미끄러지거나 모터 오류로 인해 작동이 멈출 수 있습니다.

커팅하기 전에 필요한 양의 소재가 앞으로 공급되도록 기기를 설정하십시오.

 RELATED LINKS 

・ P. 40 소재 공급 확인

인쇄와 커팅이 잘못 정렬되는 경우
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블레이드와 블레이드 홀더가 단단히 설치되어 있습니까?

커팅하는 동안 나사가 풀리지 않도록 단단히 조여져 있는지 확인하십시오.

 RELATED LINKS 

・ P. 282 블레이드 교체

블레이드의 팁이 부러졌습니까?

블레이드를 새 것으로 교체하십시오.

 RELATED LINKS 

・ P. 282 블레이드 교체

블레이드의 팁에 먼지나 소재 접착제가 쌓이지 않았습니까?

블레이드를 제거하고 청소하십시오.

 RELATED LINKS 

・ P. 282 블레이드 교체

블레이드 홀더 내부에 소재 조각이나 먼지가 쌓이지 않았습니까?

블레이드 홀더의 끝 부분을 분리하여 내부의 이물질이나 먼지를 제거하십시오.

 RELATED LINKS 

・ P. 280 블레이드 홀더 캡 청소

두꺼운 소재를 사용하고 있습니까?

두꺼운 소재를 사용하는 경우 "QUALITY"를 "HEAVY"로 설정하십시오.

 RELATED LINKS 

・ P. 204 커팅 속도 설정

블레이드 압력과 커팅 속도는 적절하게 설정되어있나요?

커팅 테스트를 수행하고 커팅이 적절하게 수행될 수 있을 때까지 설정을 조정합니다.

 RELATED LINKS 

・ P. 202 블레이드 압력 설정

・ P. 210 커팅 중 블레이드 속도 설정

커팅되지 않은 영역이 남아 있거나 
커팅된 가장자리가 깨끗하지 않은 경우
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・ P. 45 테스트 커팅 수행

블레이드 팁 오프셋이 적절합니까?

블레이드 팁에 대한 오프셋 설정이 올바르지 않으면 모서리가 둥글거나 뿔이 있을 수 있습니다. 블레이드 
팁 오프셋에 적절한 값을 설정합니다.

 RELATED LINKS 

・ P. 205 블레이드 팁 오프셋 값 설정

커팅 전에 일정량의 소재를 피드 후 커팅되도록설정되어 있습니까?

1.6m(63.00in.)보다 긴 롤 소재 또는 판지 소재를 사용할 때 커팅 데이터에 필요한 소재 길이를 피드 
포워드하지 않고 커팅을 하면 소재가 미끄러지거나 모터 오류로 인해 작동이 멈출 수 있습니다.

커팅하기 전에 필요한 양의 소재가 앞으로 공급되도록 기기를 설정하십시오.

 RELATED LINKS 

・ P. 40 소재 공급 확인

SMOOTHING 기능이 OFF로 설정되어 있습니까?

곡선을 깔끔하게 자르기 위해 "SMOOTHING"을 "ON"으로 설정합니다.

 RELATED LINKS 

・ P. 211 호 및 기타 곡선을 부드럽게 자르기(Smoothing)

블레이드 프로텍터가 손상되었거나 변형되었습니까?

블레이드 프로텍터가 손상되면 기기의 설정과 블레이드 및 블레이드 홀더의 설치가 모두 정확하더라도 
소재가 올바르게 커팅되지 않을 수 있습니다. 이 경우 공인 Roland DG Corporation 대리점에 문의하십
시오.

 RELATED LINKS 

・ P. 284 블레이드 프로텍터

커팅되지 않은 영역이 남아 있거나 커팅된 가장자리가 깨끗하지 않은 경우
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블레이드의 길이와 블레이드 압력 값이 커팅되는 소재에 적절합니까?

커팅 테스트를 수행하고 블레이드 팁과 블레이드 압력을 적절하게 조정하십시오.

 RELATED LINKS 

・ P. 199 커팅 조건에 관한 일반 가이드

・ P. 45 테스트 커팅 수행

・ P. 200 컷인 양(블레이드 길이) 조정하기

이형지까지 커팅되는 경우
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CutStudio에서 [Overlap Cutting]이 0으로 설정되어 있습니까?

[Cut] 화면에서 [Overlap Cutting]을 [0] 이외의 숫자로 설정하면 해당 숫자가 커팅 횟수에 추가됩니다. 
기기에서 [Overlap Cutting]을 [0]으로 설정하거나 [OVERLAP]을 [OFF]로 설정하십시오.

 RELATED LINKS 

・ P. 81 커팅

기기의 [OVERLAP] 설정이 1에서 10 사이의 숫자로 설정되어 있습니까?

기기의 "OVERLAP" 설정을 "OFF"로 설정합니다.

 RELATED LINKS 

・ P. 212 동일한 위치에서 반복 커팅(Overlap)

겹치는 선이 있습니까?

동일한 데이터가 복사되어 라인이 겹칠 수 있습니다. 데이터를 확인하십시오.

동일한 영역을 두 번 커팅하는 경우
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기기가 Crop Mark를 감지하지 못하면 다음 오류 메시지를 표시하고 작동을 일시 중지합니다.

• "SET TO <TOOL MODE>"
• "LENGTH NG"
• "WIDTH NG"
• "ANGLE TOO BIG"

이런 경우 제어 패널에서 아무 키나 누르십시오. 소재를 제거하고 다음 항목을 확인한 후 소재를 다시 장
착하십시오.

소재가 올바르게 장착되어 있습니까?

소재가 장착되고 올바르게 설정되었는지 확인하십시오.

 RELATED LINKS 

・ P. 27 소재 장착

흰색이 아니거나 광택이 나는 소재을 사용하고 있습니까?

소재에 장식이나 색상이 있는 경우 Crop Mark를 감지할 수 없습니다. 흰색이라도 광택이 있는 소재에서
는 Crop Mark를 감지할 수 없습니다.
흰색 무광택(최소 광택) 소재를 준비하고 인쇄 단계부터 프로세스를 다시 수행합니다.

 RELATED LINKS 

・ P. 15 사용 가능한 소재의 조건

투명한 소재를 사용하고 있습니까?

투명 소재에서는 Crop Mark를 감지할 수 없습니다. 사용 중인 소재를 변경하십시오.

 RELATED LINKS 

・ P. 15 사용 가능한 소재의 조건

소재에 접히거나 주름이 있습니까?

소재에 주름이나 컬이 있는 경우 Crop Mark가 감지되지 않을 수 있습니다.
구겨진 부분을 펴고 소재를 다시 넣습니다. Crop Mark를 여전히 감지하지 못하는 경우 주름이나 컬이 없는 
새 소재를 준비하고 데이터 인쇄 작업을 다시 실행하십시오.

Crop Mark가 흐릿하거나 검정색이 아닌 다른 색상으로 인쇄되어 있습니까?

Crop Mark의 색상을 검은색으로 설정하고 프린터에서 인쇄 농도를 100%로 지정한 다음 데이터를 다
시 인쇄하십시오.

 RELATED LINKS 

・ P. 17 Crop Marks

 Crop Mark가 감지되지 않는 경우
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Crop Mark의 크기와 모양이 정확합니까?

기기는 규정된 형태의 Crop Mark만 감지할 수 있습니다. 직경 10mm(0.39in.)의 완벽한 원으로 
Crop Mark를 만듭니다.

 RELATED LINKS 

・ P. 17 Crop Marks

Crop Mark가 올바른 위치에 있습니까?

Crop Mark를 올바른 위치에 배치합니다.

 RELATED LINKS 

・ P. 338 여백과 Crop Mark 사이의 거리

ROTATE 메뉴가 90deg로 설정되어 있습니까?

Crop Mark를 사용할 때 "ROTATE" 메뉴를 "0deg"로 설정해야 합니다. Crop Mark는 "90deg"로 설정하면 
감지하지 못합니다.

 RELATED LINKS 

・ P. 206 커팅 좌표의 방향 설정

기기가 직사광선이나 강한 실내 조명에 노출되어 있습니까?

커팅 캐리지 센서가 직사광선이나 실내 조명에 노출되면 Crop Mark가 감지되지 않을 수 있습니다.
직사광선이나 실내 조명에 노출되지 않는 장소로 기기를 이동하십시오.
위의 단계를 수행해도 문제가 해결되지 않으면 "TOOL MODE"로 정렬을 수행하십시오.

 RELATED LINKS 
・ P. 177 Tool Mode에서 인쇄와 커팅

소재가 장착되고 똑바로 고정되어 있습니까? 인쇄 결과가 비뚤어졌습니까?

다음과 같은 경우에는 Crop Mark를 감지할 수 없습니다. 소재에 직선으로 Crop Mark가 인쇄되어 있는지 
확인합니다.

• 커팅 캐리지의 이동 방향에 대해 왼쪽 및 오른쪽 Crop Mark가 5도 이상 기울어져 있는 경우

• Crop Mark가 소재 공급 방향으로 20mm 이상 오프셋 된 경우

RELATED LINKS
・ P. 72 인쇄물 장착

 Crop Mark가 감지되지 않는 경우
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소프트웨어에서 지정한 Crop Mark 사이의 거리가 기기에 지정된 것과 일치합니까? 
(수동 모드)

기기에서 소프트웨어가 지정한 거리를 올바르게 설정하십시오.

 RELATED LINKS 

・ P. 189 정렬 방법 설정(수동 모드)

인쇄가 확대되거나 축소되었습니까?

인쇄 중에 크기를 확대하거나 축소하면 커팅 중에 Crop Mark를 감지할 수 없습니다. 배율을 100%로 
지정하여 데이터를 인쇄합니다.

 Crop Mark가 감지되지 않는 경우
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로딩 레버가 내려가 있습니까?

소재가 제자리에 고정되지 않은 것입니다. 핀치 롤러가 소재 가장자리에 있는지 확인하고 로딩 레버를 올립
니다.

소재가 가이드 라인과 평행하게 장착되어 있습니까?

왼쪽과 오른쪽 가장자리가 평행한 소재를 사용하고 소재의 왼쪽 가장자리를 가이드 라인과 평행하게 정렬
합니다.

 RELATED LINKS 

・ P. 27 소재 장착 위치

커팅하는 동안 소재가 어떤 장애물과 접촉합니까?

소재의 왼쪽과 오른쪽 가장자리가 커팅 중에 기기의 내부 표면에 닿지 않도록 하십시오. 이러한 접촉은 소재
를 손상시킬 뿐만 아니라 정상적인 소재 공급을 방해하고 제자리에서 미끄러지는 원인이 됩니다.

소재 피드를 확인하지 않고 커팅을 수행했습니까?(롤 미디어)

소재의 공급을 확인하지 않고 커팅을 시작하면 올바른 커팅 결과를 얻지 못할 수 있습니다. 최악의 경우 오작
동, 오작동, 소재 손상의 원인이 됩니다.

 RELATED LINKS 

・ P. 40 소재 공급 확인

핀치 롤러가 소재의 양쪽 가장자리를 고정하고 있습니까?

핀치 롤러가 그리트 롤러 범위 내에 위치하지 않으면 소재가 고정되지 않아 제대로 공급되지 않습니다.
소재를 다시 장착하십시오.

 RELATED LINKS 

・ P. 27 소재 장착 위치

커팅 중 소재가 핀치 롤러에서 미끄러지는 경우
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케이블이 올바르게 연결되어 있습니까?

전원 코드, USB 케이블, 이더넷 케이블이 올바르게 연결되어 있는지 확인하세요.
USB 케이블과 이더넷 케이블을 동시에 연결하면 기기가 작동하지 않는 경우가 있습니다. 이 케이블 중 
하나만 연결하십시오.

전원이 꺼져 있습니까?

기기 전원을 켭니다.

 RELATED LINKS 

・ P. 20 전원 켜기

소재가 장착되어 있습니까?

기기의 전원을 켭니다. 아래와 같은 화면이 표시되는 동안에는 데이터를 보내도 커팅을 할 수 없습니다. 
불러온 소재를 선택한 후 [ENTER]키를 누르면 설정이 완료됩니다.

SELECT SHEET
ROLL

 RELATED LINKS 

・ P. 27 소재 장착

소프트웨어 설정이 올바르지 않습니까?

시스템에 적합한 드라이버를 선택하십시오. 선택 절차는 응용 소프트웨어 설명서를 참조하십시오.

기기가 작동하지 않는 경우
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전원 버튼을 1초 이상 누르고 계셨습니까?

전원 버튼을 1초 이상 누르면 전원이 꺼집니다. 여전히 전원이 꺼지지 않으면 기기에서 AC 어댑터를 분
리하십시오.

전원을 끌 수 없는 경우
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장착 하는 소재가 1.6m(63.00in.) 이상입니까?

1.6m(63.00in.) 이상의 낱장 소재를 "PIECE"를 사용하여 설정하면 기기에서 롤 소재로 인식합니다.

 RELATED LINKS 

・ P. 15 소재의 종류

커팅 소재를 PIECE로 설정할 수 없는 경우
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USB 케이블을 통한 연결

하나의 컴퓨터에 최대 5대의 GS2-24를 연결할 수 있습니다. USB 연결을 통해 여러 대의 GS2-24를 연결
할 때 출력 대상을 구분할 수 있도록 각 기기의 USB 번호를 변경해야 합니다. 기기의 기본 설정은 "A"입니
다. 두 대 이상의 기기를 연결할 때 기기가 데이터의 출력 대상을 구분할 수 있도록 두 번째 기기와 그 이후
의 모든 기기를 "A" 이외의 설정으로 구성해야 합니다.

1~3단계를 수행하여 연결을 설정합니다. 동일한 절차를 사용하여 세 번째 또는 후속 장치를 연결할 수 있습
니다.

Step 1 : 기기의 USB 번호 변경

아직 USB 케이블을 사용하여 기기를 컴퓨터에 연결하지 마십시오. 그렇게 하면 설정을 올바르게 적용하는 데 방해가 
될 수 있습니다.

IMPORTANT

절차

1. 기기의 전원을 끕니다.

2. [TEST] 버튼과 전원 버튼을 동시에 누릅니다.

아래와 같은 화면이 나타납니다.

USB NUMBER [A]
*A

3. [▲] 및 [▼]를 눌러 "A" 이외의 설정을 선택합니다.

"B"에서 "E"까지 값을 선택할 수 있습니다. 이 예에서는 "B"가 선택되었습니다.

4.  [ENTER]를 누릅니다.

5. 전원을 껐다가 다시 켜십시오.

아래와 같은 화면이 나타납니다. 3단계에서 설정한 문자가 표시되는지 확인합니다.

Roland GS2-24
[B] Main:V***

한대 이상의 기기를 한대의 컴퓨터에 연결하기
(Windows)
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Step 2 : 컴퓨터의 프린터 설정 변경

절차

1. USB 케이블을 사용하여 기기를 컴퓨터에 연결합니다.

드라이버가 설치됩니다.

2. [장치 및 프린터]를 엽니다.

• Windows 11

a. [시작]>[모든 앱]>[Windows 도구]를 클릭합니다.

b. [제어판]을 더블 클릭합니다.

c. [장치 및 프린터]를 클릭합니다.

• Windows 10

a. [Start]>[Windows System]>[Contorol Panel]를 클릭합니다.

b. [Devices and Printers]를 클릭합니다.

• Windows 8.1

a. 참 메뉴를 표시하려면 화면 오른쪽 하단 모서리를 가리키고 [설정]을 클릭합니다.

b. [Contorol Panel]를 클릭합니다.

c. [Hardware and Sound]>[Devices and Printers]를 클릭합니다.
[Roland DG GS2-24 (1)] (또는 [Roland DG GS2-24 (1 복사)])가 생성됩니다.

3. [Roland DG GS2-24 (1)](또는 [Roland DG GS2-24 (1복사))]를 마우스 오른쪽 버튼으로 클릭하고 
[프린터 속성]을 선택합니다.

4. [Roland DG GS2-24 (1)] (또는 [Roland DG GS2-24 (1복사)])를 [Roland DG GS2-24 (B)]로  
변경합니다.

5. [OK]를 클릭합니다.

한대 이상의 기기를 한대의 컴퓨터에 연결하기(Windows)
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Step 3 : 두 번째 GS2-24가 설치되었는지 확인

절차

1. CutStudio를 시작합니다.

2. [File]>[Cutting Setup]를 클릭합니다.

3. [Printer Name]을 클릭합니다.

[Roland DG GS2-24 (B)]가 표시되면 2번째 기기가 올바르게 연결된 것입니다.

한대 이상의 기기를 한대의 컴퓨터에 연결하기(Windows)
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이더넷을 통한 연결

하나의 컴퓨터에 최대 5개의 GS2-24 장치를 연결할 수 있습니다. 이더넷을 사용하여 여러 시스템을 한 
컴퓨터에 연결할 때 각 시스템을 추가할 때 드라이버를 설치하십시오.

1~3단계를 수행하여 연결을 설정합니다. 동일한 절차를 사용하여 세 번째 또는 후속 장치를 연결할 수 있
습니다.

Step 1 : 추가할 기기의 드라이버 설치

절차

1. 이더넷 케이블을 사용하여 컴퓨터와 동일한 LAN에 추가할 기기를 연결합니다.

2. 컴퓨터에 드라이버를 설치합니다.
"설치 및 초기 설정 Windows 버전" 설명서 (https://downloadcenter.rolanddg.com/GS2-24)의 
"자동으로 IP 주소가 설정된 소프트웨어 설치하기"를 참조하여 컴퓨터에 드라이버를 설치하십시오.

한대 이상의 기기를 한대의 컴퓨터에 연결하기(Windows)
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Step 2 : 컴퓨터의 프린터 설정 변경

절차

1. [장치 및 프린터]를 엽니다.

• Windows 11
a. [Start]>[All Apps]>[Windows Tool]를 클릭합니다.
b. [Contorol Panel]를 더블 클릭 합니다.
c. [Devices and Printers]를 클릭합니다.

• Windows 10
a. [Start]>[Windows System]>[Contorol Panel]를 클릭합니다.
b. [Devices and Printers]를 클릭합니다.

• Windows 8.1
a. 참 메뉴를 표시하려면 화면 오른쪽 하단 모서리를 가리킨 다음 [설정]을 클릭합니다.
b. [Contorol Panel]를 클릭합니다.
c. [Hardware and Sound]>[Devices and Printers]를 클릭합니다.

[Roland DG GS2-24 (1)] (또는 [Roland DG GS2-24 (1 복사)])가 생성됩니다.

2. [Roland DG GS2-24 (1)](또는 [Roland DG GS2-24 (1복사))]를 마우스 오른쪽 버튼으로 클릭하고 
[프린터 속성]을 선택합니다.

3.  [Roland DG GS2-24 (1)] (또는 [Roland DG GS2-24 (1복사)])를 [Roland DG GS2-24 (B)]로 
변경합니다.

4.  [OK].를 클릭합니다.

한대 이상의 기기를 한대의 컴퓨터에 연결하기(Windows)
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Step 3 : 두 번째 GS2-24가 설치되었는지 확인

절차

1. CutStudio를 시작합니다.

2. [File]>[Cutting Setup]를 클릭합니다.

3.  [프린터 이름]을 클릭합니다.

[Roland DG GS2-24 (B)]가 표시되면 2번째 기기가 올바르게 연결된 것입니다.

한대 이상의 기기를 한대의 컴퓨터에 연결하기(Windows)
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USB를 통해 여러 대의 기기를 하나의 컴퓨터에 연결할 수 없습니다.
여러 기기를 연결하려면 컴퓨터와 각 기기 간의 연결을 USB에서 이더넷으로 변경하십시오.

MEMO

이더넷을 통한 연결(IP 주소 수동 설정)

Macintosh 컴퓨터에서는 Adobe Illustrator 플러그인을 사용하여 컴퓨터로 출력합니다. 한 대의 컴퓨터
에 여러 대의 기기를 연결할 때 컴퓨터와 각 기기 간에 이더넷 연결을 설정합니다.

Step 1 : LAN 케이블 연결

절차

1. 컴퓨터를 시작합니다.

2. 전원 버튼을 눌러 연결할 기기를 시작하십시오.

3. LAN 케이블로 기기와 컴퓨터를 연결합니다.

한대 이상의 기기를 한대의 컴퓨터에 연결하기
(Mac)
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Step 2 : 연결할 기기의 IP 주소 설정

절차

1.  기기의 IP 주소를 결정합니다.
컴퓨터의 IP 주소를 확인하여 기기의 IP 주소를 확인하십시오.
컴퓨터의 IP 주소가 192.168.0.xxx인 경우

• 기기의 IP 주소 : 192. 168. 0. yyy
[yyy]에 1~254 사이의 숫자를 입력합니다. 다른 네트워크 장비의 번호와 다르게 입력합니다.

2.  기기가 꺼져 있으면 전원 버튼을 눌러 기기를 시작합니다.

3. [MENU]를 두 번 누르면 아래와 같은 화면이 나타납니다.

CONDITION

4.    [▼]를 한번 누르면 아래와 같은 화면이 나타납니다.

SYSTEM INFO.

5.    [▶]를 한번 누르면 아래와 같은 화면이 나타납니다.

SYSTEM INFO.
MODEL

6.    [▼]를 세 번 누르면 아래와 같은 화면이 나타납니다.

SYSTEM INFO.
INTERFACE

7.    [▶]를 두 번 누르면 아래와 같은 화면이 나타납니다.

NETWORK
DHCP ON

한대 이상의 기기를 한대의 컴퓨터에 연결하기(Mac)
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8.    [▶]를 누른 후 [▼]를 눌러 DHCP를 OFF로 설정합니다.

DHCP ON
 OFF

9. [ENTER]를 누릅니다.

10. [▼]를 한번 누르면 아래와 같은 화면이 나타납니다.

NETWORK
IP ADDRESS

11. [▶]를 두 번 누릅니다.

a. [▲] 또는 [▼]를 눌러 1단계에서 결정한 기기의 IP 주소를 입력합니다. [◀] 또는 [▶]를 
눌러 커서를 이동합니다.

b. [ENTER]를 누릅니다.

12. [MENU]를 누르면 원래 화면으로 돌아갑니다.

13. 1~12단계를 반복하여 두 번째 기기의 IP 주소를 설정합니다.

한대 이상의 기기를 한대의 컴퓨터에 연결하기(Mac)
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Step 3 : Adobe Illustrator 플러그인 출력 설정 구성

절차

1. Adobe Illustrator를 시작합니다.

2. [Window]>[Extensions]>[Roland CutStudio]를 클릭합니다.

[Roland CutStudio] 팔레트가 나타납니다.

3. [Model] 목록에서 [GS2-24]를 선택합니다.

한대 이상의 기기를 한대의 컴퓨터에 연결하기(Mac)
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4.  를 클릭하고 [Connection]을 선택합니다.

5. [IP]를 선택하고 [Step 2 : 연결할 기기의 IP 주소 설정]의 1단계에서 결정한 IP 주소를 입력합니다.

예 :
기기의 IP 주소가 [192.168.000.061]인 경우 [192.168.0.61]을 입력합니다.

6. [Verify]를 클릭합니다.

기기와의 연결이 성공적으로 이루어지면 [Success!]가 나타납니다.

[Failed.]가 나타나면 IP 주소가 올바르게 입력되었는지 확인하십시오.

7. [OK]를 클릭합니다.

8. 4~7단계를 반복하여 두 번째 컴퓨터에 대한 연결을 설정합니다.

Adobe Illustrator 플러그인으로 출력할 기기의 IP 주소를 입력하여 데이터를 출력할 기기를 전환할 수 있습니다.

MEMO

한대 이상의 기기를 한대의 컴퓨터에 연결하기(Mac)
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이더넷을 통한 연결(IP 주소 자동 설정)

Macintosh 컴퓨터에서는 Adobe Illustrator 플러그인을 사용하여 컴퓨터로 출력합니다. 한 대의 컴퓨터
에 여러 대의 기기를 연결할 때 컴퓨터와 각 기기 간에 이더넷 연결을 설정합니다.

Step 1 : LAN 케이블 연결

절차

1. 컴퓨터를 시작합니다.

2. 전원 버튼을 눌러 연결할 기기를 켜십시오.

3. LAN 케이블로 기기와 컴퓨터를 연결합니다.

한대 이상의 기기를 한대의 컴퓨터에 연결하기(Mac)
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Step 2 : 연결할 기기의 설정 확인

절차

1. 기기가 꺼져 있으면 전원 버튼을 눌러 기기를 켭니다.

2. [MENU]를 두 번 누르면 아래와 같은 화면이 나타납니다.

CONDITION

3.    [▼]를 한번 누르면 아래와 같은 화면이 나타납니다.

SYSTEM INFO.

4.    [▶]를 한번 누르면 아래와 같은 화면이 나타납니다.

SYSTEM INFO.
MODEL

5.    [▼]를 세 번 누르면 아래와 같은 화면이 나타납니다.

SYSTEM INFO.
INTERFACE

6.    [▶]를 두 번 누르면 아래와 같은 화면이 나타납니다.

NETWORK
DHCP ON

DHCP를 OFF로 설정한 경우 [▶] 버튼을 누르고 [▼] 버튼을 눌러 DHCP를 ON으로 설정하고 
[ENTER] 버튼을 누릅니다.

7.    [▼]를 한번 누르면 아래와 같은 화면이 나타납니다.

NETWORK
IP ADDRESS

8.    [▶]를 한 번 누릅니다.

한대 이상의 기기를 한대의 컴퓨터에 연결하기(Mac)
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9. 표시된 IP 주소를 기록해 둡니다.

10. [MENU]를 누르면 원래 화면으로 돌아갑니다.

11. 1~10단계를 반복하여 두 번째 기기의 설정을 확인합니다.

한대 이상의 기기를 한대의 컴퓨터에 연결하기(Mac)
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Step 3 : Adobe Illustrator 플러그인 출력 설정 구성

절차

1. Adobe Illustrator를 시작합니다.

2. [Window]>[Extensions]>[Roland CutStudio]를 클릭합니다.

[Roland CutStudio] 팔레트가 나타납니다.

3. [Model] 목록에서 [GS2-24]를 선택합니다.

한대 이상의 기기를 한대의 컴퓨터에 연결하기(Mac)
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4.  을 클릭하고 [Connection]을 선택합니다.

5. [IP]를 선택하고 [Step 2 : 연결할 기기의 설정 확인]의 9단계에서 기록해 둔 IP 주소를 입력합니다.

예 :
기기의 IP 주소가 [192.168.000.061]인 경우 [192.168.0.61]을 입력합니다.

6. [Verify]를 클릭합니다.

기기와의 연결이 성공적으로 이루어지면 [Success!]가 나타납니다.

[Failed.]가 나타나면 IP 주소가 올바르게 입력되었는지 확인하십시오.

7. [OK]를 클릭합니다.

8. 4~7단계를 반복하여 두 번째 컴퓨터에 대한 연결을 설정합니다.

Adobe Illustrator 플러그인의 [Connection] 옵션으로 출력할 기기의 IP 주소를 선택하여 출력 대상을 전환
할 수 있습니다.

MEMO

한대 이상의 기기를 한대의 컴퓨터에 연결하기(Mac)
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설치를 취소했거나 USB 케이블을 연결해도 마법사가 시작되지 않으면 아래 절차에 따라 드라이버를 설치
하십시오.

드라이버 재설치(Windows 8.1)

절차

1. USB 케이블로 기기를 컴퓨터에 연결하고 기기를 켭니다.

2. [새 하드웨어 발견] 메시지가 나타나면 [닫기]를 클릭하여 닫습니다.

기기를 제외한 모든 프린터에서 USB 케이블을 분리합니다.

3. 참 메뉴를 표시하려면 화면 우측 하단 모서리를 가리키고 [제어판]>[하드웨어 및 소리]를 클릭하세요.

4. [제어판]을 클릭한 다음 [프린터 및 스캐너]를 클릭합니다.

5. [장치 관리자]를 클릭합니다. [사용자 계정 컨트롤] 창이 나타나면 [예](또는 [허용])를 클릭합니다.
[장치 관리자]가 나타납니다.

6. [보기] 메뉴에서 [숨김 장치 표시]를 클릭하세요.

7. [프린터] 또는 [기타 장치] 목록을 검색한 다음 두 번 클릭합니다.
기기 이름 또는 [알 수 없는 장치]가 선택한 항목 아래에 나타납니다. 이름을 클릭하여 선택합니다.

8. [동작] 메뉴에서 [제거]를 클릭합니다.

9. [장치 제거 확인] 창에서 [확인]을 클릭합니다.

10. [장치 관리자]를 닫습니다.

11. 컴퓨터에서 USB 케이블을 분리하고 Windows를 다시 시작합니다.

12. 아래 절차에 따라 드라이버를 제거하십시오.

P. 320 드라이버 제거(Windows 8.1)

13. 아래 절차에 따라 처음부터 설치를 시작하십시오.

GS2-24 설치 및 초기 설정 Windows 버전

드라이버 설치가 불가능한 경우
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드라이버 재설치(Windows 10)

절차

1. USB 케이블로 기기를 컴퓨터에 연결하고 기기를 켭니다.

2. [새 하드웨어 발견] 메시지가 나타나면 [닫기]를 클릭하여 닫아주세요.
기기를 제외한 모든 프린터에서 USB 케이블을 분리합니다.

3. [시작] 버튼을 마우스 오른쪽 버튼으로 클릭한 다음 [장치 관리자]를 클릭합니다.

4. [보기] 메뉴에서 [숨김 장치 표시]를 클릭하세요.

5. [프린터] 또는 [기타 장치] 목록을 검색한 다음 두 번 클릭합니다.
기기 이름 또는 [알 수 없는 장치]가 선택한 항목 아래에 나타납니다. 이름을 클릭하여 선택
합니다.

6. [동작] 메뉴에서 [장치 제거]를 클릭합니다.

7. [장치 제거 확인] 창에서 [확인]을 클릭합니다.

8. [장치 관리자]를 닫습니다.

9. 컴퓨터에서 USB 케이블을 분리한 다음 Windows를 다시 시작합니다.

10. 아래 절차에 따라 드라이버를 제거하십시오.

P. 321 드라이버 제거(Windows 10)

11. 아래 절차에 따라 처음부터 설치를 시작하십시오.

GS2-24 설치 및 초기 설정 Windows 버전

드라이버 설치가 불가능한 경우
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드라이버 재설치(Windows 11)

절차

1. USB 케이블로 기기를 컴퓨터에 연결하고 기기를 켭니다.

2. [새 하드웨어 발견] 메시지가 나타나면 [닫기]를 클릭하여 닫아주세요.
기기를 제외한 모든 프린터에서 USB 케이블을 분리합니다.

3. [시작] 버튼을 마우스 오른쪽 버튼으로 클릭한 다음 [장치 관리자]를 클릭합니다.

4. [보기] 메뉴에서 [숨김 장치 표시]를 클릭하세요.

5. [프린터] 또는 [기타 장치] 목록을 검색한 다음 두 번 클릭합니다.
기기 이름 또는 [알 수 없는 장치]가 선택한 항목 아래에 나타납니다. 이름을 클릭하여 선택
합니다.

6. [동작] 메뉴에서 [장치 제거]를 클릭합니다.

7. [장치 제거 확인] 창에서 [확인]을 클릭합니다.

8. [장치 관리자]를 닫습니다.

9. 컴퓨터에서 USB 케이블을 분리한 다음 Windows를 다시 시작합니다.

10. 아래 절차에 따라 드라이버를 제거하십시오.

P. 322 드라이버 제거(Windows 11)

11. 아래 절차에 따라 처음부터 설치를 시작하십시오.

GS2-24 설치 및 초기 설정 Windows 버전

드라이버 설치가 불가능한 경우
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드라이버를 제거하려면 아래 절차를 따르십시오.

드라이버 제거(Windows 8.1)

절차

1. 기기를 끄고 컴퓨터와 기기 사이의 커넥터 케이블을 분리합니다.

2. 윈도우를 시작합니다.

3. [데스크탑]을 클릭합니다.

4. 참 메뉴를 표시하려면 화면 오른쪽 하단 모서리를 가리킨 다음 [설정]을 클릭합니다.

5. [제어판]>[프로그램 제거]를 클릭합니다.

6. 제거할 기기의 드라이버를 마우스 오른쪽 버튼으로 클릭한 다음 [제거]를 클릭합니다.
[사용자 계정 컨트롤] 창이 나타나면 [예](또는 [허용])를 클릭합니다.

7. 삭제를 확인하는 메시지가 나타나면 [예]를 클릭합니다.

8. [시작]>[데스크톱]을 클릭합니다.

9. 탐색기를 열고 다운로드 시 드라이버 설치 위치로 지정된 폴더를 엽니다.

10. [SETUP64.EXE](64비트 버전) 또는 [SETUP.EXE](32비트 버전)를 더블 클릭합니다.
[사용자 계정 컨트롤] 창이 나타나면 [예](또는 [허용])를 클릭합니다.
드라이버 설치 프로그램이 시작됩니다.

11. [제거]를 선택한 다음 [시작]을 클릭합니다.

12. 컴퓨터를 다시 시작하라는 창이 나타나면 [예]를 클릭합니다.

13. 컴퓨터가 다시 시작되면 제어판을 다시 열고 [장치 및 프린터 보기]를 클릭합니다.

14. 삭제할 기기의 아이콘이 보이면 마우스 오른쪽 버튼을 클릭한 다음 [장치 제거]를 클릭합니다.

드라이버 제거
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드라이버 제거(Windows 10)

절차

1. 기기를 끄고 컴퓨터와 기기 사이의 연결 케이블을 분리합니다.

2. 컴퓨터의 관리자로 Windows에 로그온합니다.

3. [시작]>[Windows 시스템]>[제어판]>[프로그램 제거]를 클릭합니다.

4. 제거할 기기의 드라이버를 더블 클릭하고 [예]를 클릭합니다.

[사용자 계정 컨트롤] 창이 나타나면 [예](또는 [허용])를 클릭합니다.

5. 삭제를 확인하는 메시지가 나타나면 [예]를 클릭합니다.

6. [시작] 버튼을 마우스 오른쪽 버튼으로 클릭한 다음 [탐색기]를 클릭합니다.

7. 탐색기를 열고 다운로드 시 드라이버 설치 위치로 지정된 폴더를 엽니다.

8. [SETUP64.EXE](64비트 버전) 또는 [SETUP.EXE](32비트 버전)를 더블 클릭합니다.

[사용자 계정 컨트롤] 창이 나타나면 [예](또는 [허용])를 클릭합니다.
드라이버 설치 프로그램이 시작됩니다.

9. [제거]를 선택한 다음 [시작]을 클릭합니다.

10. 컴퓨터를 다시 시작하라는 창이 나타나면 [예]를 클릭합니다.

컴퓨터를 다시 시작하면 제거가 완료됩니다.

드라이버 제거

소프트웨어 문제 321



드라이버 제거(Windows 11)

절차

1. 기기를 끄고 컴퓨터와 기기 사이의 연결 케이블을 분리합니다.

2. 컴퓨터의 관리자로 Windows에 로그온합니다.

3. [시작]>[모든 앱]>[Windows 도구]를 클릭합니다.

4. [제어판]을 더블 클릭합니다.

5. [프로그램 제거]를 클릭합니다.

6. 제거할 기기의 드라이버를 더블 클릭하고 [예]를 클릭합니다.

[사용자 계정 컨트롤] 창이 나타나면 [예](또는 [허용])를 클릭합니다.

7. 삭제를 확인하는 메시지가 나타나면 [예]를 클릭합니다.

8. [시작] 버튼을 마우스 오른쪽 버튼으로 클릭하고 [탐색기]를 클릭합니다.

9. 탐색기를 열고 다운로드 시 드라이버 설치 위치로 지정된 폴더를 엽니다.

10. [SETUP64.EXE]를 더블 클릭합니다.

[사용자 계정 컨트롤] 창이 나타나면 [예](또는 [허용])를 클릭합니다.
드라이버 설치 프로그램이 시작됩니다.

11. [제거]를 선택한 다음 [시작]을 클릭합니다.

12. 컴퓨터를 다시 시작하라는 창이 나타나면 [예]를 클릭합니다.

컴퓨터를 다시 시작하면 제거가 완료됩니다.

드라이버 제거
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드라이버가 제대로 설치되지 않은 경우 설치된 드라이버가 컴퓨터에 [지정되지 않음]으로 표시됩니다. 이러
한 경우 다음 절차를 수행하여 드라이버를 다시 설치하십시오.

드라이버를 올바르게 설치할 수 없는 경우(Widows 8.1)

절차

1. 컴퓨터의 관리자로 Windows에 로그온합니다.

2. [시작] 화면에서 [데스크톱]을 클릭합니다.

3. 마우스 포인터를 바탕 화면 창의 오른쪽 아래 모서리로 이동한 다음 마우스 포인터를 약간 위로 이동합니다.
참 바가 화면 오른쪽에 표시됩니다.

4. [설정]을 클릭합니다.

화면 오른쪽에 [설정] 참이 나타납니다.

5. [제어판]을 클릭합니다.

6. [장치 및 프린터]를 클릭합니다.

7. [미지정]으로 분류된 사용 중인 기기의 드라이버를 마우스 오른쪽 버튼으로 클릭하고 [속성]을 클릭합니다.
기기와 컴퓨터가 연결되어 있지 않으면 [미지정] 아래에 드라이버가 표시되지 않습니다. 드라이
버가 표시되지 않으면 기기를 켜고 기기를 컴퓨터에 연결합니다.

8. [하드웨어] 탭을 클릭하고 사용 중인 모델 이름을 더블 클릭합니다.

9. [일반] 탭에서 [설정 변경]을 클릭하여 [설정 변경] 버튼을 숨깁니다.

처음부터 [설정 변경]이 표시되지 않으면 다음 단계로 진행하십시오.

10. [드라이버]를 클릭하고 [삭제]를 클릭합니다.

11. [장치 제거 확인] 창에서 [확인]을 클릭합니다.

이 시점에서 사용 중인 모델의 드라이버는 여전히 [지정되지 않음]으로 표시됩니다.

12. 드라이버를 제거합니다.

P. 320 드라이버 제거(Windows 8.1)

13. 드라이버를 다시 설치하십시오.

GS2-24 설치 및 초기 설정 Windows 버전

설치 후 드라이버가 [지정되지 않음]으로
표시되는 경우
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드라이버를 올바르게 설치할 수 없는 경우(Widows 10)

절차

1. 컴퓨터의 관리자로 Windows에 로그온합니다.

2. [시작]>[Windows 시스템]>[제어판]을 클릭합니다.

3. [장치 및 프린터]를 클릭합니다.

4. [미지정]으로 분류된 사용 중인 기기의 드라이버를 마우스 오른쪽 버튼으로 클릭하고 [속성]을 클릭합니다.
기기와 컴퓨터가 연결되어 있지 않으면 [미지정] 아래에 드라이버가 표시되지 않습니다. 드라이
버가 표시되지 않으면 기기를 켜고 기기를 컴퓨터에 연결합니다.

5. [하드웨어] 탭을 클릭하고 사용 중인 모델 이름을 두 번 클릭합니다.

6. [일반] 탭에서 [설정 변경]을 클릭하여 [설정 변경] 버튼을 숨깁니다.

처음부터 [설정 변경]이 표시되지 않으면 다음 단계로 진행하십시오.

7. [드라이버] 탭을 클릭하고 [장치 제거]를 클릭합니다.

8. [장치 제거 확인] 창에서 [확인]을 클릭합니다.

이 시점에서 사용 중인 모델의 드라이버는 여전히 [지정되지 않음]으로 표시됩니다.

9. 드라이버를 제거합니다.

P. 321 드라이버 제거(Windows 10)

10. 드라이버를 다시 설치하십시오.

GS2-24 설치 및 초기 설정 Windows 버전

설치 후 드라이버가 [지정되지 않음]으로 표시되는 경우
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드라이버를 올바르게 설치할 수 없는 경우(Windows 11)

절차

1. 컴퓨터의 관리자로 Windows에 로그온합니다.

2. [시작]>[모든 앱]>[Windows 도구]를 클릭합니다.

3. [제어판]을 더블 클릭합니다.

4. [장치 및 프린터]를 클릭합니다.

5. [미지정]으로 분류된 사용 중인 기기의 드라이버를 마우스 오른쪽 버튼으로 클릭하고 [속성]을 클릭합니다.
기기와 컴퓨터가 연결되어 있지 않으면 [미지정] 아래에 드라이버가 표시되지 않습니다. 드라이
버가 표시되지 않으면 기기를 켜고 기기를 컴퓨터에 연결합니다.

6. [하드웨어] 탭을 클릭하고 사용 중인 모델 이름을 두 번 클릭합니다.

7. [일반] 탭에서 [설정 변경]을 클릭하여 [설정 변경] 버튼을 숨깁니다.

처음부터 [설정 변경]이 표시되지 않으면 다음 단계로 진행하십시오.

8. [드라이버] 탭을 클릭하고 [장치 제거]를 클릭합니다.

9. [장치 제거 확인] 창에서 [확인]을 클릭합니다.

이 시점에서 사용 중인 모델의 드라이버는 여전히 [지정되지 않음]으로 표시됩니다.

10. 드라이버를 제거합니다.

P. 322 드라이버 제거(Windows 11)

11. 드라이버를 다시 설치하십시오.

GS2-24 설치 및 초기 설정 Windows 버전

설치 후 드라이버가 [지정되지 않음]으로 표시되는 경우
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데이터가 AI 8.0 또는 EPS 8.0 형식으로 저장됩니까?

Illustrator에서 만든 데이터를 CutStudio로 가져올 때 Al 8.0 또는 EPS 8.0 파일만 가져올 수 있습니다. 
상위 버전을 사용하는 경우 파일을 가져오기 전에 하위 버전으로 저장하십시오.

 RELATED LINKS 

・ P. 62 인쇄 데이터 배치

Illustrator 데이터를 가져올 수 없는 경우

데이터 문제 327



컴퓨터가 숨김 폴더를 표시하도록 설정되어 있지 않습니까?

샘플 데이터 폴더 위치

CutStudio 설치 폴더에 있는 [Sample.bmp] 파일(일반적으로 C 드라이브의 [Program Files 
(x86)]>[CutStudio]에 있음)

컴퓨터 설정에 따라 경우에 따라 샘플 데이터가 표시되지 않을 수 있습니다. 이 경우 다음 설정을 수행하
고 데이터 저장 위치를 다시 확인하십시오.

절차

1. [탐색기]를 엽니다.

바탕 화면의 왼쪽 하단 모서리에 있는 폴더를 클릭합니다.

2. [보기] 탭을 클릭합니다.

3. [숨겨진 항목]을 선택합니다.

샘플 데이터를 찾을 수 없는 경우
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이 절에서는 기기의 디스플레이에 나타날 수 있는 오류 메시지와 문제를 해결하기 위한 조치를 취하는 방법
에 대해 설명합니다. 여기에 설명된 조치로 문제가 해결되지 않거나 여기에 설명되지 않은 오류 메시지가 나
타나면 공인 Roland DG Corporation 대리점에 문의하십시오.

"WRONG COMMAND"

기기가 해석할 수 없는 데이터가 전송되었습니다.
오류 메시지를 지우려면 아무 키나 누르십시오. 컴퓨터에서 보낸 데이터를 검토한 다음 올바른 데이터를 보
냅니다.

"WRONG NO.S"

파라미터 개수가 허용 개수와 다릅니다.
오류 메시지를 지우려면 아무 키나 누르십시오. 컴퓨터에서 보낸 데이터를 검토한 다음 올바른 데이터를 보
냅니다.

"OUT OF RANGE"

지정된 파라미터의 값이 허용 범위를 벗어났습니다.
오류 메시지를 지우려면 아무 키나 누르십시오. 컴퓨터에서 보낸 데이터를 검토한 다음 올바른 데이터를 보
냅니다.

"ORIGIN ERROR"

기기가 직사광선이나 강한 실내 조명에 노출되어 전원을 켠 직후에는 원점을 감지할 수 없습니다.
전원을 끄고 직사광선이나 강한 빛에 노출되지 않는 장소로 기기를 이동시키고 전원을 다시 켭니다.

"CROPMARK ERROR"

Crop Mark의 모양이나 색상 또는 소재의 색상이나 광택이 기기에 적합하지 않습니다. 이 문제는 기계적 고
장으로 인한 것일 수도 있습니다.
기기가 Crop Mark를 감지하지 못합니다. Crop Mark의 모양과 색상, 소재의 색상과 광택을 확인하십시오.
Crop Mark의 모양과 색상, 소재의 색상과 광택을 검토한 후에도 동일한 오류가 발생하면 공인 Roland DG 
Corporation 대리점에 문의하십시오.

"CROPMARK ERROR""ANGLE TOO BIG"

Crop Mark 2 또는 3이 5도 이상 기울어져 있습니다.

오류 메시지
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 ① : Crop mark 2
 ② : Crop mark 3
오류 메시지를 지우려면 아무 키나 누르십시오. 소재를 다시 장착합니다.

오류 메시지
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"CROPMARK ERROR""LENGTH NG"

Crop Mark 3이 소재 공급 방향으로 20mm(0.79in.) 이상 벗어났습니다.

① : Crop marks 3
오류 메시지를 지우려면 아무 키나 누르십시오. 소재를 다시 불러오거나 Crop Mark 3의 위치를 변경합니다.

"CROPMARK ERROR""WIDTH NG"

Crop Mark 2가 커팅 캐리지 방향으로 20mm(0.79in.) 이상 벗어났습니다.

② : Crop mark 2
오류 메시지를 지우려면 아무 키나 누르십시오. 소재를 다시 불러오거나 Crop Mark 2의 위치를 변경합니다.

"OUT OF CUT RANGE"

이 메시지는 Crop Mark 또는 원점이 소재 외부에 설정되었음을 나타냅니다.
오류 메시지를 지우려면 아무 키나 누르십시오. Crop Mark 위치 또는 원점이 소재 외부에 설정되어 있지 
않은지 확인하고 설정을 다시 실행하십시오.

"SHEET UNLOADED"

소재를 장착하지 않고 기기를 준비시키려는 시도가 있었습니다. 기기가 커팅을 수행할 준비가 되었을 때 소
재가 제거되었습니다. 커팅 중에 소재가 이탈되었습니다.
설정을 취소하고 오류 메시지를 지우려면 아무 키나 누르십시오. 소재를 올바르게 장착하고 커팅 준비를 합
니다(Setup상태).

 RELATED LINKS 

・ P. 27 소재 장착 위치

오류 메시지
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"SET TO <SENSOR MODE>"

기기가 수동 모드일 때 Crop Mark 데이터가 전송되었습니다.
오류 메시지를 지우려면 아무 키나 누르십시오. 기기의 설정을 센서 모드로 변경하고 데이터를 다시 전송
하십시오.

 RELATED LINKS 

・ P. 76 자동 정렬을 수행하도록 설정 구성

"SET TO <TOOL MODE>"

센서 모드에서 Crop Mark를 감지할 수 없습니다.
오류 메시지를 지우려면 아무 키나 누르십시오. 기기의 설정을 도구 모드로 변경한 다음 데이터를 다시 전송
하십시오. 그렇게 할 때 네 개의 Crop Mark를 사용하십시오. 기기가 Tool Mode에 있는 경우 3개의 Crop 
Mark를 사용하여 커팅할 수 없습니다.
Crop Mark를 세 개 사용하려면 기기를 센서 모드로 두고 Crop Mark의 모양과 색상 또는 소재의 색상과 광
택을 변경합니다.

 RELATED LINKS 

・ P. 17 Crop Marks/Tool Marks

・ P. 292 Crop Mark가 감지되지 않는 경우

"DATA OVERFLOW"

기기에 저장된 데이터 양이 너무 커서 "REPLOT"을 실행할 수 없습니다.

절차

1. 기기에 저장된 데이터를 삭제합니다.

2. 컴퓨터에서 보낸 데이터의 크기를 줄이고 다시 보내십시오.

3. "REPLOT"을 수행하십시오.

 RELATED LINKS 
・ P. 227 동일한 데이터를 반복적으로 커팅하기

"BAD POSITION"

핀치 롤러가 소재를 고정할 수 없는 위치에 있습니다.
설정을 취소하고 오류 메시지를 지우려면 아무 키나 누르십시오. 핀치 롤러를 올바른 위치로 이동하고 소재
를 다시 장착합니다.

핀치 롤러를 올바른 위치로 이동했는데도 메시지가 나타나면 기기가 직사광선이나 강한 실내 조명에 노출되었을 수 
있습니다. 전원을 끄고 직사광선이나 강한 조명에 노출되지 않는 장소로 기기를 이동한 후 전원을 켭니다.

MEMO

오류 메시지
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관련된 링크

・ P. 29 낱장 소재 장착

・ P. 35 롤 소재 장착

"MOTOR ERROR"

모터에 무거운 하중이 가해져 작동이 중지되었습니다.
다음과 같은 조건에서 기기에 과부하가 걸리면 "MOTOR ERROR"가 나타납니다.

• 두꺼운 소재가 장착된 상태에서 커팅이 수행되었습니다.
• 소재가 미리 공급되지 않고 커팅 중에 롤에서 갑자기 당겨졌습니다.
• 소재가 어딘가에 걸렸습니다.

전원을 끄고 로딩 레버를 내린 후 다시 소재를 장착합니다.

롤 소재 커팅
커팅할 소재의 길이를 미리 롤에서 빼냅니다. 또한 커팅 전에 테스트 피드를 수행하십시오.

이때 디스플레이 메뉴의 "AREA"에서 커팅 길이보다 약 20cm(7.87in.) 더 긴 값을 설정합니다.

두꺼운 소재 커팅

품질 설정을 "HEAVY"로 설정하십시오.

"EEPROM ERROR"/"SOLENOID ERROR"

전원을 끄고 공인 Roland DG Corporation 대리점에 문의하십시오.

오류 메시지
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소재의 측면 커팅 영역(커팅 캐리지가 이동하는 방향)은 핀치 롤러의 위치에 따라 결정됩니다. 커팅 영역은 
2개의 핀치 롤러 사이에 걸쳐 있으며 각 측면에서 약 1mm(0.04in.)를 뺀 값입니다.

핀치 롤러

커팅 영역

커팅 좌표 원점

A 최대 584mm(22.99in.)

B

지정된 소재의 유형

• "ROLL" / "EDGE"
최대 25,000mm(984.25in.) *1

• "PIECE"
최대 : 감지된 길이 *2

C 10 ~ 25mm(0.40 ~ 0.98in.)

D 약 1mm(0.04in.)

E 15mm

F 50mm(1.97in.) 또는 이상

* 1 정확도는 최대 1,600mm(62.99in.)까지 보장됩니다.
* 2 감지된 길이가 1,600mm(63.00in.) 이상이면 소재가 "ROLL"로 결정되고 커팅 영역 길이는 약 25,000mm(984.25in.)로 설정됩
니다. 그러나 디스플레이에는 길이가 표시되지 않습니다.

커팅 영역
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Crop Mark 사이의 여백과 거리를 설정합니다. 소재를 커팅하기 위해 필요한 여백을 고려하고 Crop Mark 
위치를 설정합니다.

Crop Mark가 있는 인쇄 영역(CutStudio를 사용하여 커팅 데이터 생성 시)

Crop Mark가 있는 영역에 Crop Mark 이외의 그림이나 먼지가 없는지 확인하십시오.

MEMO

Crop Mark 사이의 길이(L)

Crop Mark 사이의 길이(W)

인쇄 영역

A 500mm(19.68in.) 또는 이하

B 610mm 또는 이하

C 10 ~ 60mm(0.40 ~ 2.36in.) *1

D 10 ~ 42.5mm(0.40 ~ 1.67in.)

E 50mm(1.97in.) 또는 이상 

F 20mm(0.8in.)

* 1 Crop Mark 위치를 수동으로 설정합니다. A3, A4, B4 이외의 크기의 소재를 사용하는 경우 다음 사항에 유의하십시오.
 • 맨 왼쪽 그리트 패턴 내에서 핀치 롤러를 사용하는 경우 그리트 패턴의 왼쪽 끝에서 Crop Mark까지 최소 30mm(1.19in.)(W)를 
남겨 두어야 합니다. 여백이 30mm(1.19in.) 미만이면 Crop Mark를 감지할 수 없습니다.

여백과 Crop Mark 사이의 거리
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관련된 링크
・ P. 67 인쇄 조건 설정

여백과 Crop Mark 사이의 거리
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Crop Mark가 있는 인쇄 영역
(Adobe Illustrator/CorelDRAW를 사용하여 커팅 데이터 생성 시)

Crop Mark가 있는 영역에 Crop Mark 이외의 그림이나 먼지가 없는지 확인하십시오.

MEMO

Crop Mark 사이의 길이(L)

Crop Mark 사이의 길이(W)

커팅 영역

A 1500mm(59.05in.) 또는 이하

B 소재의 폭

C 10mm(0.40in.) 또는 이상 *1

D 10mm(0.40in.) 또는 이상

E 50mm(1.97in.) 또는 이상

F 20mm(0.8in.)

* 1 Crop Mark 위치를 수동으로 설정합니다. A3, A4, B4 이외의 크기의 용지를 사용하는 경우 다음 사항에 유의하십시오.
  • 맨 왼쪽 그리트 패턴 내에서 핀치 롤러를 사용하는 경우 그리트 패턴의 왼쪽 끝에서 Crop Mark까지 최소 30mm(1.19in.)(W)
를 남겨 두어야 합니다. 여백이 30mm(1.19in.) 미만이면 Crop Mark를 감지할 수 없습니다.

여백과 Crop Mark 사이의 거리
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관련된 링크

・ P. 100 인쇄 조건 설정

・ P. 152 인쇄 조건 설정

여백과 Crop Mark 사이의 거리
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드라이브 시스템 디지털 제어 서보 모터

커팅 방식 미디어 이동 방식

사용 가능한 소재 크기 너비 50mm ~ 700mm(1.97in. ~ 27.5in.)

길이 롤 소재 : 제한 없음
낱장 소재: 100mm(3.94in.) 또는 이상

최대 커팅 영역 584mm(너비) × 25,000mm(길이)(22.9in. × 984in.)

사용 가능한 툴 • CAMM-1 시리즈 블레이드 (ZEC-U5032 / U5022 / U5025 / U3017)
• 판재용 블레이드(ZEC-U1715 / U3050 / U3075 / U3100)
• 윈도우 필름 블레이드 (ZEC-U5010)

커팅 속도 10 ~ 850mm/s(0.39 ~ 33.4in./s)

블레이드 압력 30 ~ 500gf

기계적 해상도 0.0125mm/step(0.49mil./step)

소프트웨어 해상도 0.025mm/step(0.98mil./step)

거리 정확도 *1 이동 거리의 ±0.2% 미만 또는 0.1mm(3.94mil.) 중 큰 값의 오차

반복 정확도*1*2 0.1mm(3.9mil) 또는 이하

인쇄물을 커팅 할 때 인쇄와 커팅에 대한 정렬 
정확도 *1*3

소재 공급 방향으로 이동 거리가 210mm(8.3in.) 이하이고 폭 방향으로 이동 
거리가 170mm(6.7in.) 이하인 경우 ±1mm(±39.4mil.) 이하
(프린터 및 소재의 영향을 고려하지 않음)

인터 페이스 • 이더넷(10BASE-T와 100BASE-TX 사이의 자동 전환)
• USB 2.0(FULL SPEED 호환)

반복 커팅 메모리 2MB(버퍼 크기: 8MB)

명령 시스템 CAMM-GLⅢ

전원 전용 AC 어댑터
입력: 100 - 240Vac, 50/60Hz
출력: 24Vdc 2.7A

정격 전류 1.0 

전력 소비 약 24 W

음향 소음 수준 작동 중 70dB(A) 또는 이하

대기 중 40dB(A) 또는 이하

외부 치수 860mm(너비) × 319mm(폭) × 235mm(높이)(33.9in. × 12.6in. × 9.3in.)

중량 13.5kg(30lb.)

사용 환경 • 온도 : 5 ~ 40°C(41 ~ 104°F)
• 습도 : 20 ~ 80%RH(결로 없을 것)

기본 제공 품목 전원코드, AC 어댑터, 블레이드, 블레이드 홀더, 롤러 베이스, USB 케이블, 
얼라이먼트 툴, 설명서

*1 Roland DG Corporation에서 지정한 소재및 커팅 조건에 따름.

*2 • 미디어의 팽창 및 수축은 제외
• 시트 이송방향의 길이 : 1,600mm(62.9in.) 이내

*3 Roland DG Corporation에서 지정한 측정 표준에 따름.

• 소프트웨어에는 Roland DG Corporation 소프트웨어가 포함되어야 합니다.
• 해상도가 720dpi 이상인 레이저 또는 잉크젯 프린터를 사용한다고 가정합니다.
• 광택 또는 라미네이트된 소재는 제외됩니다.
• 프린터의 정확도로 인한 뒤틀린 인쇄의 영향이나 소재의 팽창/수축 영향을 제외합니다.
• 사용하는 프린터 잉크(검은색)에 따라 센서가 올바르게 감지하지 못할 수 있습니다.

사양
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